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SOFTWARE HELP 
1 Job Manager 

1.1 Job Manager 
The Job Manager XLJobMan is a module of the X-LabPro software package to 
display and edit jobs and samples. 

XLJobMan contains a new tree control following the design of the Windows 
explorer. Using the menu entries or the command buttons of the toolbar you can 
create, edit, backup or delete jobs and samples. The tree control and the job 
window offer you context menus to do further operations. Note: Some menu 
entries and command buttons of the toolbar are disabled as long as no sample is 
selected or as long as no job window is opened. 

1.1.1 Window overview 
 Tree Control 

 Job Window 

Menu overview 

 File Menu  

 Edit Menu 

 View Menu  

 Job Menu 

 Window Menu 

 X-LabPro Menu 

 Help Menu  

Other 

 Title Bar 

 Toolbar 

 Status Bar 

  

1.2 Job Window 
The job window is used to display all of the samples assigned to the active job. 
Samples can be assigned to jobs and organized using the job window. Each 
customer sample has to be assigned to a job. Click on the head of a column (like 
in the Windows explorer) to sort the samples alternately up- and downward in 
relation to the contents of the selected column. 
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You get access to all commands of the Edit menu by clicking the right mouse 
button on a sample. 

 

Instead of a job, the trashcan can be opened. In this case the trashcan context 
menu looks like shown on the following pictures.  

 

 Restore 
Select Restore to restore the selected sample(s). The sample(s) will be 
assigned to the former jobs(s). If a job does not exist any more, the sample 
will be restored to the collective job. 

 Restore All 
Select Restore All to restore all samples in the trashcan. See Restore for 
details. 

 Delete 
Select Delete to delete the selected sample(s). 

 Delete All 
Select Delete All to delete all samples in the trashcan. 
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Note: 

The samples should be assigned to different jobs even if your applications are not 
organized according to jobs. In this case, a new job may be created for each 
week, for example. 

Changes to the data are automatically stored. Use the New Window menupoint of 
the Window menu or of the job context menu of the tree control to open additional 
job windows. 

Use the Sample menu or the command buttons in the toolbar to copy sample data 
to other jobs or windows. 

1.3 Create New Job/Job Properties 
Use this dialog to create a new job.  

 

Key Information Group 

Name of job 
Enter the name of the job to be newly created. The name may be up to 20 
characters long and must be unique.  
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Description 
Enter a description of the new job. The description may be up to 20 characters 
long.  

Comment 
Use this field to enter a comment for the new job. 

Customer Group 

Name 
Enter the customer's name and the name of the contact person, etc. as desired in 
these text boxes. Up to 40 characters may be entered in each field.  

Street 
Enter the street address for the customer in this text box. Up to 40 characters may 
be entered in this text field.  

City, State, Zip 
Enter the city, state and postal code information for the customer address in this 
text box. Up to 40 characters may be entered in this text box.  

Comments Group 

Enter comments about the job being created in these text boxes. Up to 80 
characters may be entered in each of the text boxes.  

After entering the new job´s data click on the OK command button to confirm the 
entries. The job will be created and automatically displayed in a new job window. 

To cancel just click on the Cancel command button. Now, the job won´t be 
created. 
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1.4 Edit Job 

Use this dialog to edit a job.  

 

Key Information Group 

Name of job 
Edit the name of the job. The name may be up to 20 characters long and must be 
unique.  

Description 
Edit the description of the job. The description may be up to 20 characters long.  

Customer Group 

Name 
Edit the customer's name and the name of the contact person, etc. as desired in 
these text boxes. Up to 40 characters may be entered in each field.  

Street 
Edit the street address for the customer in this text box. Up to 40 characters may 
be entered in this text field.  

City, State, Zip 
Edit the city, state and postal code information for the customer address in this text 
box. Up to 40 characters may be entered in this text box.  
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Comments Group 

Edit the comments about the job in this text boxes. Up to 80 characters may be 
entered in each of the text boxes.  

After editing the job´s data click on the OK command button to confirm the 
changes. 

To cancel click on the Cancel command button and the job won´t be changed. 

1.5 Import Job 
Use this dialog box to select the archive-file of the job you want to import. 

 

For a detailed description how to import/export jobs please refer to the relevant 
chapter.  

 

1.6 Export Job 
Use this dialog box to select the folder where you want to export a job. 
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For a detailed description how to import/export jobs please refer to the relevant 
chapter. 

1.7 Tree Control 
In the left area of the job manager it is possible to display the tree control.  

 

The tree control displays all the jobs and their assigned samples and 
measurements of the database. Further it displays the trashcan, where deleted 
samples are stored. To show or hide the tree control choose Tree Control of the 
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View menu ( ALT, V, C ). Update of the same menu will add valid database 
changes to the tree control. 

Click on a job to display the assigned samples in the active job window. Double 
click on a job or sample item to fold open or back the children, clicking on a plus or 
minus icon of the tree is the same. The blue number maintain the numbers of 
children of the items. 

Right click on an item will give you access to a context menu in relation to the type 
( job, sample, measurement, trashcan ). 

1.8 Context Menu for a job 

 

 Job Properties 
Select Job Properties to get the properties of the selected job. This selection 
opens the Job Properties dialog box. 

 New Window 
Select New Window to open a new job window containing the selected job. 

 Delete Job 
Select Delete Job to delete the selected job. This selection opens a dialog 
box to confirm the deletion. The assigned samples will be moved to the 
trashcan. 

1.9 Context Menu for a sample 

 

 Sample Properties 
Select Sample Properties to get the properties of the selected sample. This 
selection opens the Sample Properties dialog box.  
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 Show Spectra 
Select Show Spectra to open the X-LabPro Spectra Viewer and see the 
spectra of the selected sample. 

 Results 
Select Results to get the results of the selected sample. This selection opens 
the Display Sample Results dialog box.  

 

1.10 Context Menu for the trashcan 

 

 Delete All 
Select Delete All to delete all samples in the trashcan. 

 New Window 
Select New Window to open a new job window containing the trashcan. 

Note: The job window offers you some more commands for the trashcan. For 
example, you can restore samples. 

  

1.11 Menu Commands 

1.11.1 Commands in the File Menu 
 Open Job 

Use this command to open a job. This command opens a dialog box to select 
a job. The selected job will be opened in a new job window. 

 Shortcuts: 

Toolbar:  
Keyboard: CTRL+O

 Close Job 
Use this command to close the active job window. 
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 Shortcuts: 

Keyboard: CTRL+Q
 Print 

Use this command to print the selected sample(s). This command opens a 
Print dialog box to do printer settings and the printing.  

Shortcuts 

Keyboard: CTRL+P
 Print preview 

Use this command to get a preview of the print-out on the screen.  

 Exit 
Use this command to end your XLJobMan session. You can also use the 
Close command on the application control menu.  

Shortcuts 

Mouse: Double click the application's icon. 
Keyboard: ALT+F4 
   

 

1.11.2 Commands in the Edit Menu 
 New 

Use this command to create a new sample. This command opens the 
Enter/Edit Sample Data dialog box to enter the new sample´s properties. If a 
sample is selected at the moment you use this command, the dialog box will 
be preset with the properties of the selected sample otherwise with defaults. 
The new sample will be assigned to the active job. 

 Edit 
Use this command to edit the selected sample. This command opens the 
Enter/Edit Sample Data dialog box to change the sample´s properties. 

 Copy 
Use this command to copy the selected sample(s) to the X-LabPro clipboard. 

Shortcuts 

Toolbar:  
Keyboard: CTRL+C

 Paste 
Use this command to paste the sample(s) from the X-LabPro clipboard into 
the active job.  

Shortcuts 

Toolbar:  
Keyboard: CTRL+V
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 Paste with Data 
Use this command to paste the sample(s) including their results from the X-
LabPro clipboard into the active job.  

Shortcuts 

  
Keyboard: CTRL+W

 Clone 
Use this command to clone the selected sample(s). The selected sample(s) 
will immediately be copied and pasted to the active job. The X-LabPro 
clipboard won´t be used. 

Shortcuts 

Toolbar:  
Keyboard: CTRL+B

 Delete 
Use this command to delete the selected sample(s). The selected sample(s) 
will be moved to the trashcan.  

Shortcuts 

Toolbar: 
 

Keyboard: CTRL+X
  

 Assign Method 
This command changes the method assignment of a sample. 

 Reset Measurements 
This command resets the measurements of one or more selected samples. 

 Import Sample(s) 
Use this command to import samples from archive-files (*.smp). This 
command opens a dialog box where you can select one or more files. The 
imported samples will be assigned to the active job. 

 Export Sample(s) 
Use this command to export the selected samples to archive-files (*.smp). 
This command opens a dialog box where you can select the export folder. 

 Evaluate 
Use this command to evaluate the selected sample(s) 

 Show Spectra 
Use this command to open the X-LabPro Spectra Viewer to see the spectra of 
the selected sample(s). 

Shortcuts 

Toolbar: 
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 Results 
Use this command to get the results of the selected sample. This command 
opens the Display Sample Results dialog box.  

Shortcuts 

Toolbar: 

  
 Properties 

Use this command to get the properties of the selected sample. This 
command opens the Sample Properties dialog box.  

1.11.3 Commands in the View Menu 
 Toolbar 

Use this command to display and hide the toolbar, which includes buttons for 
some of the most common commands in the Job Manager. A check mark 
appears next to the menu item when the toolbar is displayed. 
See Toolbar for help on using the toolbar.  

 Status Bar 
Use this command to display and hide the status bar, which describes the 
action to be executed by the selected menu item or depressed toolbar button, 
and keyboard latch state. A check mark appears next to the menu item when 
the status bar is displayed. 
See Status Bar for help on using the status bar.  

 Tree Control 
Use this command to show and hide the tree control. The tree control shows 
the jobs and the assigned samples with measurements.  

 Update 
Use this command to update the tree control after valid database changes 
have been made from X-LabPro. When using this command the tree will only 
be reloaded from its temporary files. 

 Rebuild 
Use this command to update the tree control after valid database changes 
have been made from X-LabPro. When using this command the tree will 
completely re-calculated from the database. This operation will take a few 
seconds. 

1.11.4 Commands in the Window Menu 
The Window menu contains the following commands. 

 New Window 
Select this menupoint to open a new job window. 

 Cascade 
Select this menupoint to arrange open windows so that the title bar of each 
window is visible. Only a portion of the other windows is displayed. Scroll 
within the visible portion with the scroll bars.  
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 Tile 
Select this menupoint to arrange all of the open windows side by side so that 
all of them are visible. Only a portion of the other windows is displayed. Scroll 
within the visible portion with the scroll bars.  

 Arrange Icons 
Select this menupoint to arrange the icons within the application window.  

1.11.5 Commands in the X-LabPro Menu 
The X-LabPro menu contains the following commands to open other applications: 

 Method Administration... 
Use this command to open the Method Administration. You may also click on 
the  button on the toolbar. 

 Job Manager... 
This command would open the Job Manager. It is disabled because the Job 
Manage is already running. 

 Routine Dialog... 
Use this command to open the Routine Dialog. You may also click on the  
button on the toolbar. 

 Spectra Viewer... 
Use this command to open the Spectra Viewer. You may also click on the   
button on the toolbar. 

 Configuration Editor... 
Use this command to open the Configuration Editor. 

 Evaluation... 
Use this command to open the Evaluation Tool. 

   

1.11.6 Commands in the Help Menu 
The Help menu contains the following commands which will assist you by using 
this application: 

 Contents 
Select this menupoint to display a table of contents for the help system of the 
X-LabPro applications. In the help system, select the Contents command 
button below the menuline to show the table of contents.  

 Context Sensitive 
Select this menupoint to display a context sensitive help text. This menupoint 
corresponds to the command button with a question mark in the toolbar. 

 Software 
Select this menupoint to display a table of contents for the software 
description. Use of the operation and control software for the X-LAB energy 
dispersive x-ray fluorescence spectrometer is described in this section.  
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 Shortcuts 
Select this menupoint to display an overview of the keyboard shortcuts.  

 About XLJobMan 
Show the version and copyrights of the Job Manager. 

 

1.12 Other 

1.12.1 Toolbar 

 

The toolbar is displayed across the top of the application window, below the menu 
bar. It provides quick mouse access to many functions used in the job manager. 
To hide or display the toolbar, choose Toolbar from the View menu (ALT, V, T). 

Click to 

 
Create a new job and open it in a new job window. 

 
Open a dialog to select a job. The selected job will be opened in a new 
job window. 

 
Copy the selected sample(s) to the X-LabPro clipboard. 

 
Paste the sample(s) in the X-LabPro clipboard to the active job. 

 
Clone the selected sample(s). The selected sample(s) will immediately be 
copied and pasted to the active job. The clipboard will not be used for this 
operation. 

 
Delete the selected sample(s). The selected sample(s) will be moved to 
the trashcan.  

 
Open the X-LabPro Spectra Viewer to show the spectra of the selected 
sample(s). 

 
Open the Display Sample Results dialog box to show the results of 
the selected sample. 

 Print the selected sample(s). 

 
Open the Online Help. 

 
Open the Method Administration.This button is disabled because the 
Method Administration is already running. 

 Open the Job Manager. 

 Open the Routine Dialog. 

 Open the Spectra Viewer. 
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1.12.2 Title Bar 

 

The title bar is located along the top of the application window. It contains the 
names of the application and of the current job window. 

To move the window, drag the title bar. Note: You can also move dialog boxes by 
dragging their title bars. 

The title bar may contain the following elements: 

 Exit button 

 Maximize button 

 Minimize button 

 Name of the application 

 Name of the job window

 Icon of the application 

  

  

1.12.3 Status Bar  

 

The status bar is displayed at the bottom of the Job Manager. To display or hide 
the status bar, use the Status Bar command in the View menu. 

The left area of the status bar describes actions of menu items as you use the 
arrow keys to navigate through menus. This area shows messages that describe 
the action of a toolbar button while pressing the button. If after viewing the 
description of the toolbar button command you wish not to execute the command, 
then release the mouse button while the pointer is off the toolbar button.  

Moreover the database reading status will be shown in the status bar by a 
progress bar.  

The right areas of the status bar indicate which of the following keys are latched 
down: 

Indicator Description 

CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down. 
SCRL The Scroll Lock key is latched down.
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2 Routine Dialog 
The Routine Dialog offers the user an easy use of the X-LabPro routine 
measurement.  

It is possible to enter the sample data in the right area of the screen, the sample 
table. The left area contains a tab control for the selection of different view modes 
during the measurement. It is possible to switch between the  

 Sample Plate Display 

 Spectrum Display 

 Video Display (if your instrument is equipped with a video camera system). 

 Comunication 

 Element Mapping (Midex M only) 

The following menus are displayed when the Routine window is active: 

 File Menu 

 Edit Menu 

 View Menu 

 Tools Menu 

 Recalibration Menu 

 Video Menu 

 Help Menu 

 System Menu 

See also: 

Toolbar 
Statusbar 

 

2.1 The X-LabPro Routine Dialog 
The Routine Dialog offers the user an easy use of the X-LabPro routine 
measurement.  

It is possible to enter the sample data in the right area of the screen, the sample 
table. The left area contains a tab control for the selection of different view modes 
during the measurement. It is possible to switch between the  

 Sample Plate Display 

 Spectrum Display 

 Video Display (if your instrument is equipped with a video camera system). 

 Comunication 

 Element Mapping (Midex M only) 
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The following menus are displayed when the Routine window is active: 

 File Menu 

 Edit Menu 

 View Menu 

 Tools Menu 

 Recalibration Menu 

 Video Menu 

 Help Menu 

 System Menu 

See also: 

Toolbar 
Statusbar 

2.2 How to Define New Samples/Enter the Sample Data 
(Xepos) 

 

By clicking a cell in the "Name" column this will be highlighted and you can enter 
the sample name using the keyboard. After leaving this cell by pressing the "Enter" 
key, an arrow key or clicking into another cell, the sample name is accepted. 
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Moreover, the job name will generated automatically as configurated. You can 
overwrite the job name if necessary. 

Use the mouse to select a method from the method field. By clicking on the 
method field, a drop down list opens and it is possible to select a method. Only the 
methods of the selected method class will be displayed in the drop down list. 

For editing additional sample data it is possible to display the respective columns 
by changing the configuration in the Routine Dialog Settings Dialog Box in the 
Configuration Editor. For changing additional data without displaying the columns, 
click with the right mouse button on the respective cell containing the sample 
name and select the Sample Data menu point from the context menu. The 
Enter/Edit Sample Data Dialog Box opens. 

 

It is possible to select another method class for your sample plate by using the 
drop down list box above the sample table. In the example the method class "Vac 
methods" is in use.  
Note: By selecting a new method class all contents of the sample table will be 
deleted. 

It is possible to define the sample plate for repeated runs by selecting a repetition 
number from the drop down list box left above the sample table (Here only 1 run is 
selected). 

You can use the following shortcuts to use the clipboard: 

 Use the "Del" key to delete the content of the selected field or the whole 
sample, if the belonging row is selected in the table. 

 Use "Ctrl+Ins" or "Ctrl+C" to copy selected table areas into the clipboard. 

 Use "Shift+Ins" or "Ctrl+V" to paste the data from the clipboard into the 
selected table area. 

 Use "Shift+Del" or "Ctrl+X" to cut selected table areas into the clipboard. 

You can edit the entered data at every time before the measurement is started. 
Just click into the cell to overwrite the contained data. 
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SPECTRO Analytical Instruments GmbH 

2.3 How to Define New Samples/Enter the Sample Data (IQ) 

 

By clicking in the "Sample Name" edit box you can enter the sample name using 
the keyboard. Moreover, the job name will generated automatically as 
configurated. You can overwrite the job name if necessary. 

Use the mouse to select a method from the "Method" drop down list. Only the 
methods of the selected method class will be displayed in the drop down list. 

For editing additional sample data click with the right mouse button in the "Sample 
Name" edit box and select the Sample Data menu point from the context menu. 
The Enter/Edit Sample Data Dialog Box opens. 

 

It is possible to select another method class by using the drop down list box above 
the "Sample Name" edit box. In the example the method class "SPECTRO IQ" is 
in use.  
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It is possible to define a sample measurement for repeated runs by selecting a 
repetition number from the drop down list box left above the sample table (Here 
only 1 run is selected). 

You can edit the entered data at every time before the measurement is started. 

2.4 How to Load and Save the Sample Plates 
At every time it is possible to save the entered sample data for later use. To do 
this use the menu point Save as of the File Menu. The Save As dialog box opens 
like shown in the picture below: 

 

Enter a file name for your sample plate. By clicking the "Save" command button 
the sample plate data will be saved. The file type is "xst" ("X-LabPro Sample 
Table"). 

To open a saved sample plate later, use the File Open command in the File Menu. 
The File Open dialog shown in the picture below will open and you can select one 
of the files shown in the dialog box.  
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2.5 The Measurement 
After entering all sample plate data or loading a sample plate, the measurement 
can be started by clicking the Start button shown below. The following picture 
shows the control panel of the Routine Dialog. 

 

For an IQ you have to enter a sample name in the Sample Name Eedit field. The 
following picture shows the control panel of the Routine Dialog if your intrument is 
a IQ. 

 

The command buttons have the following functions: 

 Start – Starts the measurement. Will be switched during the measruement to 

 Stop – Measurement will be stopped (Standby Mode will be entered if 
selected) 

 Abort – Measurement will be stopped (Standby Mode will not be entered) 

 Pause – Measurement will be paused. Continue by clicking Start 

 Test – Starts a test measurement after entering all measurements parameters 
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 Next – During the measurement: The current measurement will be breaked 
and the next measurement will be started 

 Standby – The standby mode of the instrument can be switched on or off 

 Reset – The actually measurement will be restarted 

 Off – Turn off the instrument (IQ only) 

The check boxes on the right have the following functions: 

 Measurement – The samples of the current selected sample plate will be 
measured 

 Evaluation – The samples of the current selected sample plate will be 
evaluated 

 Direct Print – The sample results will be printed directly after the 
measurement is done 

 Standby – After the measurement is completed the instrument will be 
switched into the standby mode. 

After the measurement is started the samples will be shown in different colors. The 
colors have the following symbols (Xepos only): 

 Red = The sample is not measured completely 

 Yellow = This sample is in measurement 

 Green = The sample is measured completely 

The remaining time will be displayed like in the following picture (Xepos only): 

 

  

  

2.6 Show the Sample Results 
After the measurement and evaluation of a sample is finished, you can open the 
context menu by clicking the right mouse button on the sample name. The context 
menu is shown in the following picture: 
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Select the Results menu point to open the Display Sample Results Dialog Box: 

 

For a IQ the sample results will be shown automatically after the measurement 
and evaluation of a sample is finished. 
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2.7 Prepare Global Recalibration 
If a global recalibration is necessary, use the menu point Prepare Global 
Recalibration of the Recalibration menu. Remember that reference samples 
defined once in X-LabPro are required for a propper work of this function. 

The routine dialog itself will create a new global sample plate like shown in the 
following picture: 

 

The routine dialog for an IQ will also create a new global sample like shown in the 
following picture: 
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New recalibration samples with a continuous numbered sample name (e.g. 
"_07R", "_06R",...) will automatically be generated as defined in the configuration 
editor. These samples will automatically contain a link to the original reference 
sample as control sample. 

Use this function only to prepare and start a global recalibration. 

Do not try to edit the automatically generated sample plate manually. 

2.8 Prepare MCA Recalibration 
If an MCA recalibration is necessary, use the menu point Prepare MCA 
Recalibration of the Recalibration menu. Remember that a reference sample 
defined once in X-LabPro is required for a propper work of this function. 

The routine dialog itself will create a new MCA sample plate like shown in the 
following picture: 

 

The routine dialog for an IQ will also create a new MCA sample like shown in the 
following picture: 
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New MCA samples with a continous numbered sample name (e.g. "_27R", 
"_28R",...) will automatically be generated as defined in the configuration editor. 
These samples will automatically contain a link to the original reference sample as 
control sample. 

Use this function only to prepare and start an MCA recalibration. 

Do not try to edit the automatically generated sample plate manually. 

2.9 Prepare Intercept Recalibration 
If an Intercept recalibration is necessary, use the menu point Prepare Intercept 
Recalibration of the Recalibration menu. A dialog box for method selection will be 
opened. Select the method that should be calibrated in this dialog box. 

Remember that a reference sample defined once in Method Administration is 
required for a propper work of this function. 
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The routine dialog itself will create a new Intercept sample plate like shown in the 
following picture: 

 

For an IQ the routine dialog look like the following picture: 

 

New Intercept samples with a continous numbered sample name (e.g. "_27R", 
"_28R",...) will automatically be generated as defined in the configuration editor. 
These samples will automatically contain a link to the original reference sample as 
control sample. 

Use this function only to prepare and start an Intercept recalibration. 

2.10 Prepare Method Recalibration 
If an Method recalibration is necessary, use the menu point Prepare Method 
Recalibration of the Recalibration menu. A dialog box for the method selection will 
be opened. Select in this dialog box the method that should be calibrated 

Remember that a reference sample defined once in Method the Administration is 
required for a propper work of this function. 
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The routine dialog itself will create a new Method sample plate like shown in the 
following picture: 

 

For an IQ the routine dialog look like the following picture: 

 

New Mehod samples with a continous numbered sample name (e.g. "_27R", 
"_28R",...) will automatically be generated as defined in the configuration editor. 
These samples will automatically contain a link to the original reference sample as 
control sample. 

Use this function only to prepare and start an Method recalibration. 
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2.11 The Routine Dialog Spectrum Display 

 

The spectrum display shows the spectrum that is transmitted from the instrument.  
On the top the sample name of the current measured sample and the 
measurement number is displayed. 
On the bottom the line cursor data for the current line cursor position is displayed. 
Click into the spectrum display to place the line cursor. 

Use the Toolbox to have enhanced access to the spectral representation. You can 
open the toolbox by using the Toolbar symbol or the Tools Menu. 
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2.12 The Routine Dialog Sample Plate Display 

 

The sample plate display can be selected by using the tab control in the middle left 
of the Routine Dialog screen. It shows the instrument sample plate status at its 
current situation. 

The different colors have the following significance: 

Dark Gray (with text "Lock") 
Locked Position. You cannot place samples on this plate position. Locked 
positions can be defined in the Configuration Editor by using the Routine Dialog 
Settings Dialog Box. 

Green 
Measurement of this sample is completed 

Yellow 
Measurement of this sample in progress 

Red 
Measurement of this sample is not completed 

Blue (during editing the sample table) 
This position is selcted for entering sample data 

2.13 Settings Dialog Box 
The presets for the Routine Dialog can be configured using the Configuration 
Editor. Click with the right mouse button on the X-LabPro communication server 
(small icon in the tray, left to the clock) and click Configuration Editor. After double-
clicking the Routine Dialog icon, the following dialog opens: 
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Here the method class, a sample plate and a list of locked positions can be 
selected as pre-setted for the Routine Dialog. Moreover you can decide how the 
job name will be created automatically. You can choose between collective job as 
automatically used, a daily generated job (e.g. 2001_06_05), a weekly generated 
job (e.g. 2001_23) or a monthly generated job (e.g. 2001_06). 

Note: A job can include a maximum of 1000 samples. 
If you measure a lot of samples it will be useful to use weekly or daily generated 
jobs. 

The check box at the bottom of the dialog can be used to start the Routine Dialog 
automatically with X-LabPro. 

You must define at least one method class. Click on the Method Class tab control 
to open the following sheet: 
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The picture shows a system containing 3 method classes. Up to 20 method 
classes can be defined. Use the Insert and Delete button to manage your method 
classes. After you have defined the method classes use the Method Assignment 
sheet to assign the methods to the defined classes. 

 

Select the method class in the drop down list at the top right of the dialog. Use 
Insert to add selected methods from the list at the left to the selected method class 
represented by the right list. Use Delete to remove a selected method from the 
right list. 

Click to the Locked Positions sheet to define the list of locked positions as shown 
in the picture below. Use New to open the Edit Locked Positions dialog box for 
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selecting locked positions. By clicking Edit you can edit the selected list of locked 
positions. Click Delete for deleting the selected list of locked positions. 

 

In the Columns sheet you can define the order of the columns and select if you 
want the columns to be visible or hidden. Use the Up and Down buttons to change 
the order position of a selected column. Double-click on a column to change 
between visible or hidden. 

 

After the configuration is finished it is meaningful to edit and check the settings on 
the first sheet Presets again and to save the configuration. Restart all the X-
LabPro applications to make user of the new settings. 
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If you want to change the settings for a selected plate in the Routine Dialog, use 
the Settings dialog box that can be opened by clicking Settings in the Extras 
menu. 

 

3 Result Viewer 
Certain applications require the compliance with a predefined set of concentration 
limits for one or more elements. The result viewer not only controls the compliance 
of the analytical result, it also presents it in a visual form with all relevant 
information included. 

 

 

3.1 Selection of elements / definition of concentration limits 
Open the “Method Administration” and select a method.  In the tab “Output” – 
“Element Options” select the elements which have to be monitored.   

 

To activate the Result viewer click on “Open Result View after Measurement”. 
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Select tab “Elements” and enter the minimum and maximum concentration range. 

 

 

Open the “Results viewer”. 
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After a measurement is finished the results are displayed.  

Green bar   : defined concentration range 

Green arrow : result within concentration range 

Red arrow  : result out of concentration range 

 

 

 

If you would like to have further information, click on “Tools – Settings”.  
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Here you can choose if you would like a scaling on the bars and a different color 
for the concentration limits. 

 

 

In the menu bar “View” you can either create a bitmap or open the bitmap in an 
external application. 
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4 Spectra Viewer 

4.1 The Spectra Viewer 
The Spectra Viewer is used to view and compare spectra measured by your X-
LabPro software. To select spectra for the representation, the Spectra Viewer 
offers two possibilities: 

 The Tree Control 

 The Selection Table 

If at least one spectra window is shown, the following menus are enabled: 

 File Menu 

 View Menu 

 Spectrum Menu 

 MCA Menu 

 Window Menu 

 Help Menu 

4.2 The Tree Control 
In the left area of the Spectra Viewer it is possible to display the tree control. The 
tree control displays the methods or jobs; you can select it below the control use 
the tab control. The small blue number behind the methods (or jobs) shows the 
number of samples a method or job is containing. The small number behind the 
sample shows the number of measurements. The different sample types are 
displayed by different icons, just as the different measurement states (-, M, A). 
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4.2.1 How to Select Spectra for Representation 

The usage of the tree control can be compared to the Windows Explorer. Use the 
following possibilities to select a spectrum for being displayed in a spectra window: 

 A double click on a measurement opens the spectrum in a new spectra 
window. 

 "Open new Spectrum Window" from the context menu (the context menu can 
be opened by clicking with the right mouse button on a measurement) opens 
the spectrum in a new spectra window. 

 "Add to Spectrum Window" displays the selected measurement in an opened 
(and activated) spectra window.  

 By clicking "Measurement Properties" important information about the 
measurement will be shown. 

4.2.2 How to Enable/Disable the Tree Control 
The tree control needs a lot of processor performance. Moreover, when opening 
the Spectra Viewer with an activated tree control, all databases must be scanned 
first. This needs a lot of time on older systems and it is possible that during a 
measurement, the databases will be locked. This causes possible errors and 
problems. 

Note: If you are using an older PC system or if you want to use the spectra 
viewer during measurements, please disable the tree control. 
The tree control can be enabled or disabled by using the Tree Control menu point 
in the View Menu. 

  

4.3 The Selection Table 
Use the selection table to decide which spectra in which order will be shown in the 
selected spectra window. You can open the selection table by using the menu 
point Selection Table in the Spectrum menu. Moreover, you can use the shortcut 
"Ctrl+T" or the  symbol in the toolbar. 
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4.3.1 Selecting Spectra 
Use the command buttons to select spectra. Activate the referring cell in the 
Sample Name column before. 

Paste Command Button 
If you have copied sample(s) into the clipboard e.g. from the method window, use 
this command button to paste it into the selection table. 

Sample Command Button 
Click this command button to open a dialog for selecting a sample from a method 
or from a job. 

Remove Command Button 
Click this command button to delete a selected sample from the selection table. 

Import Command Button 
You can import samples from files by clicking on this command button.. 

Export Command Button 
If a measurement is selected in the columns 1-6, you can export the sample data 
into a file. 

1,2,3,4,5,6,7,8,- Command Buttons 
Use this command buttons to define the order of the spectra. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 
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4.4 Menu Commands 

4.4.1 Spectra Viewer Menu Overview 
Menu overview 

 File Menu 

 View Menu 

 Spectrum Menu 

 MCA Menu 

 Tools Menu 

 Window Menu 

 Help Menu 

 System Menu 

4.4.2 Commands in the File Menu 
 New 

Creates a new spectra window. 

 Open 
Use the open command to load an existing spectra window. This command 
will open a standard Windows File Dialog to select the spectra window. 
Shortcuts: 

Toolbar:  
Keyboard: CTRL+O

 Close 
Use the close command to close the selected spectra window. You will be 
promted to save the spectra data if the data contains any new information. 

 Save 
Use this command to save the active spectra window to its current name and 
directory. If you want to change the name and directory of an existing spectra 
window before you save it, use the Save As command. 
Shortcuts: 

Toolbar:  
Keyboard: CTRL+S

 Save as 
Use this command to save and name the active spectra. The Spectra Viewer 
displays the Save As dialog box so you can name your spectra.  

To save a spectra with its existing name and directory, use the Save command. 

 Print 
Use this command to print the aktice spectra window. 
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 Exit 
Use this command to end the Spectra Viewer session. You can also use the 
Close command on the Application Control Menu. The Spectra Viewer 
prompts you to save documents with unsaved changes. 
Shortcuts: 

Mouse: Double click the application's Control menu Icon. 

 
Keys: ALT+F4 

 

4.4.3 Commands in the View Menu 
 Toolbar 

Use this command to display and hide the Toolbar, which includes buttons for 
some of the most common commands in the Spectra Viewer, such as File 
Open. A check mark appears next to the menu item when the toolbar is 
displayed. 
See Toolbar for help on using the toolbar. 

 Statusbar 
Use this command to display and hide the Status Bar, which describes the 
action to be executed by the selected menu item or depressed toolbar button, 
and keyboard latch state. A check mark appears next to the menu item when 
the Status Bar is displayed. 
See Status Bar for help on using the status bar. 

 ToolBox 
Use this command to display or hide the tool window. 

 Tree Control 
Use this command to display and hide the tree control. The tree control 
displays the methods or jobs. 

 Update Tree 
Use this command to update the tree control after valid database changes 
have been made from X-LabPro. Use F5 as shortcut for this command. 

 Rebuild Tree 
Use this command to rebuild the tree control completely from your X-LabPro 
database. 

4.4.4 Commands in the Spectra Menu 
The Spectra menu contents the following commands: 
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 Selection Table 
Select this menupoint to display the Selection Table Dialog Box. 

 Rotate 
Select this menupoint to rotate the order of the spectra in the selected spectra 
window. 

4.4.5 Commands in the Edit Menu 
This menu is used to manipulate the displayed foreground spectrum and second 
spectrum. The abbreviation "MCA" stands for Multi Channel Analyzer. The 
menupoints in the menu are similar to the functions of an MCA. The menu is 
shown only in the Spectra window. The following menupoints are available: 

 Normalize to 2nd Spectrum 
Select this menupoint to adjust the foreground spectrum to the second 
spectrum within a defined region (ROI). An adjustment factor is determined in 
the selected region using the least squares method. The channel contents in 
the foreground spectrum are then multiplied by this factor.  
The spectrum window will automatically switch to the ROI marking mode. 
Click the left mouse button in the spectral representation to select a ROI. The 
adjustment is automatically performed and the display is updated. 

 Normalite All to Foreground 
Select this menupoint to adjust the background spectra to the foreground 
spectrum within a defined region (ROI). An adjustment factor is determined in 
the selected region using the least squares method. The channel contents in 
the are then multiplied by this factor.  

 Copy to Foreground 
Select this menupoint to copy a selected region of the second spectrum into 
the foreground spectrum. 
The spectrum window will automatically switch to the ROI marking mode. 
Click the left mouse button in the spectral representation to select a ROI. The 
selected region of the second spectrum is automatically copied into the 
foreground spectrum and the display is updated. 

 Multiplicate 1st Spectrum... 
Select this menupoint to multiplicate the foreground spectrum with a factor. A 
dialog will be opened to edit the factor. 

 Add 2nd Spectrum 
Select this menupoint to add a selected region of the second spectrum from 
the foreground spectrum. 
The spectrum window will automatically switch to the ROI marking mode. 
Click the left mouse button in the spectral representation to select a ROI. The 
selected region of the second spectrum is automatically subtracted from the 
foreground spectrum and the display is updated. 

 Subtract 2nd Spectrum 
Select this menupoint to subtract a selected region of the second spectrum 
from the foreground spectrum. 
The spectrum window will automatically switch to the ROI marking mode. 
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Click the left mouse button in the spectral representation to select a ROI. The 
selected region of the second spectrum is automatically subtracted from the 
foreground spectrum and the display is updated. 

 Edit Channel Contents 
Select this menupoint to open the Edit Channel Contents dialog box. The 
impulse number can be manually edited for each channel in this dialog box. 
The display of the foreground spectrum is automatically updated. 

 Smooth Spectrum 
Select this menupoint to smooth the foreground spectrum using a three point 
formula. The smoothened spectrum is automatically displayed as the 
foreground spectrum. 

 First Derivative 
Select this menupoint to automatically calculate the first derivative of the 
foreground spectrum. The derivative is automatically displayed as the new 
foreground spectrum. Negative values or values smaller than 1 are displayed 
only in the linear representation display format. 

 Second Derivative 
Select this menupoint to automatically calculate the second derivative of the 
foreground spectrum. The derivative is automatically displayed as the new 
foreground spectrum. Negative values or values smaller than 1 are displayed 
only in the linear representation display format. 

 Calculate Background 
Select this menupoint to calculate a background for the foreground spectrum 
in the second spectrum. The Calculate Background dialog box opens. After 
the calculation, the calculated background is automatically displayed as the 
second spectrum. 

 Reset Foreground Spectrum 
Select this menupoint to abandon any changes to the foreground spectrum. 
The original data for the measurement is newly read from the measurement 
databank when the spectrum is reset.  

 Reset 2nd Spectrum 
Select this menupoint to abandon any changes to the second spectrum. The 
original data for the measurement is newly read from the measurement 
databank when the spectrum is reset. 

 Reset All Spectra 
Select this menupoint to abandon any changes to all spectra. The original 
data for the measurements is newly read from the measurement databank 
when the spectrum is reset.  

 Assign Background 
Select this menupoint to save the current spectrum as a background 
spectrum. 

Note: The manipulations are always performed on the foreground spectrum, with 
one exception (Calculate Background). 
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4.4.6 Calculate Background Dialog Box 

This dialog box is used to select the type of calculation to be used to calculate the 
background. This dialog box is opened with the Calculate Background menupoint 
in the MCA menu. The dialog box contains the following elements:  

Background Type Group Box 

Constant Background Option Button  
Select this option button to calculate a constant background. The background is 
calculated using the defined ROI. At least one ROI must be defined for a constant 
background. The following figure shows an example of a constant background: 

 

Linear Background Option Button  
Select this option button to calculate a linear background. The background is 
calculated using the defined ROI. At least two ROI must be defined for a linear 
background. The following figure shows an example of a linear background: 
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Quadratic Background Option Button  
Select this option button to calculate a quadratic background. The background is 
calculated using the defined ROI. At least three ROI must be defined for a 
quadratic background. The following figure shows an example of a quadratic 
background: 

 

OK Command Button  
Click on this command button to close the dialog box. The background is 
calculated and carried into thesecond spectrum. 

Cancel Command Button  
Click on this command button to close the dialog box and cancel the procedure for 
calculating the background. 

Note: 
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The calculated background is carried into the second spectrum. The calculated 
background can then be subtracted from a selected region of the foreground 
spectrum using the Subtract 2nd Spectrum menupoint in the MCA menu. 

4.4.7 Edit Channel Contents Dialog Box 
This dialog box is used to edit the impulse number for the channel at the position 
of the energy cursor for the foreground spectrum in the selected spectrum window. 
This dialog box is opened with the Edit Channel Contents menupoint in the MCA 
menu. The dialog box contains the following elements:  

Channel Display Field  
The number of the channel selected in the spectrum window is displayed in this 
display field. 

Energy Display Field  
The energy of the channel selected in the foreground spectra is displayed in this 
display field. 

Impulse (old) Display Field  
The number of impulses for the selected channel in the foreground spectrum is 
displayed in this display field. 

Impulse (new) Text Box  
Enter the new value for the number of impulses for the selected channel in this 
text box. 

 (Left Arrow) Command Button  
Click on this command button to select the previous channel. Changes in the 
impulse number for the currently selected channel are automatically carried into 
the foreground spectrum. 

 (Right Arrow) Command Button  
Click on this command button to select the next channel. Changes in the impulse 
number for the currently selected channel are automatically carried into the 
foreground spectrum. 

OK Command Button  
Click on this command button to close the dialog box and carry the new value into 
the foreground spectrum. 

Cancel Command Button  
Click on this command button to close the dialog box and cancel the procedure for 
editing the channel contents. 

Note: Select the Reset Foreground Spectrum in the MCA menu to reset any 
changes in the foreground spectrum. 

4.4.8 Window Menu 
This menu is used to switch between and arrange windows. The menu is 
displayed in every open window. The following menupoints are available: 

 Cascade 
Select this menupoint to arrange open windows so that the title bar of each 
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window is visible. Only a portion of the other windows is displayed. Scroll 
within the visible portion with the scroll bars. 

 Tile 
Select this menupoint to arrange all of the open windows side by side so that 
all of them are visible. Only a portion of the other windows is displayed. Scroll 
within the visible portion with the scroll bars. 

 Arrange Icons 
Select this menupoint to arrange the icons within the application window. 

4.4.9 Commands in the Help Menu 
 Contents 

Select this menupoint to display a table of contents for the help system for the 
X-LABPro program. In the help system, select the Contents command button 
below the menuline to show the table of contents. 

 Context Sensitive 
Select this menupoint to display a context sensitive help text. This menupoint 
corresponds to the command button with a question mark in the toolbar. 

 Software 
Select this menupoint to display a table of contents for the software 
description. Use of the operation and control software for the X-LAB energy 
dispersive x-ray fluorescence spectrometer is described in this section. 

 About XLSpcView 
Show the version and copyrights of the Spectra Viewer. 

4.5 Other 

4.5.1 Toolbar 

 

The toolbar is displayed across the top of the application window, below the menu 
bar. The toolbar provides quick mouse access to many functions used in the 
Spectra Viewer. 

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). 

Click To 

 
Create a new spectra window 

 
Open an existing spectra window. The Spectra Viewer displays the Open 
dialog box, in which you can locate and open the desired file. 

 
Save the active spectra window with its current name. If you have not 
named the document, the Spectra Viewer displays the Save As dialog 
box. 

 Display or hide the Toolbox Window 
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 Opens the Selection Table Dialog Box 

 
Rotate the order of the spectra in the selected spectra window 

 Print the actually spectra. 

 Calculate the associated escape lines for the selected elements. 

 Calculate the associated Pile-Up lines for the selected elements. 

 Search for elements in the actually spectra. 

 Insert a text at an arbitrary position. 

 Delete one or all inserted text(s) from the spectral representation. 

 Create a bitmap/jpeg file from the current spectral representation. 

 
Opens the Online Help. 

  

  

4.5.2 Status Bar  

 

The status bar is displayed at the bottom of the Spectra Viewer. To display or hide 
the status bar, use the Status Bar command in the View menu 

The left area of the status bar describes actions of menu items as you use the 
arrow keys to navigate through menus. This area similarly shows messages that 
describe the actions of toolbar buttons as you depress them, before releasing 
them. If after viewing the description of the toolbar button command you wish not 
to execute the command, then release the mouse button while the pointer is off 
the toolbar button.  

Moreover the database reading status will be shown in the statusbar by a progress 
bar.  

The right areas of the status bar indicate which of the following keys are latched 
down:. 

Indicator Description 

CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down. 
SCRL The Scroll Lock key is latched down.
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4.5.3 Titlebar 

 

The title bar is located along the top of a window. It contains the name of the 
application and the spectra window. 

To move the window, drag the title bar. Note: You can also move dialog boxes by 
dragging their title bars. 

A title bar may contain the following elements: 

 Exit button. 

 Maximize button. 

 Minimize button. 

 Name of the application. 

 Name of the spectra window

 Applications icon. 

  

  

  

4.6 Tool Window 

4.6.1 Toolbox 
The toolbox window offers a lot of functions to view and edit spectral 
representations. You can enable/disable this window by clicking the menu point 
Toolbox in the View menu. It may be freely moved around on the monitor. In this 
way, it is possible to move the window so that it does not interfere with your view 
of the portion of the spectrum that is being examined. The Toolbox window 
contains the following command buttons: 

 
Click on this button to stretch the displayed spectrum. At least 64 
channels are always displayed. 

 
Click on this button to compress the displayed spectrum. 

 
Click on this button to stretch the display of the spectrum along the y-
axis. The extent of the change depends on the type of display. 

 
Click on this button to compress the spectrum along the y-axis. The 
extent of the change depends on the type of display. 

 
Click on this button to shift the displayed spectrum in small steps to the 
left. 

 
Click on this button to shift the displayed spectrum in small steps to the 
right. 

 
Click on this button to shift the displayed spectrum in small steps 
upwards. 
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Click on this button to shift the displayed spectrum in small steps 
downwards. 

 
Click on this button to shift the displayed spectrum in large steps to the 
left. 

 
Click on this button to shift the displayed spectrum in large steps to the 
right. 

 
Click on this button to shift the displayed spectrum in large steps 
upwards. 

 
Click on this button to shift the displayed spectrum in large steps 
downwards. 

 
Click on this button to move the Energy cursor one channel to the left. If 
the Energy cursor is not active, it is automatically activated by clicking 
on this command button. 

 
Click on this button to move the Energy cursor one channel to the right. 
If the Energy cursor is not active, it is automatically activated by clicking 
on this command button. 

 
Click on this button to switch to the channel representation. 

 
Click on this button to switch to the energy representation. 

 
Click on this cursor to move the Z-cursor to the element with the next, 
higher atomic number. If the Z-cursor is not active, it is automatically 
activated by clicking on this command button. 

 
Click on this cursor to move the Z-cursor to the element with the next, 
lower atomic number. If the Z-cursor is not active, it is automatically 
activated by clicking on this command button. 

 
Click on this cursor to move the Z-cursor to the next, higher shell; the 
element with the nearest energy is chosen. If the Z-cursor is not active, 
it is automatically activated by clicking on this command button. 

 
Click on this cursor to move the Z-cursor to the next, lower shell; the 
element with the nearest energy is chosen. If the Z-cursor is not active, 
it is automatically activated by clicking on this command button. 

 
Click on this button to display or hide the background grid. 

 
Click on this button to turn display of the selected ROI on or off. Display 
of the ROI is automatically enabled after a ROI is defined. 

 
Click on this button to turn display of the selected line markers on or off. 
Display is automatically activated when line markers are selected. 

 
Click on this button to open the Select Elements dialog box in order to 
select the line markers to be displayed 

 
Click on this button to open the Select Lines dialog box in order to 
select the line markers to be displayed. 

 
Click on this button to delete the ROI at the current Energy cursor 
position.  

 
Click on this button to delete all of the ROI in the displayed spectrum. 

 
Click on this button to view data for the ROI data of the displayed 
spectra.  
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Click on this button to search for the lines at the current Energy cursor 
position.  

 
Click on this button to activate the logarithmic representation of the 
spectrum. 

 
Click on this button to activate the square root representation of the 
spectrum. 

 
Click on this button to activate the linear representation of the 
spectrum. 

 
Click on this button to reset the display of the spectrum to its original 
values. 

 
Click on this button to switch to the magnify mode. You can choose an 
area to zoom in by using your mouse. 

 
Click on this button if you want to switch the spectral representation to 
display one channel on one pixel. 

 
Click on this button to enable the ROI marking mode. Display of the ROI 
is automatically enabled after a ROI is defined. 

The cursor keys may also be used to move the Energy cursor. 

SPECTRO Analytical Instruments GmbH 

4.6.2 Select Lines Dialog Box 
You can use this dialog box to manage all displayed lines of your spectra window. 
You can choose lines from a list of all available lines or from a list of filtered lines: 

Available Lines List Box 
Shows all available Lines or lines filtered by element and/or by energy. Use the 
checkboxes "Filter By Element" and "Filter By Energy" to use the filter options. 

Filter By Element Check Box 
Enables a filter for displaying only lines belonging to the selected elemnt. You can 
enter an element atomic number or select an element from the periodic table. 

Filter By Energy Check Box 
Enables a filter for displaying only lines in a defined area of energy. Enter your 
energy limits in the text fields. 

Selected Lines List Box 
Shows the lines selected for being displayed in the spectra window. 

Insert Command Button 
Copies a selected line from the "Available Lines" list box to the "Selected Lines" 
list box. 

Remove Command Button 
Deletes the selected line in the "Selected Lines" list box. 

Remove all Command Button 
Deletes all lines in the "Selected Lines" list box. 

Show Line Marker Text Check Box 
Enables/disables the display of the line name for the selected line. 

Show Element Symbol Only Check Box 
Switch the announcement of the line designation in the spectrum representation 
on or off. 
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Show Escape Lines Check Box 
Switch the announcement of the Escape Lines in the spectrum representation on 
or off. 

Show Pile-Up Lines Only Check Box 
Switch the announcement of the Pile-Lines in the spectrum representation on or 
off. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

5 Method Administration 
The Method Administration is used to do all settings for the methods in the X-
LabPro software. Create, edit or delete methods or the assigned standard samples 
here. You get information about the methods in general and about their standard 
samples or measurements. Settings for deconvolution or calibration may also be 
done.. The Method Administration offers two possiblities to navigate through and 
use the application: 

 The Tree Control 

 The Method Window 

If at least one method is opened, the following menus are enabled: 

 File Menu 

 Edit Menu 

 View Menu 

 Method Menu 

 Tools Menu 

 Window Menu 

 X-LabPro Menu 

 Help Menu 

5.1 The Method Window 
In the right area of the Method Administration the Method Window is displayed. 
Here you get some different property pages which guide you to get information 
and do settings dependant on the opened method. Click on the title of a property 
page to open it. 
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 General: This page includes general information about the opened method 
like global settings, dilution, normalization and additional settings. Moreover, 
you can finalize the method here.  

 Elements: You may choose the elements you want to analyse and do the 
settings on this page.  

 Standards: Get a table of the assigned standard samples of the opened 
method and information about these standard samples.You may also create, 
edit or delete standards here.  

 Measurement: On this page you get information or do settings for the number 
and type of measurements.  

 Deconvolution: This page offers you the possibility to do settings for the 
deconvolution. Calibration: Do the settings for the calibration on this page.  

 Output: Do the settings for the printer output on this page.  

If you select another page of the Method Window by clicking the title of this page 
and if you have changed values or parameters, you will be prompted to confirm 
the changes. In this case the changes will be written to the database immediately. 

See also: 
Method Administration 
Method Administration ( Tree Control ) 

5.2 The Tree Control 
In the left area of the Method Administration the tree control is displayed. Here you 
find all methods ordered by their sample types. Click on the small cross next to an 
icon to open a sample type folder and get a list of the methods. The small blue 
number behind the description of a folder shows the number of methods the folder 
is containing. A padlock behind the name of a method indicates that the method is 
finalized. Double click on a method to open it in the Method Window. You may 
also use the context menu to open a method: Right click on a method and select 
OPEN. 
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You may sort the different methods in a hierachy by using the option Subclass 
Methods of the File Menu. While selected, this option offers you to drag a method 
with a left mouse click and drop it as a child in the tree. 

 

See also: 
Method Administration 
Method Window 

5.3 General Page 
The General Page of the Method Window is used to set the parameters for the 
method, dilution material and normalization in different group boxes. You may also 
finalize the method currently selected or do an automatic recalibration. 

Global Settings Group Box 
The global method settings are displayed and can be changed with the dialog 
elements in this group box. The individual elements have the following meanings: 

Method Name Text Box  
The name of the currently selected method is displayed and can be changed in 
this text box. 

Created by Text Box  
The name of the user who created the method is displayed and can be changed in 
this text box. 

Sample Type Drop-down List Box  
The sample type for which the method was defined is displayed and can be 
changed in this drop-down list box. 

Sample State Drop-down List Box  
The sample state to which the method is assigned is displayed and can be 
changed in this drop-down list box. The parameters depand on the pre-defined 
sample state. To define/edit sample types/states use the configuration editor. 

Description Text Box  
A short description of the method is displayed and can be changed in this text box. 
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Matrix for Calib. Text Field  
The chosen matrix for calibration is displayed in this text field.  

Select Button 
Click on this button to select a matrix for calibration. The matrices can be defined 
in the configuration editor. 

Edit Button 
Click on this button to create or edit a matrix for calibration 

Mathematics Drop-down List Box  
The mathematical method for the calculation is displayed and can be changed in 
this drop-down list box. 

Option Drop-down List Box  
Use this drop-down to select what kind of method you want to create (e.g. 
recalibration). 

Use external concentration as Drop-down List Box  
The meaning of the external concentration is displayed and can be changed in this 
drop-down list box. 

Dilution Group Box 
The information about the used dilution is displayed and can be changed with the 
dialog elements in this group box. The individual elements depend on the selected 
sample state and can be pre-defined in the configuration editor. 

Dilution Material Drop-down List Box  
The dilution material of the currently selected method is displayed and can be 
changed in this drop-down list box. 

Sample Mass Text Box  
The sample mass ( in g ) of the currently selected method is displayed and can be 
changed in this text box. 

Dilution Mass Text Box  
The dilution mass ( in g ) of the currently selected method is assigned is displayed 
and can be changed in this text box. 

Sum/Factor Display Fields  
The sum of the sample mass and the dilution mass and the part of the sample 
mass of the sum of both is displayed in this display field. 

Additional Settings Group Box 
The additional method settings are displayed and can be changed with the dialog 
elements in this group box. The individual elements have the following meanings: 

Sample Diameter Text Box 
The sample diameter (in mm) is displayed and can be changed in this text box. 
The default diameter depends on the selected sample state and can be pre-
defined in the configuration editor. 

Cuvette Foil Drop-down List Box  
The type of the cuvette foil of the method is displayed in this drop-down list box. 

Protection Foil Drop-down List Box  
The type of the protection foil of the method is displayed in this drop-down list box. 
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Note: The foils can be defined in the configuration editor. 

Dust Protection Foil / Liquid Protection Cup Radio Button 
Select with this radio button the usage of the protection foil. If you select Dust 
Protection Foil the Routine Dialog will ask for inserting the foil. 

Standard for Comparison Display Field  
The standard for comparison of the method is displayed in this display field. To 
select or change the standard click on the button at right. You will be prompted to 
choose a standard. Click on the cross to delete the selection. 

Normalization Group Box 
The settings of the normalization are displayed and can be changed with the 
dialog elements in this group box. Choose the type of the normalization between 
the following dialog elements: 

No Normalization 
Select this option if you don´t want to normalize. See: Normalization. 

Use MSK Calibration 
Select this option to normalize via MSK Calibration. 

Normalize Results 
Select this option to normalize the results. You are asked to enter the 
normalization concentration by one value or a bandwith. 

Difference Element 
Select this check box to enter an element which influences the sample but which 
isn´t measurable. This can be used to tell the mathematical procedure, what's the 
"non-visible" part of the sample. You may enter the number of the element in the 
text box below or left click on the button PTE to get the periodic table of elements 
where you can choose one element. 

Finalize Button 
To finalize your method click this button. Note: A finalized method cannot be 
modified further. 

See also: 
Method Administration 
Method Window 

5.4 Element Page 
You may choose the elements you want to analyse and do the settings on this 
page of the Method Window. This page offers the following dialog elements: 

Coherent Back Scatter Correction Text Box  
The intensity correction factor for the coherent back scatter correction is displayed 
and can be changed in this text box. 

Incoherent Back Scatter Correction Text Box  
The intensity correction factor for the incoherent back scatter correction is 
displayed and can be changed in this text box. 

Typical Standard Display Field  
The typical standard sample for this method is displayed in this display field. To 
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select or change the standard sample click on the button at right. You will be 
prompted to choose a standard sample. Click on the cross to delete the selection. 

Elements Button 
Click on this button to select the elements you want to analyse. The Select 
Elements dialog box will be opened and shows a periodic table of elements. Here 
you may select the desired elements. All of the elements that are to be expected 
for the samples to be measured should be selected. 

Display Matrix Check Box 
Activate this check box to enable the matrix presentation of the selected elements 
and the displayed values. 

Elements Table 
In the table below the selected elements are listed. Do the settings for the different 
elements here. The table contains the following columns: 

N Column  
The atomic number of the element is displayed in this column. 

Sym. Column  
The element symbol (or its chemical bond) of the element is displayed in this 
column. 

Name Column  
The name of the element is displayed in this column. 

Analysis Elem Column  
Select this option to include the element to the analysis. A check mark appears if 
the option is selected. 

LOD [µg/g] Column  
This column shows the value for the Limit of Detection of the element. You may 
enter a new value. Valid entries lie in the range between 0 and 10000 µg/g. 

Conc. Range Min [µg/g] and Conc. Range Max [µg/g] Columns 
It is possible to calculate up to three calibrations for different concentration ranges. 
Control of selection of the range is conducted using the min and max 
concentration limit for the respective calibration. Enter the desired range in this two 
columns. If only one calibration is to be calculated, then select the concentration 
limits for this range so that all possible cases fall within one range. 

Conc. Limit [µg/g] Column  
Enter the concentration limit for consideration of the lower shell for the selected 
element in this column. 

See also: 
Method Administration 
Method Window 

  

 



                     
 

X-LabPro  5  
 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 68 of 391 
 
 

5.5 Standard Page 
On this page of the Method Window all standard samples assigned to the opened 
method are listed in a table. You may edit the standard samples by using the 
menu points in the Edit Menu, the buttons of the toolbar or the menu points of the 
context menu. The context menu will be opened by right clicking on a standard 
sample, it contains the same menu points as the Edit Menu.. Please see Edit 
Menu for additional information. 

Standards Table 
In the table below the standard samples are listed. The table contains the following 
columns: 

Name Column  
The name of the standard sample is displayed in this column. 

Description Column  
The description of the standard sample is displayed in this column. 

Status Column  
The measurement status of the standard sample is displayed in this column. 

Creation Date Column  
The creation date of the standard sample is displayed in this column. 

Evaluation Date Column  
The evaluation date of the standard sample is displayed in this column. 

Dilution Column  
If the standard sample is using a dilution, a check mark appears in this column. 

Backg. Column  
If the standard sample is a background sample, a check mark appears in this 
column. 

See also: 
Method Administration 
Method Window 
Method Administraiton (Edit Menu)  
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5.5.1 The Enter/Edit Sample Data Dialog 

 

This dialog box is used to enter and edit data for a sample or a standard sample. 
The dialog box contains the following elements:  

General Information Group Box 

Sample Name Text Box  
Enter the sample name (up to 250 characters) in this text box.  

Comment Text Box 
Enter an additional description (up to 20 characters) for the sample here. This text 
box does not have to be filled in.  

Method Drop-Down List Box 
The name of the method to which the sample is assigned is displayed in this 
display field. When editing a sample (not standard) you can select a method here. 

Job Drop-Down List Box 
The sample can be assigned to a job in this list box. This command is not active 
for the definition of a standard sample, because standard samples are always 
assigned to a single method. If the dialog box is opened from the Job Manager, 
then the name of the currently selected job is automatically entered.  
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Control Sample Display Field and Buttons 
The name of the sample for comparison (control sample) is displayed in this 
display field. Use the  button to select a control sample spectrum. Use the  
button to remove your selection and reset the display field to "None". The 
spectrum of the control sample is shown as the second spectrum in the Routine 
Dialog (Measured Spectrum) during the measurement.  

Optional Entries Group Box 

Measurement Status 1 bis 6 Display Fields 
The measurement status of the sample is shown in these fields.  

Sample State Drop-Down List Box  
Select the desired sample state in this drop-down list box. The possible sample 
states can be changed in the Sample Settings dialog box.  

Dilution Material Drop-Down List Box  
Select the name of the desired dilution material in this drop-down list box. The 
possible dilution materials must be defined in the selected method as standard 
samples that are marked as dilution materials. If no dilution materials have been 
defined, the text "none" is displayed.  

Sample Mass Text Box/Display Field 
Enter the sample mass (in g) in this text box. Whether this field or the three 
following fields are active or not, depends on the settings in the Sample Settings 
dialog box. It is possible to choose between two variations: The entry of sample 
and dilution mass or the entry of total mass and dilution factor. For each option, 
the other quantities are automatically calculated.  

Dilution Mass Text Box/Display Field 
Enter the dilution mass (in g) in this text box (see "Sample Mass Text Box/Display 
Field" for additional information). 

Sum of Masses Text Box/Display Field 
Enter the sum of the masses for the sample (in g) in this text box (see "Sample 
Mass Text Box/Display Field" for additional information). 

Dilution Factor Text Box/Display Field  
Enter the dilution factor in this text box (see "Sample Mass Text Box/Display Field" 
for additional information).  

Diameter Text Box  
Enter the sample diameter (in mm) in this text box.  

Given Loss Of Ignition Text Box  
Enter the given value for the loss of ignition (in percent) in this text box. If you do 
not want to set a value for the loss of ignition, enter "-1" or simply a dash. The loss 
of ignition is interpreted to be 0% if a zero is entered. 

Date of Receipt Text Box  
Enter the date of receipt for the sample into your laboratory in this text box. The 
date is printed with the printout of the results. When a new sample is entered, this 
field is automatically filled with the current date.  
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Ext. Conc.  
Click on this command button open the Edit External Concentrations for Sample 
Dialog Box. 

OK Command Button  
Click on this command button to close the dialog box and save the modified or 
newly entered sample. 

Cancel Command Button 
Click on this command button to close the dialog box. New samples or changes to 
an existing  

See also: 

Edit Menu (Job Manager) 
Edit Menu (Method Development) 

5.5.2 Given Concentrations Dialog Box 
This dialog box is used to enter and edit the given (e.g. certified) concentration for 
a standard sample. This dialog box is opened with menu point Given 
Concentrations of the Edit Menu (Method Administration) or via the context menu 
of the Standards Page (Method Window). The dialog box contains the following 
elements: 

General Information Group Box 

Sample Name Display Field  
The name of the selected standard sample is displayed in this display field. 

Comment Display Field  
The comment of the selected standard sample is displayed in this text box. 

Sample State Display Field  
The state of the selected standard sample is displayed in this display field. The 
possible sample states can be changed in the Sample Settings dialog box. 

Dilution Material Display Field 
The name of the assigned dilution material is displayed in this display field. 

Sample Status Display Field 
The measurement status is displayed in this field. 

Sample Mass Display Field  
The sample mass is displayed in g in this display field. 

Dilution Mass Display Field  
The dilution mass is displayed in g in this display field. 

Dilution Factor Display Field  
The dilution factor calculated from the sample and dilution masses is displayed in 
this display field. 

Sample Specification Group Box 

Average Atomic Number Calibration Check Box  
Mark this check box if the selected standard sample is to be used for the Average 
Atomic Number Calibration. 
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Mass Attenuation Coefficient Calibration Check Box  
Mark this check box if the selected standard sample is be used for the Mass 
Attenuation Coefficients Calibration. 

Layer thickness standard Check Box 
Mark this check box if you want to use a layer thickness calibration. Note that the 
following elements will be enabled and overwrite other ones. 

Substrat Display Field 
The name of the assigned substrat is displayed in this display field. This display 
field overwrites the Dilution Material Display Field of the General Information 
Group Box. 

Density Display Field 
The density of the standard sample is displayed in this display field. This display 
field overwrites the Sample Mass Display Field of the General Information Group 
Box. Further the Dilution Mass and Dilution Factor Display Fields are disabled. 

Substrat Check Box 
Mark this check box if the selected standard sample is to be used as a substrat. 
This Check Box overwrites the Dilution Material Check Box of the Sample 
Specification Group Box. 

Layer Thickness [nm] Text Box 
Enter the layer thickness in this text box. This text box is added to the Settings for 
given conc. Group Box. 

Standard Type Drop-Down List Box 
Select in this Drop-Down List Box the sample type if the selected standard sample 
is to be used as one of the following sample types: 

Dilution Material (D) 

Validation Sample (V) 

Method Recal Sample (M) 

Intercept Recal Sample (I) 

Settings for given conc. Group Box 

Bonds Check Box 
Mark this check box if you want to enter the concentrations as bond 
concentrations. The bonds are set in the Edit Chemical Bonds dialog box . When 
entered, the concentrations for the bonded elements are automatically, 
proportionally entered. 

Output Ele. Only Check Box 
Mark this check box if you want to display only the output elements. Note: The 
elements H, C, N and O are always shown. 

Typical Unit Drop-Down List Box  
Select the typical mass unit for entry of the given values for the standard sample. 

Sum of Conc. Display Field 
The sum of the entered given concentrations is displayed in % in this display field. 

Concentration Values Group Box 
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In the Concentration Values Group Box you find a table with the following 
columns: 

Z Column  
The atomic number of the selected element is displayed in this column. Row 0 
includes the LOI (loss of ignition). 

Symbol Column  
The element symbols of the selected element is displayed in this column. 

Element Column  
The element names of the selected element is displayed in this column. 

Conc. Column 
Enter the given concentrations of the selected element in this column. 

Error Column  
Enter the absolute errors of the given concentrations of the selected element in 
this column. 

Level Column  
Select certification level for the selected element for the standard sample in this 
drop-down list box. 

Emp. 1, 2, 3, Fund. 1, 2 and Std. Columns 
Select this options by a left mouse click if the standard sample should be used for 
the calibration (Compton/empirical calibration, fundamental parameter calibration 
and recalibration) for the various evaluation methods for the selected element. A 
check mark appears in the field if the option is enabled. 

Std. Lib. Command Button (Save) 

  
 

Click on this command button to store the data for the standard sample in the 
library of standards. 

Std. Lib. Command Button (Load 

  

 
Click on this command button to load the data of a standard sample in the library 
of standards. 

Reset Command Button  
Click on this command button to reset the settings for the selected standard 
sample to the default values stored in the library of standards . The name of the 
standard sample must be the same as the name of an entry in the library of 
standards . If this is not the case, all of the concentrations are set to zero. A 
message to this effect is displayed. 

OK Command Button  
Click on this command button to close the dialog and store the settings that have 
changed. 
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Cancel Command Button  
Click on this command button to close the dialog without storing changes to the 
settings. 

5.6 Measurement Page 
On this page of the Method Window you can edit the settings for the 
measurements of the standard samples of the selected method. The page 
contains the following elements: 

General Settings Group Box 
Do the general settings for the measurements in this group box. The different 
elements have the following meanings: 

Measurements 1-8 Check Boxes  
Here you can select how many and which measurements should be assigned to a 
standard sample of the selected method. A check mark appears if the check box is 
selected. 

Measurement Type Drop-down List Box 
Select the measurement type of the standard samples in this Drop-down List Box. 

Sample Rotation Check Box 
If this check box is enabled the sample will be rotate during a measurement 

Quick Start Check Box 
If the Quick Start feature is enabled, gas flush or vacuum pumping will be done 
during the first measurement. When disabled, it will be done before the first 
measurement. 

Measurements Pages 
For each measurement selected in the General Settings Group Box you may do 
individual settings. Left click on the title of the measurement´s page you want to 
edit. The measurement pages offer you the following group boxes. 

Detection System Group Box 
Do the settings for the Detection System in this group box. The group box contains 
the following elements: 

Channels Drop-down List Box 
Select the number of channels for the measurement in this drop-down list box. 
Valid entries are 1024, 2048 and 4096. 

Peak Time [µs] Drop-down List Box 
Select the peak time that is to be used for the selected measurement in this drop-
down list box. 

Zero Peak Rate [cps] Drop-down List Box 
Select the zero peak rate that is to be used for the selected measurement in this 
drop-down list box. 

Energy Range[keV] Drop-down List Box 
Select the energy range that is to be used for the selected measurement in this 
drop-down list box. 
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Target Drop-down List Box 
Select the target to be used for the selected measurement in this drop-down list 
box. 

Generator Control Group Box 
Do the settings for the Generator Control in this group box. The group box 
contains the following elements: 

Voltage Group Box 
Use the slider to set the tube voltage for the selected measurement. The values 
that can be currently set, depending on the tube characteristic line, are displayed 
at the end of the scroll bar. Valid entries lie in the range between 8 kV and a value 
that can be set in the Instrument Control Settings dialog box. 

The currently set tube voltage is displayed in kV in the text box. A new value for 
the voltage can also be entered in this field. If the value "zero" is entered for the 
voltage and for the current, the measurements are conducted with out high 
voltage. This can be useful for tests or for measurements with a nuclide source. 

Current Group Box 
Use the slider to set the tube current for the selected measurement. The values 
that can be currently set, depending on the tube characteristic line, are displayed 
at the end of the scroll bar. Valid entries lie in the range between 8 and 80 mA. 

The currently set tube current is displayed in mA in the text box. If the value "zero" 
is entered for the voltage and for the current, the measurements are conducted 
with out high voltage. This can be useful for tests or for measurements with a 
nuclide source. 

Mark the Current Regulation Check Box to set automatically the current of the 
measurement by evaluating the best value. 

Measurement Time Limit Check and Group Box 
Mark this field and group to end the selected measurement after a given maximum 
time has elapsed. Measurement limited by time can be combined with 
measurement by impulse number; the measurement is ended as soon os one of 
the conditions has been met. You are asked to do some further settings: 

Measurement Time Text Box 
Enter the default time for the maximum measurement time in this text box when 
the measurement is to be limited by time. Valid entries lie in the range between 0 
and 200000 s. 

Measurement Pulse Limit Check and Group Box 
Mark this field and group to end the selected measurement after a given maximum 
impulse number has been reached in the given window (between first and last 
channel). You are asked to do some further settings: 

No. of Impulses Text Box 
Enter the maximum impulse number in this text box when the measurement is to 
be limited by impulse number. The measurement is ended when the sum of the 
impulses in the given window reach this number. 

First Channel Text Box 
When the measurement is to be limited by impulse number, enter the first channel 
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for the window in which the impulses are to be summed in this text box. Valid 
entries lie in the range between 1 and 1024 and must be smaller than or equal to 
the entry for the last channel. 

Last Channel Text Box 
When the measurement is to be limited by impulse number, enter the last channel 
for the window in which the impulses are to be summed in this text box. Valid 
entries lie in the range between 1 and 1024 and must be larger than or equal to 
the entry for the first channel. 

See also: 
Method Administration 
Method Window 

5.7 Deconvolution Page 
Use this page of the Method Window to do the settings for the deconvolution. This 
page contains the following three property pages: 

Number of background spectra Drop-Down List Box  
Set the number of background spectra used in this drop-down list box. Since 
Version 3.0 the background spectra are stored in samples named Background_xx. 
The switchover between regions is set for each sample by the scattering ratio. The 
default for the number of background spectra is 3 (for light, medium and heavy 
sample matrices). A maximum of 6 different background spectra can be used. To 
use more than one background it is necessary that a Compton target is used for 
the first measurement and the selected mathematics is Ext. Compton, Spectro or 
Compton/Rayleigh. 

Edit Limits Command Button  
Click on this command button to open the Limits for Background Spectra 
Switchovers dialog box in order to change the scattering ratio for the switch 
between the various background spectra. 

Property Pages 
Further you get some property pages: The general page and one page for each 
measurement.  

General Property Page  
This page shows a table with all elements selected on the Elements Page. It gives 
an overview about the settings on the n Measurement tables. For example a 2,3 in 
the Intensity column of the row of element 11 means that for the measurements 
number 2 and 3 the option Intensity of the element number 11 is selected. You 
cannot edit the table on this page, it is created to give you an overview. The table 
contains the following columns: 

N Column 
The atomic number of the element is displayed in this column. 

Sym. Column 
The element symbol of the element is displayed in this column. 

Name Column 
The name of the element is displayed in this column. 
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Intensity Column 
This column shows for which measurement and element the Intensity option is 
selected.Click on this command button to open the Select Elements dialog box. 
This dialog box is used to select the elements for which intensities are to be 
determined for the selected measurement. Individual elements can be selected for 
multiple measurements. Only elements that have been previously defined for the 
respective measurement as deconvolution elements can be selected. 

Concentration Column 
This column shows for which measurement and element the Concentration option 
is selected. 

Measurement n Property Page  
On this page you may do the individual settings for each measurement. The page 
contains the following elements: 

Element Table 
This table shows all intensity elements assigned to the measurement n. You may 
change the selection by clicking the Elements Button. The table contains the 
following rows: 

N Column 
The atomic number of the element is displayed in this column. 

Sym. Column 
The element symbol of the element is displayed in this column. 

Name Column 
The name of the element is displayed in this column. 

Conc Column 
Click on the check point in this column to select an element which concentrations 
are to be determined for the selected measurement. Each element can be 
selected for only one measurement. A number behind a check point indicates that 
the choosen element is already selected by the measuremment with the 
corresponding number. 

Line Column 
In this column you select the line to be used for the deconvolution in the drop-
down list box. The type of line that should be selected depends on the type of 
excitation and the selected element. The following line types are available: 

K-Alpha  
K-Beta  
L-Alpha  
L-Beta  
M-Alpha  
M-Xi  
 
Deconvolution Column  
In this column you select the deconvolution strategy to be used for the 
deconvolution in the drop-down list box. The following deconvolution strategies are 
available: 
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Summation 
The channel contents in the given deconvolution region are summed with this 
method. The K-alpha line should be used for elements with an atomic number 
> 21; the L-alpha line for elements with atomic numbers > 56. The lines are not 
subtracted from the spectrum. This strategy should only be used when no peak 
overlaps are expected. 

Series Fit 
This method is used when other methods cannot be used. 

Line Fit 
If the K-alpha or an L-alpha line (for elements with N > 56) is without overlaps, but 
the secondary lines are overlapped with K-alpha or L-alpha lines from other 
elements, then this overlap can be removed by determining the height of the lines 
that are not overlapped using a model adjustment. The heights of the secondary 
lines are calculated from the model spectrum and subtracted from the measured 
spectrum. The energetically next highest main line remains, without overlaps, in 
the spectrum. Main lines with more than 500 impulses are additionally used to 
standardize the energy-channel relationship with this method. 

Example: 
Evaluation of a Cr-Mn-Fe-Spektrum. The Mn K-alpha line is overlapped by the Cr 
K-beta line. The Fe K-alpha line is overlapped by the Mn K-beta line. Beginning 
with Cr, all of the elements can be processed with this method. 

Line Fit with Standard 
This method is similar to the line fit method, however, main lines with more than 
3000 impulses are used for a width-energy relationship standardization in addition 
to an energy-channel relationship standardization. 

Elements Button 
Click on this command button to open the Select Elements dialog box. Select the 
elements to be considered with the selected measurement in this dialog box. 
These elements are selected as deconvolution elements for this individual 
measurement. All of the elements that are to be expected for the samples to be 
measured should be selected. 

Deconvolution Region Button 
Click on this command button to open the Select Deconvolution Regions dialog 
box. The deconvolution regions for the respective measurement can be set in this 
dialog box. 

Background Region Button 
Click on this command button to open the Select Background Regions dialog box. 
The background regions for the respective measurement can be set in this dialog 
box. 

Normalization Region Button 
Click on this command button to open the Select Normalization Regions dialog 
box. The normalization regions for the respective measurement can be set in this 
dialog box. 

Iron Cobalt Corr. Check and Text Box 
Mark this check box to activate the optional iron-cobalt correction. This is 
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necessary when there is a high iron concentration and iron and cobalt are to be 
deconvoluted in the same measurement. Enter the correction factor for the iron-
cobalt correction in the enabled text box. 

Target Name Display Field 
The name of the target selected for the measurement is displayed in this display 
field. 

Use Optimization Check Box 
Mark this check box to enable the deconvolution optimization during the sample 
evaluation. 

Voltage Display Field 
The voltage selected for the measurement is displayed in this display field. 

Deconvolution cycles Text Box 
In this text box you determine how often the deconvolution will be repeated. 

See also: 
Method Administration 
Method Window 

  

5.7.1 Limits for Background Spectra Switchovers Dialog Box 
This dialog box is used to set the limits for the switchovers for the various possible 
background spektra. The dialog box is opened with the Edit Limits command 
button on the Deconvolution Page of the Method Window of the Method 
Administration. The dialog box contains the following elements: 

Scattering ratio for switchover to spectrum nText Boxes  
Enter the the scattering ratio for which the nth background spectrum should be 
used in the respctive text boxes. The switchover occurs from large to small values. 
For 3 background spectra, the default entry is, for example, 4.1 for spectrum 2 and 
1.5 for spectrum 3. In this way, samples with a scattering ration larger than 4.1 are 
evaluated with the first background spectrum; samples with a scattering ratio 
between 4.1 and 1.5 with the second background spectrum; and samples with 
smaller scattering ratios with the third background spectrum. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

5.8 Calibration Page 
Use this page of the Method Window to do the settings of the calibration 
parameters. The page contains the three following property pages: 

The method administration offers the following calibration models: 

 Mass Attenuation Coefficient  
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 Extended Compton  
 Fundamental Parameter Model  
 Lucas Tooth/Price  
 Spectro  
 Compton/Rayleigh 
 Layers  

You will see different dialog elements depending on the selected calibration 
model: 

Standards Property Page  
The Standards Property Page shows a table which contains the folloing columns: 

N Column 
The number in this column shows how often a standard sample was used for the 
calibration. An empty field means that the standard sample was not used. You 
may enter numbers between 1 and 5 to weigh the different standard samples. 

Standard Column 
The name of an assigned standard sample is displayed in this column. 

Intensity Column 
The value of the intensity determined from the measurement is displayed in this 
column. 

Given Column 
The value of the given concentration/MAC is displayed in this column. 

Calculated Column 
The value of the calculated concentration/MAC is displayed in this column. 

Difference Column 
The value of the calculated difference (calculated - given) is displayed in this 
column. 

Parameters Property Page  
This page displays a table with the assigned parameters. It contains the following 
columns: 

No. Column 
The number of the parameter is displayed in this column. 

Parameter Column 
The name of the parameter is displayed in this column. 

Value Column 
The value of the parameter is displayed in this column. 

Calibration Diagram Property Page  
On this page you get two diagrams with the following meanings: 

Upper Diagram 
This diagram displays the calibration line and can be used to check the calibration. 
Use the Context Menu to switch between different display formats. You get access 
to this menu by clicking the right mouse button on the diagram.  
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Lower Diagram 
This diagram shows the differences between the given and the measured values. 

 

Double click on this double line to open the 
diagram in a new window. The assigned context 
menu is still available. Move the mouse to this 
double line without clicking to get the information 
about the statistics. 

The diagram on this page shows the calibration line to check the calibration. To 
enlarge sections of the diagram, left click the mouse and draw a rectangle on the 
desired section. The section will zoom in when you release the left mouse button. 
Click the right mouse button to get access to the context menu. This menu 
contains the following menu point: 

Grid 
Select this option to display a grid on the diagram. This may simplify an 
interpretation. 

Print... 
Click on this command button to print the diagramm. A printer dialog will prompt 
you to do further settings. 

Reset 
Click on this command button to reset your changes. 

Enable All Command Button 
Click on this command button to include all standard samples in the calibration. 

Disable All Command Button 
Click on this command button to remove all standard samples from the calibration. 

Reset Command Button 
Click on this command button to undo the last calibration calculation. 

Calculate Command Button 
Click on this command button to calculate the mass attenuation coefficients 
calibration. 

Corrections Command Button 
Click on this command button to open the Correction Values dialog box. This 
dialog box is used to edit element dependent corrections. 

Calibration Data Group Box 
The Calibration Data Group Box contains the following elements: 

Element Text Box and PTE Command Button 
Select the element for which the calibration is to be conducted with this 
combination. Either the respective atomic number can be entered in the text box or 
the Select Element dialog box can be opened with the PTE command button. The 
command buttons Element Change can be used to increase or decrease in single 
steps the atomic number displayed. The name of the selected element is 
displayed in the display field. Only elements that have been selected as 
concentration elements in the deconvolution method may be selected.  
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Command Buttons 

 Click on this command button to calibrate the next element. 

 
Click on this command button to select the standard sample in the 
diagram that has the next, lower given concentration. 

 
Click on this command button to select the standard sample in the 
diagram that has the next, higher given concentration. 

Lower Conc. [µg/g]: Text Box 
Enter the lower limit for the concentration range in this text box. 

Upper Conc. [µg/g]: Text Box 
Enter the upper limit for the concentration range in this text box. 

Calibration Weight Text Box 
Enter a concentration with which the concentration of the element of interest is to 
be weighted before the calculation of the calibration parameters. 

Color Level [%] Text Box 
Enter a color level which determines the deviation of given and calculated 
concentrations in %. Deviations which are bigger than the entered level will be 
colored red. 

Hide non-certified samples Check Box 
Select this option to show only the standard samples with given concentration and 
intensity values. If this option is not selected all standard samples will be 
displayed. 

Output Unit Check Box 
Select this option to switch to a defined output unit. The default unit is ppm.  

Log. Term Check Box 
Mark this check box to use a logarithmic term for a Compton model during the 
calibration. 

Comp./Ray. Ratio as Matrix Element Check Box 
Mark this check box to use the Compton/Rayleigh ratio as a matrix element. 

Ratio Limit Text Box 
Enter a limiting value for the Compton/Rayleigh ratio in this text box. The ratio is 
used as a matrix beginning with this limiting value. This text box is only active if the 
check box described above is selected. 

Compton Range Measurement Drop-down List Box 
The measurement number for the backscatter region for the defined normalization 
region is displayed in this text box.  

Compton Range Region Drop-down List Box 
The region number for the backscatter region for the defined normalization region 
is displayed in this text box.  

Calib. incl. overlapping elements Check Box 
Mark this check box to do the calibration including the overlapping elements. 
These elements are selected via the Overlapping Elements Command Button. 

Overlapping Elements Command Button 
Click on this command button to open the Intensity Elements dialog box. All 
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elements that have been defined as concentration elements at the Deconvolution 
Page can be selected as intensity elements. 

Calibration with Offset Check Box 
Select this option to calibrate with an offset value. 

Secondary excitation via matrix element Check Box 
Select this option if you want to assign the secondary excitation to the calibration. 

Matrix Elements Command Button 
Click on this command button to open the Matrix Elements dialog box. All 
elements that have been defined as concentration elements at the Deconvolution 
Page can be selected as matrix elements. 

K-Shell Radio Button 
Select this option to switch to the K-Shell. 

L-Shell Radio Button 
Select this option to switch to the L-Shell. 

Thick sample extrapolation Check Box 
Select this option to enable the thick sample extrapolation. This is necessary if you 
want to measure a sample containing "heavier" elements than Fe. 

Note: 

Display of the calibration line and of the normalized impulse number enable you to 
check the calibration of the instrument and whether or not the concentrations of 
your samples are covered by the calibration. 

During creation of user-defined methods, the diagrams allow you to check your 
standard samples and the quality of the calibration. 

   

5.9 Output Page 
The Output Page of the Method Window is used to do settings for the printer 
output. It contains the following elements. 

General Group Box 
The general output settings are displayed and can be changed with the dialog 
elements in this group box. The individual elements have the following meanings: 

Drop-down List Box 
Select Standard or Cement Modules depending on the selected method. When 
selecting cement modules, all other dialog items except the Cement Modules 
button will be disabled. 

Base Matrix for Output Text Field 
The selected base matrix for the output of the present method is displayed in this 
text field. 

Select Button 
Click on this button to select a base bond class for output. A dialog will open to 
choose a matrix. Bond classes can be defined in the Configuration Editor => 
Bonds. 
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Edit Button 
Click on this button to edit the chemical bond. The Edit Chemical Bond Dialog will 
open to do the settings for the output bond format. 

Output Unit Button 
Click on this button to edit the output unit of the elements. A dialog will prompt you. 

Print Form Group Box 
In this group box you may choose the output form and the output destination. The 
group box contains the following elements. 

Drop-down List Box  
Choose the output form in this Drop-down list box. There are three possibilities. 

 By Sample (Elements in rows) 
With this output form, each sample is printed on a new page, and the 
respective element data is printed by row in a table format. This print form 
allows the most adjustment. 

 By Sample (Elements in columns) 
With this output form, each sample is printed on a new page, and the 
respective element data is printed in columns. 

 By Elements  
With this output form, the printout consists of a table in which the data for all 
samples is sorted according to elements. This form is practical when the 
element data for a series of samples is to be compared. To print statistics, this 
selection is necessary. 

Print to Printer Radio Button 
Choose this option to print to a printer. 

Print to File Radio Button 
Choose this option to print to a file. 

Print to Printer and File Radio Button 
Choose this option to print to a printer and to a file. 

File Settings Button 
Click on this button to do special settings for the printing to a file. A dialog will 
prompt you to do further settings. This Button is only enabled if you select the Print 
to File Radio Button or the Print to Printer and File Radio Button. 

Element Options Group Box 
In this group box you choose which elements will be printed and the order of the 
elements. 

Elements Button 
Click on this button to open the Select Elements Dialog Box where you can 
choose which elements will be printed. 

Sort Elements Check Box 
Mark this check box if the elements by the print should be sorted with the order of 
elements configuration. 

Order Button 
Click on this button to determinate the order of elements for the printer output. The 
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Determinate Order of Elements Dialog Box will prompt you to do the configuration 
settings. 

Intensity Options Group Box 
Do the settings for the intensity options in this group box. The box contains the 
following elements. 

Drop-down List Box  
Select an entry of the list box. 

 no counts: No intensity counts will be printed. 

 net counts: The total number of intensity counts will be printed. 

 normalized intensity: The normalized intensity counts will be printed. 

 normalized intensity (compton): The normalized intensity counts by compton 
will be printed. 

Show C/F for intensities 
Select this option to print the "F" for fundamental calculated results. 

Special Options Group Box 
Do special settings in this group box. The box contains the following elements 

Short Sample Header Check Box 
Mark this check box if a short description of the sample (sample name, 
description, measurement and evaluation date) is desired, even on the first side of 
the sample report. 

MAC Check Box 
Select this option to print the Mass Attenuation Coefficient. 

Loss of Ignition Check Box 
Mark this check box if the calculated loss of ignition should also be included in the 
sample report. 

Sum of Concentration Check Box 
Select this option to print the sum of all concentrations of the elements 

Overflow Calibration Range Check Box 
If the calculated concentration is greater than the highest concentration in the 
calibration this will be marked by a "~" character if this check box is marked. This 
Check Box is only enabled if you select "by sample (elements in rows)" in the 
drop-down list box of the Print Form Group Box. 

Print Statistic Check Box 
Select this option to print a statistic. This check box is only enabled if you select 
"by elements" in the drop-down list box of the Print Form Group Box. 

Cement Modules Button 
Select this option to get a special printer form created for . A dialog will prompt you 
to do further settings assigned to the output. 

See also: 
Method Administration 
Method Window 
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5.9.1 Determinate Order of Elements Dialog 
Edit the order of the elements to print in this dialog. The dialog contains the 
following elements. 

Selected Elements List Box 
All elements which should be printed out are displayed in this list box.  

Insert Button 
Select one element in the Selected Elemtents List Box and click on this button to 
add this element into the Order of Output List Box. 

Remove Button 
Select one element in the Order of Output List Box and click on this button to 
remove the element of the Order of output List Box. 

Delete All Button 
Click on this button to remove all elements from the Order of Output List Box. 

Order of Output List Box 
In this list box all elements to be printed are diplayed, in order of their output. 

Up Button 
Select an element of the Order of Output List Box and click on this button to move 
it up one step in the order of output. 

Down Button 
Select an element of the Order of Output List Box and click on this button to move 
it down one step in the order of output. 

OK Button 
Click on this button to confirm your selection and close the dialog. 

Cancel Button 
Click on this button to close the dialog without changes. Your selection won´t be 
saved. 

5.9.2 Edit Chemical Bond Dialog 
This dialog is used to edit the chemical bonds you want to be displayed on the 
printer output. You get the following elements. 

Considered Bonds Group Box 
The general output settings are displayed and can be changed with the dialog 
elements in this group box. The individual elements have the following meanings: 

Base Element 
The selected element´s number is displayed in the text box. You may click on the 
PTE-button to open a periodic table of elements and choose another element to 
edit. Right of this button the name of the element is displayed. Click on the buttons 
right of the name of the element to step through the periodic table of elements. 

Bond Notation Text Box 
The bond notation is displayed in this text box. You may edit the bond notation. 

Name of Bond Text Box 
You may enter a name of the bond in this text box. 
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Conversion Factor Text Field 
The conversion factor is displayed in this text field. 

Bond Elements Group Box 
The bond elements and the assigned stoichiometric factors are displayed and can 
be edited in this group box. The individual elements have the following meanings: 

Element Column 
In this column the selected element is displayed. Further the assigned bonds are 
displayed. You may edit a bond by clicking on the PTE-button which opens the 
periodic table of elements. 

Stoichiometric Factor Column 
The stoichiometric factor of the elements in the left column are displayed in this 
column. 

OK Button 
Click on this button to close the dialog and confirm the changes. The changes will 
be stored in the database. 

Cancel Button 
Click on this button to close the dialog without saving the changes. 

5.10 Library of Standards Dialog Box 

5.10.1 Select Standard Dialog Box 
This dialog box is used to select a standard from the library of standards. This 
dialog box can be opened by using the Library Of Standards menu point in the 
Tools Menu of the Method Administration. The dialog box contains the following 
elements:  

Standard Name and Description Column 
The names and short descriptions of the standard samples stored in the library of 
standards are displayed in these columns 

Dilution Column  
A mark displays the use of a dilution in a standard sample. 

New Command Button 
Click on this command button to open the Library of Standards: Edit Standard 
Data dialog box in order to enter the data for a new record in the Library of 
standards . This command button is only active in the supervisor level. 

Edit Command Button 
Click on this command button to open the Library of Standards: Edit Standard 
Data dialog box in order to change the data for an existing record in the Library of 
standards . The standard sample to be changed must first be selected in the list 
box. This command button is only active in the supervisor level. 

Delete Command Button 
Click on this command button to delete the standard sample currently selected in 
the list box from the library of standards. This command button is only active in the 
supervisor level. 
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Display Command Button  
Click on this command button to open the Library of Standards: Display Standard 
Data dialog box and view the data for the standard currently selected in the list 
box. 

OK Command Button  
Click on this command button to close the dialog and store the settings that have 
changed. 

5.10.2 Library of Standards: Display Standard Data Dialog Box 
This dialog box is used to display the data stored in the library of standards. The 
dialog box contains the following elements: 

General Information Group Box 

Sample Name Display Field  
The name of the standard sample is displayed in this display field.  

Comment Display Field  
The comment of the selected standard sample is displayed in this display field. 

Sample Mass (g) Display Field 
The sample mass of the standard sample is displayed in this display field. 

Dilution Mass (g) Display Field 
The dilution material mass of standard sample is displayed in this display field. 

Dilution Factor Display Field  
The dilution factor calculated from the given sample mass and the given dilution 
material mass is automatically displayed in this display field. 

Sample Specification Group Box 

Average Atomic Number Calibration Check Box  
This check box is marked if the selected standard sample is to be used for the 
Average Atomic Number Calibration. 

Mass Attenuation Coefficient Calibration Check Box  
This check box is marked if the selected standard sample should be used for the 
Mass Attenuation Coefficients Calibration. 

Dilution Material Check Box 
This check box is marked if the selected standard sample is to be used as a 
dilution material. 

Settings for given conc. Group Box 

Typical Unit Drop-Down List Box  
The typical mass unit for entry of the given values for the standard sample. is 
displayed in this drop-down list box. 

Sum of Conc. Display Field 
The sum of the entered given concentrations is displayed in % in this display field. 

Given concentration Group Box 

In the Given concentration Group Box you find a table with the following columns: 
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First Column  
The atomic number of the selected element is displayed in this column. Row 0 
includes the loss of ignition . 

Symbol Column  
The element symbols of the selected element is displayed in this column. 

Element Column  
The element names of the selected element is displayed in this column. 

Conc. Column 
The given concentration of the selected element is displayed in this column. 

Error Column  
The absolute error of the given concentrations of the selected element is displayed 
in this column. 

Level Column  
The certification level for the selected element for the standard sample is 
displayed in this drop-down list box. 

Emp. 1, 2, 3, Fund. 1, 2 and Std. Columns 
These options are marked if the standard sample should be used for the 
calibration for the various evaluation methods for the selected element. 

OK Command Button  
Click on this command button to close the dialog. 

5.10.3 Edit Standard Data Dialog Box 
This dialog box is used to edit the data stored in the library of standards. The 
dialog box contains the following elements: 

General Information Group Box 

Sample Name Text Box  
Enter a name for the standard sample in this text box. The name should be in 
compliance with accepted international nomenclature and may be up to 20 
characters long. 

Comment Display Field  
The comment of the selected standard sample is displayed in this text box. 

Sample Mass (g)Text Box  
Enter the sample mass for the standard sample in this text box. Valid entries lie in 
the range between 0 and 6.5 g. 

Dilution Mass (g)Text Box  
Enter the dilution material mass for the standard sample in this text box. Valid 
entries lie in the range between 0 and 6.5 g. 

Dilution Factor Display Field  
The dilution factor calculated from the given sample mass and the given dilution 
material mass is automatically displayed in this display field. 

Sample Specification Group Box 
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Average Atomic Number Calibration Check Box  
Mark this check box if the selected standard sample is to be used for the Average 
Atomic Number Calibration. 

Mass Attenuation Coefficient Calibration Check Box  
Mark this check box if the selected standard sample should be used for the Mass 
Attenuation Coefficients Calibration. 

Dilution Material Check Box 
Mark this check box if the selected standard sample is to be used as a dilution 
material. 

Settings for given conc. Group Box 

Typical Unit Drop-Down List Box  
Select the typical mass unit for entry of the given values for the standard sample. 

Sum of Conc. Display Field 
The sum of the entered given concentrations is displayed in % in this display field. 

Given concentration Group Box 

In the Given concentration Group Box you find a table with the following columns: 

First Column  
The atomic number of the selected element is displayed in this column. Row 0 
includes the loss of ignition . 

Symbol Column  
The element symbols of the selected element is displayed in this column. 

Element Column  
The element names of the selected element is displayed in this column. 

Conc. Column 
Enter the given concentration of the selected element in this column. 

Error Column  
Enter the absolute error of the given concentrations of the selected element in this 
column. 

Level Column  
Select certification level for the selected element for the standard sample in this 
drop-down list box. 

Emp. 1, 2, 3, Fund. 1, 2 and Std. Columns 
Select this options by a left mouse click if the standard sample should be used for 
the calibration for the various evaluation methods for the selected element. A 
check mark appears in the field if the option is enabled. 

OK Command Button  
Click on this command button to close the dialog and store the settings that have 
changed. 

Cancel Command Button  
Click on this command button to close the dialog without storing changes to the 
settings. 
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5.11 Menu Commands 

5.11.1 Commands in the File Menu 
 Method Wizard 

Creates a new method. The X-LabPro Method Wizard will be opened to assist 
you. 

Toolbar: 

 Close 
Use the Close command to close an opened method. 

 Print 
Select the Print command to print one or more selected standard samples of 
the method opened in the method window. You will be promted to select a 
printer and do the printer settings. 

Toolbar: 

 Print Preview 
Get a preview of the printer output of the standard sample(s) you want to 
print. 

 Subclass Methods 
Select this option to sort the methods in the Tree Control. A check mark 
appears next to the menu item as long as the option is enabled. After 
enabling this option you can move the methods in the tree control via drag-
and-drop. You must first close all open method windows to make use of this 
feature. 

 Exit 
Use this command to end the Method Administration session. You can also 
use the Close command on the Application Control Menu. 

See also: 
Method Administration 
Method Administration ( Tree control ) 
Method Window 
Method Administration ( Toolbar ) 

  

5.11.2 Commands in the Edit Menu 
 New... 

Use this command to create a new standard sample in the selected method. 
This command will open the Enter/Edit Sample Data Dialog. 

 Edit... 
Use this command to edit a selected standard sample. This command will 
open the Enter/Edit Sample Data Dialog. 
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 Given Concentrations... 
Use this commands to enter given concentrations for a standard sample. This 
command will open the Given Concentrations Dialog Box. 

 Copy 
This command copies the selected standard sample(s) of the present method 
to the X-LabPro-clipboard. 

Toolbar: 

 Paste 
Use this command to paste standard samples from the X-LabPro-clipboard to 
the present method. The data of the measurements will not be pasted. 

Toolbar: 

 Paste with Data 
Use this command to paste standard samples from the X-LabPro-clipboard to 
the present method. The data of the measurements will be pasted too. 

 Clone 
This command clones the selected standard sample(s) of the present 
methods. This means it will copy and paste in one single step. 

Toolbar: 

 Delete 
Use this command to delete the selected standard sample(s) from the 
database. 

Toolbar: 

 Define As Background... 
Use this command to create a copy of the selected standard sample(s) and 
define it as background. A dialog will prompt you to choose one of six 
possible backgrounds. 

 Reset Measurements 
This command resets the measurements of one or more selected standard 
sample(s) . 

 Reset Evaluation 
This command resets the results of one or more selected standard sample(s) 
. (Sample Status will be set from A to M). 

 Import Standard Sample(s)... 
This command imports standard samples from archive files into the selected 
method. A dialog will prompt you to choose one or more archive files (*.smp). 

 Export Standard Sample(s)... 
Use this command to export and backup standard samples of the selected 
method. You will be prompted to choose a directory where the archive files 
(*.smp) will be created. 

 Evaluate... 
Use this command to evaluate the selected standard sample(s). 
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Toolbar: 

 Show Spectra... 
Shows the spectra of one or more selected standard sample(s) via the X-
LabPro Spectra Viewer. 

 Results... 
This command shows the results of a standard sample in the Display Sample 
Results Dialog. 

 Properties... 
This command shows the properties of a standard sample in the Sample 
Properties Dialog. 

See also: 
Method Administration 
Method Administration ( Toolbar ) 

5.11.3 Commands in the View Menu 
 Toolbar 

Use this command to display and hide the Toolbar, which includes buttons for 
some of the most common commands in the Method Administration. A check 
mark appears next to the menu item when the toolbar is displayed. 
See Toolbar for help on using the toolbar. 

 Status Bar 
Use this command to display and hide the Status Bar, which describes the 
action to be executed by the selected menu item or depressed toolbar button, 
and keyboard latch state. A check mark appears next to the menu item when 
the Status Bar is displayed. 
See Status Bar for help on using the status bar. 

 Update (Ctrl + F5) 
Use this command to update the tree control after valid database changes 
have been made from X-LabPro. When using this command the tree will only 
be reloaded from its temporary files. 

 Rebuild 
Use this command to update the tree control after valid database changes 
have been made from X-LabPro. When using this command the tree will 
completely re-calculated from the database. This operation will take a few 
seconds. 

 Update Standards List (F5) 
Use this command to update the standards list after valid database changes 
have been made from X-LabPro. When using this command the standards 
will be reloaded from the database. 

See also: 
Method Administration 
Method Administration ( Tree Control ) 
Method Administration ( Toolbar ) 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 93 of 391 
 
 



                     
 

X-LabPro  5  
 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 94 of 391 
 
 

5.11.4 Commands in the Method Menu 
 New 

Select this menupoint to create a new method. There must be opened already 
a method in the Method Administration, the new method will be copied from 
the present one. Moreover, you can select if you want to copy standards from 
the opened to the new method. 
Note: Background samples and dilution materials will always be copied. 

 Delete 
Use this command to delete the opened method from the database. 

 Import... 
Import a method from an archive file (*.mar). You will be prompted to choose 
the archive file. 

 Export... 
Select this menupoint to export and backup the selected method to an archive 
file (*.mar). A dialog will prompt you to choose a folder where to export.  

 Create Table of Standards... 
Select this menupoint to create a text file containing a table of all standard 
samples and backgrounds of the present method. 

 Adopt Defaults... 
Select this menupoint to open the Adopt Defaults dialog box in order to adjust 
various settings for standard samples that have been imported or inserted into 
the method.  

See also: 
Method Administration 
Method Window 

5.11.5 Commands in the Tools Menu 
 Select X-LabPro Configuration... 

Select this menupoint to define a X-LabPro configuration file (*.xcf) as your 
standard configuration. 

 Library Of Standards... 
Select this menupoint to open the Library Of Standards: Select Standard 
dialog box. Here you may create, edit or delete standard samples. 

See also: 
Method Administration 

5.11.6 Commands in the Window Menu 
This menu is used to switch between and arrange windows. The menu is 
displayed in every open window. The following menupoints are available: 

 Cascade 
Select this menupoint to arrange open windows so that the title bar of each 
window is visible. Only a portion of the other windows is displayed. Scroll 
within the visible portion with the scroll bars. 



                     
 

X-LabPro  5  
 

 Tile 
Select this menupoint to arrange all of the open windows side by side so that 
all of them are visible. Only a portion of the other windows is displayed. Scroll 
within the visible portion with the scroll bars. 

 Arrange Icons 
Select this menupoint to arrange the icons within the application window. 

5.11.7 Commands in the X-LabPro Menu 
The X-LabPro menu contains the following commands to open other applications: 

 Method Administration... 
This command would open the Method Administration but is disabled 
because the Method Administration is already running. 

 Job Manager... 
Use this command to open the Job Manager. You may also click on the  
button on the toolbar. 

 Routine Dialog... 
Use this command to open the Routine Dialog. You may also click on the  
button on the toolbar. 

 Spectra Viewer... 
Use this command to open the Spectra Viewer. You may also click on the   
button on the toolbar. 

 Configuration Editor... 
Use this command to open the Configuration Editor. 

 Evaluation... 
Use this command to open the Evaluation Tool. 

See also: 
Toolbar (Method Administration) 

  

  

5.11.8 Commands in the Help Menu 
 Contents 

Select this menupoint to display a table of contents for the help system for the 
X-LabPro program. In the help system, select the Contents command button 
below the menuline to show the table of contents. 

 Context Sensitive 
Select this menupoint to open the online-help of the Method Administration. 

 Software 
Select this menupoint to display a table of contents for the software 
description. Use of the operation and control software for the X-LAB energy 
dispersive x-ray fluorescence spectrometer is described in this section. 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 95 of 391 
 
 



                     
 

X-LabPro  5  
 

 Shortcuts 
Display the shortcuts. 

 Periodic Table 
Select this menupoint to display the periodic table of elements. 

 About XLMethodAdmin 
Show the version and copyrights of the Method Administration. 

See also: 
Method Administration 
Method Administration ( Toolbar ) 

 

5.12 Other 

5.12.1 Toolbar 

 

The toolbar is displayed across the top of the application window, below the menu 
bar. The toolbar provides quick mouse access to many functions used in the 
Method Administration. 

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). 

Click To 

 
Create a new method. The X-LabPro Method Wizard will be opened to 
assist you. 

 Copy the selected standard(s) to the X-LabPro clipboard. 

 
Paste the standards from the X-LabPro clipboard to the opened method. 

 
Clone the selected standard(s). 

 
Delete the selected standard(s). 

 Evaluate the selected standard(s). 

 
Show the spectra of the selected standard(s). 

 Show the results of the selected standard. 

 Print the selected standard(s). 

 
Show information about the application. 

 
Open the Method Administration.This button is disabled because the 
Method Administration is already running. 

 Open the Job Manager. 

 Open the Routine Dialog. 

 Open the Spectra Viewer. 
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See also: 
Method Administration 

  

  

  

5.12.2 Title Bar 

 

The title bar is located along the top of a window. It contains the name of the 
application and the opened method. 

To move the window, drag the title bar. Note: You can also move dialog boxes by 
dragging their title bars. 

A title bar may contain the following elements: 

 Exit button. 

 Maximize button. 

 Minimize button. 

 Name of the application. 

 Name of the spectra window

 Applications icon. 

  

  

  

  

6 Configuration Editor 

6.1 Using the Configuration Editor 

6.1.1 Menu Commands 
The configuration editor XLCEdi is a module of the X-LabPro software package to 
configure your X-LabPro system.  

Menu overview 

 File Menu 
 Reset Menu 
 View Menu 
 Help Menu 
 System Menu 
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6.1.2 Commands in the File Menu 

 Select X-LabPro Configuration 
Use this command to select the standard configuration, which will be load at 
X-LabPro start. This command will open a standard Windows File Dialog to 
select a configuration file. 

 Open 
Use the open command to load an existing configuration file. This command 
will open a standard Windows File Dialog to select the configuration file. 

 Shortcuts: 

Toolbar:  
Keyboard: CTRL+O

 Save 
Use this command to save the active document to its current name and 
directory. When you save a document for the first time, XLCedi displays the 
Save As dialog box so you can name your document. If you want to change 
the name and directory of an existing document before you save it, choose 
the Save As command. 

Shortcuts 

Toolbar:  
Keys: CTRL+S

 Save as 
Use this command to save and name the active document. XLCedi displays 
the Save As dialog box so you can name your document.  

 To save a document with its existing name and directory, use the Save 
command. 

 Print Configuration 
Use this command to print out all configuration parameters. 

 Exit 
Use this command to end your XLCEdi session. You can also use the Close 
command on the Application Control Menu. XLCEdi prompts you to save 
documents with unsaved changes. 

Shortcuts 

Mouse: Double click the application's Control menu Icon. 

 
Keys: ALT+F4 
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6.1.3 Open Dialog Box 

The following options allow you to specify which file to open: 

Look in Drop-Down List Box 
Select in this drop down list box the drive and the directory in which the 
configuration file is saved. The list will be automatically updated. 

File name Text Box 
Type or select with your mouse the configuration file you want to open. The list 
box shows all files with the extension you select in the Files of Type Drop-Down 
List Box. 

Files of Type Drop-Down List Box 
Select the type of file you want to open: 
XCF : X-LABPro Configuration File 

Open Command Button 
Click the open command button after you have selected a filename and location. 
The box will be automatically closed. Double clicking on a file name in the list has 
got the same effect. 

Cancel Command Button 
Close the dialog box without any activity. 

Command buttons in this dialog box: 

 Change to the higher directory 

 Create a new direktory 

 
The list shows filenames only  

 
The list shows filenames and additional details.

  

SPECTRO Analytical Instruments GmbH 

6.1.4 Save As Dialog Box 
This dialog box allows you to specify the name and location of the configuration 
file you are about to save. 

Save in Drop-Down List Box 
Select in this drop down list box the drive and the directory in which you want to 
store the configuration file. Existing files are be shown. 

File name Text Box 
Type a new filename to save the configuration file with a different name. XLCedi 
adds the extension you specify in the Save as type drop down list box. 

Save Command Button 
Click the save command button after you have select filename and location.This 
dialog box will be automatically closed. If you select an existing file name, a new 
dialog box will ask you to overwride the file. 

Cancel Command Button 
Close the dialog box without any activity. 
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Command buttons in this dialog box: 

 Change to the higher directory. 

 Make a new direktory. 

 The list shows filenames only.  

 The list shows filenames and additional details. 

6.1.5 Commands in the Reset Menu 
 ...to last saved 

Resets the complete configuration to the settings in last saved version. 

6.1.6 Commands in the View Menu 
 Toolbar 

Use this command to display and hide the Toolbar, which includes buttons for 
some of the most common commands in XLCedi, such as File Open. A check 
mark appears next to the menu item when the toolbar is displayed. 

 See Toolbar for help on using the toolbar. 

 Statusbar 
Use this command to display and hide the Status Bar, which describes the 
action to be executed by the selected menu item or depressed toolbar button, 
and keyboard latch state. A check mark appears next to the menu item when 
the Status Bar is displayed. 

 See Status Bar for help on using the status bar. 

 Large Icons 
Use this command to display the icons of the configuration editor in large icon 
style. 
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 Small Icons 
Use this command to display the icons of the configuration editor in small icon 
style. 

 

6.1.7 Commands in the Help Menu 
The help menu contents the following commands which will assist you by using 
this application: 

 Contents 
Select this menupoint to display a table of contents for the help system for the 
X-LABPro program. In the help system, select the Contents command button 
below the menuline to show the table of contents. 

 Context Sensitive 
Select this menupoint to display a context sensitive help text. This menupoint 
corresponds to the command button with a question mark in the toolbar. 

 Software 
Select this menupoint to display a table of contents for the software 
description. Use of the operation and control software for the X-LAB energy 
dispersive x-ray fluorescence spectrometer is described in this section. 

 Shortcuts 
Select this menupoint to display an overview of the keyboard shortcuts. 

 About XLCedi 
Show the version and copyrights of XLCedi. 

6.1.8 Commands in the Control Menu 
 Restore 

Use this command to return the active window to its size and position before 
you chose the Maximize or Minimize command. 
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 Move 
Use this command to display a four-headed arrow so you can move the active 
window or dialog box with the arrow keys. 

 

Note: This command is unavailable if you maximize the window. 

Size 
Use this command to display a four-headed arrow so you can size the active 
window with the arrow keys. 

 

After the pointer changes to the four-headed arrow:  

Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the 
pointer to the border you want to move.  

Press a DIRECTION key to move the border. 

Press ENTER when the window is the size you want. 

Note: This command is unavailable if you maximize the window. 

Shortcut 
Mouse: Drag the size bars at the corners or edges of the window. 

 Minimize 
Use this command to reduce the XLCedi window to an icon. 

Shortcut 
Mouse: Click the minimize icon  on the title bar. 

 Maximize 
Use this command to enlarge the active window to fill the available space. 

Shortcut 
Mouse: Click the maximize icon  on the title bar; or double-click the title bar. 

 Close 
Use this command to close the active window or dialog box. 

 Clicking the Close icon  and double-clicking the Control menu icon is the 
same as choosing the Close command. 

 Note: If you have multiple windows open for a single document, the Close 
command on the document Control menu closes only one window at a time. 
You can close all windows at once with the Close command on the File menu. 

 Shortcuts 
Keys: CTRL+F4 closes a document window 
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6.2 Other  

6.2.1 Toolbar 

 

The toolbar is displayed across the top of the application window, below the menu 
bar. The toolbar provides quick mouse access to many functions used in XLCedi. 

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). 

Click To 

 
Open an existing configuration file. XLCEdi displays the Open dialog box, 
in which you can locate and open the desired file. 

 
Save the active document or template with its current name. If you have 
not named the document, XLCEdi displays the Save As dialog box. 

 Print the actually configuration. 

 
Switch the representation to large icon style. 

 
Switch the representation to small icon style. 

 
Display the online help. 

  

  

  

  

6.2.2 Title Bar 

 

The title bar is located along the top of a window. It contains the name of the 
application and document. 

To move the window, drag the title bar. Note: You can also move dialog boxes by 
dragging their title bars. 

A title bar may contain the following elements: 

 Exit button 

 Maximize button 

 Minimize button 

 Name of the document 

 
Applications icon. This icon shows your type of instrument or the 
selected dialog. 
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6.2.3 Status Bar 

 

The status bar is displayed at the bottom of the XLCedi window. To display or hide 
the status bar, use the Status Bar command in the View menu. 

The left area of the status bar describes actions of menu items as you use the 
arrow keys to navigate through menus. This area similarly shows messages that 
describe the actions of toolbar buttons as you depress them, before releasing 
them. If after viewing the description of the toolbar button command you wish not 
to execute the command, then release the mouse button while the pointer is off 
the toolbar button. Moreover, during opening and closing a document, a progress 
bar will show you the current status. 

The right areas of the status bar indicate which of the following keys are latched 
down: 

Indicator Description 

CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down. 
SCRL The Scroll Lock key is latched down.
  

6.2.4 Scroll bars 
Displayed at the right and bottom edges of the document window. The scroll boxes 
inside the scroll bars indicate your vertical and horizontal location in the document. 
You can use the mouse to scroll to other parts of the document. 

 

6.3 The Configuration Editor Dialog Boxes 

6.3.1 Global Settings and Instrument Data Dialog Box 
This dialog box is used to edit the customer- and instrument data. This dialog box 
is opened with the Global Settings icon. The dialog box contains the following 
elements: 

Global Settings Group Box  
Customer Name Display Field 
The name of the customer (your company name) is shown in this diplay field.  

Instrument Number Display Field  
The instrument number is shown in this diplay field.  

SPECTRO Job Number Text Box 
Enter the SPECTRO Job Number for the respective instrument or update in text 
box 
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Generator Serial Number Text Box 
Enter the generator serial number in this text box. 

Generator Serial Number Text Box 
Enter the X-Ray tube serial number in this text box. 

Profile Drop Down List Box and Edit Command Button Combination 
Select the profile for your type of computer in this drop down list box. Click the Edit 
Command Button to change the timing values for your selection. In the opened 
Dialog Box you can change the values for following parameters  

Spectrum Read Interval 

Generator Read Interval 

Vacuum Read Interval 

Intrument Type Group Box  
Intrument Type Option Buttons 
Select the option button witch corresponds to your intrument type (XEPOS or 
SPECTRO iQ) in this selection field.  

Optional Equipment Group Box (Service Mode only) 
Powervar UPS 
Select this check box if your intrument is equipped with an uninterruptible power 
supply. 

Hauppauge WinTV Video System Check Box 
Select this check box if your intrument is equipped with a Hauppauge WinTV 
Video System. 

Matrox Cronos Video System Check Box 
Select this check box if your intrument is equipped with a Matrox Cronos Video 
System. 

Spectro 4.4 Data Transmission Check Box 
Select this check box if you want to use the Spectro 4.4 format for the data 
transmission. 

OK Command Button 
Click on this command button to close the dialog box and store your changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

6.3.2 Targets/Filter Dialog Box 
This dialog box is used to view and edit the configuration for the target drum. This 
dialog box is opened with the Targets/Filter icon. The dialog box contains the 
following elements: 

Basic Settings Group Box 

Number of Positions Drop-Down List Box 
Select the number of target positions on the target drum in this drop down list box. 
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Valid entries are 4, 5, 6, and 8. If a number smaller than 8 is selected, the table in 
the Target/Filter Parameters group box is adjusted accordingly.  

Changer installed Check Box 
Mark this check box if your intrument is equipped with a target changer. This 
control is only enabled in service mode. 

Always Initialize Changer Check Box 
If this check box is marked, the target changer motor will be initialized before any 
target movement. 

Offset Text Box 
In this text box you can enter the offset steps that the target changer motor moves 
the target changer after initialisition. The unit is steps. 

Target Parameters Group Box 

Target Configuration Table 
The configuration of the individual target positions are displayed in this table. 
Double click on a target position to open the Target Position Parameters dialog 
box to view a detailed description of the target position. Double clicking 
corresponds to the function of the Display command button. 

Display Command Button 
Select this command button to open the Target Position Parameters dialog box in 
order to view a detailed description of the currently selected target position. 

Edit Command Button 
Select this command button to open the Target Position Parameters dialog box in 
order to change the detailed data for the currently selected target position. 

Delete Command Button 
Select this command button to delete the data for the currently selected target 
position. This corresponds to an empty position on the target drum. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

Target Position Parameters Dialog Box 
This dialog box is used to view and/or edit the detailed data for a target position. 
The dialog box contains the following elements: 

Basic Settings Group Box 

Type Drop Down List Box 
Select the target type in this drop-down list box. Valid entries are: Empty, 
Secondary target (K), Secondary target (L), Compton/Secondary, Compton 
scatter, Barkla scatter and Bragg Crystal. One of the two dialog elements for a 
more detailed description of the target (explained below) is displayed, depending 
on the values selected in this drop down list box. 
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Name Drop Down List Box 
This drop down list box is displayed when the selected target type is: Barkla 
scatter or Bragg Crystal. Select the name of the target in this drop down list box. 
Valid entries for Barkla scatter are: Boron carbide, Aluminum oxide, Beryllium, 
Beryllium oxide, Carbon and HOPG. The valid entry for Crystal is: HOPG. 

Combination: Name Text Box, PTE Command Button and Display Field 
This combination of dialog elements is displayed when the selected target type is: 
Compton scatter or Secondary target. The element for the target material can be 
chosen with this combination of dialog elements. Use either the text box to enter 
the atomic number or the PTE command button to select an element using the 
periodic table of elements. The Select Element dialog box is opened when the 
PTE command button is chosen. The name of the selected element is displayed in 
the display field. 

Intensity Correction Factor Text Box 
Enter the intensity correction factor in this text box. This factor can be used to 
make adjustments after replacing the excitation unit, for example. The factor is 
determined during the calibration of your instrument. Valid entries lie in the range 
between 0 and 2. 

Primary/Secondary Diaphragm Group Boxes  
These group boxes describe the primary diaphragm and the secondary 
diaphragm. Both group boxes have corresponding dialog elements. These are: 

Material Text Box 
Enter a description of the respective diaphragms material in this text box. The 
description can be a maximum of 20 characters long. 

Inner Diameter Text Box 
Enter the inner diameter of the respective diaphragm in this text box. Valid entries 
for the primary diaphragm lie in the range between 0 and 14 mm; in the range 
between 0 and 12 mm for the secondary diaphragm. 

Length Text Box 
Enter the length for the respective diaphragm in this text box. Valid entries for the 
primary diaphragm lie in the range between 0 and 10 mm; in the range between 0 
and 6 mm for the secondary diaphragm. 

Radiation Filter Group Boxes 
These group boxes describe the filters for the target positions (Primary filter, 
Primary filter 2, Secondary filter 1 and Secondary filter 2). The group boxes have 
corresponding dialog elements. These are: 

Combination: Name Text Box, PTE Command Button and Display Field 
The element for the respective filter can be set with these dialog elements. Use 
either the text box to enter the atomic number or the PTE command button to 
select an element using the periodic table of elements. The Select Element dialog 
box is opened with the PTE command button. The name of the selected element is 
displayed in the display field. 

Density Text Box  
Enter the density of the filter material in this text box. Valid entries lie in the range 
between 0 and 25 g/cm³. 



                     
 

X-LabPro  5  
 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 108 of 391 
 
 

Thickness Text Box  
Enter the thickness of the filter material in this text box. Valid entries lie in the 
range between 0 and 1000 µm. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

6.3.3 X-Ray Tube Dialog Box 
This dialog box is used to view and/or edit various settings for the X-Ray tube. 
This dialog box is opened by clicking the X-Ray Tube icon.  

General Information Group Box 

Type Drop Down List Box 
Select the type of tube used in this drop-down list box. Possible entries depent on 
your instrument. Entries will be automatically placed in the Max. Power text box 
and in the Characteristic Lines list box when a new type is selected in this drop 
down list box.  

Anode Text Box 
This edit control contains the atomic number of the anode material. It is possible to 
enter the atomic number in the edit control or to choose an atomic number from 
the Periodic Table of Elements by clicking the PTE Button. 

Characteristic Lines Group Box 

Grid Control for Current and Voltage for the Tube Characteristic Lines  
Up to 10 pairs of current and voltage pairs, whose fit points are not components of 
the portion of the tube tube characteristic lines limited by the maximum power, are 
shown in this list box. These values are used together with the value for the x-ray 
tube's maximum power to check the user settings for current and voltage and to 
adjust them if necessary. It is possible to edit the values directly in the grid control. 

Options Group Box 

Generator installed Ckeck Box 
Mark this check box if your instrument is equiped with a generator. 

Preset Standby Mode Ckeck Box 
If this check box is activated, the generator will automatically change its mode to 
standby mode after finishing a measurement. 

Options Generator 
Max. Power Text Box 
Enter the maximum tube power in this text box. Valid entries lie in the range 
between 100 and 3000 W. This value is used together with the values for the tube 
characteristic lines to check the user settings for current and voltage and to adjust 
them if necessary. There are no possible settings that do not lie within the limits 
described in this dialog box. 
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Maximum Voltage (kV) Text Box 
Enter the maximum value for the tube voltage in this text box. Valid entries lie in 
the range between 1 and 100 kV. 

Maximum Current (mA) Text Box 
Enter the maximum value for the tube current in this text box. 

Delta Voltage (kV) Text Box 
Enter the size of the steps with which the tube voltage should be reduced before 
turning off the x-ray tube. Small steps slow the reduction process; steps that are 
too large may lead to an error during monitoring of the relative voltage for the x-ray 
generator along with premature turning off of the x-ray tube. Valid entries lie in the 
range between 1 and 10 kV. 

Delta Current (mA) Text Box 
Enter the size of the steps with which the tube current should be reduced before 
turning off the x-ray tube. See above for further information. Valid entries lie in the 
range between 1 and 10 mA. 

Shutter Group Box 

Motor Steps Text Box 
Enter the number of steps for the shutter in this text box. Valid entries lie in the 
range between 1 and 5000 Steps.  

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

6.3.4 Instrument Control Dialog Box 
This dialog box is used to view and edit various instrument control settings. This 
dialog box is opened with the Instrument Control icon.  

 

Standby Tab Control 
Standby Voltage (kV) Text Box 
This text box contains the generator voltage in standby mode. The unit is kV. Valid 
ranges depent on the selected tube and the maximum tube power. 

Standby Current (mA) Text Box 
This text box contains the generator current in standby mode. The unit is mA. 
Valid ranges depent on the selected tube and the maximum tube power. 

Standby Target Drop Down List Box 
In this drop down list box you can choose the target selected in standby mode. 

Enable Vacuum Pump ... Check Box 
If this checkbox is activated, the vacuum pump will be switched on when entering 
standby mode after a cuvette measurmenent. The pump time cannot be entered 
and is set to 5 seconds. 
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Vacuum Tab Control 
Ventilation Time (s) Text Box 
Enter the ventilation time in this text box. This is the time that is needed to 
ventilate the evacuated sample chamber. Valid entries lie in the range between 10 
and 100 s. The sample chamber may not be completely ventilated if the value here 
is too small. It may, then, not be possible to open the cover for the sample 
chamber. 

Vacuum Pump Time (s) Text Box 
Enter the vacuum pump time in this text box. This is the time that is needed to 
produce a vacuum in the sample chamber. Valid entries lie in the range between 
10 and 200 s. The sample chamber may not be completely evacuated before a 
measurement is started if the value here is too small; this leads to erroneous 
measurement values. 

Postpump Time (s) Text Box 
Enter the time for pumping after reaching the vacuum in this text box. This time is 
needed to ensure the vacuum during the whole measurement.  

Vacuum Pump Installed Check Box 
Mark this checkbox if your intrument is equipped with a vacuum pump. 

Vacuum Measurement Installed Check Box 
Mark this checkbox if your intrument is equipped with the optional vacuum 
measurement. 

Measurement Tab Control 
Optimum Dead Time (%) Text Box 
Enter the optimum dead time in this text box. The calculation of the new tube 
current is based on this time during current regulation. If the optimum dead time 
cannot be achieved, despite current regulation, it is because the newly calculated 
current lies outside of the tube characteristic line and, thus, cannot be set. Check 
the excitation conditions for the measurement if this occurs. 

Check Tube Cooling Check Box 
If this check box is marked, the revolutions of the fan motor will be controlled. This 
check box is only activated for the XEPOS. 

Low Energy Cutoff [eV] Text Box 
Enter the low energy level (in eV) in this text box. From this level onwards events 
are shown in the spectral representation. This textbox is only enabled if your 
instrument is epuiped with a DXP. 

Hide Secure Message Boxes 
If this check box is marked, the secure message boxes are will be hidden. 

Gas Flush Tab Control 
Prepump Time (s) Textbox 
Enter the prepump time in this textbox. For this time, the air in the sample room 
will be pumped out by the vacuum pump before the gas flush will be activated. 
Valid entries lie in the range between 0 and 300 s. This textbox is enabled if the 
Gas Flush with Vacuum option button is marked. 
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Waiting Time (s) Textbox 
Enter the waiting time before the measurement in this text box. Valid entries lie in 
the range between 0 and 300 s. This textbox is enabled if the Gas Flush with 
Vacuum or Gas Flush without Vacuum option button is marked. 

Minimum Gas Flow (l/h) Textbox 
Enter the minimum gas flow in this textbox. Valid entries lie in the range between 0 
and 1000 l/h. This textbox is enabled if the Gas Flush without Vacuum option 
button is marked. 

No Gas Flush / Gas Flush with Vacuum / Gas Flush without Vacuum Option 
buttons 
With this option buttons you are able to change between several gas flushes or no 
gas flush, depended on which given flushes are installed in your instrument. 

Switch off gas flush Check Box 
Mark this check box to switch off the gas flush during the measurement. if this 
check box is marked, you have to enter the gas flush times for the first and for the 
repeated measurements.  

Permanent pumping Check Box 
If this check box is marked the vacuum pump will be pumping permanent. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

6.3.5 Sample Plate Dialog Box 
This dialog box is used to view and/or edit various settings for the sample plate. 
This dialog box is opened with the Sample Plate icon. The dialog box contains the 
following elements: 

Allowed Sample Plate Sizes Group Box 

List box with sample plate sizes and offsets 
The possible sample plate size and the sample plate offsets for their 
configurations are displayed in this list box. 

Insert Command Button  
Click on this command button to open the sample plate parameters dialog box. An 
additional sample plate size can be inserted into the list with this dialog box. 

Edit Command Button 
Click on this command button to open the sample plate parameters dialog box. 
The currently selected entry in the list box can be edited with this dialog box. 

Delete Command Button 
Click on this command button to delete the sample plate size currently selected in 
the list box. 
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Sample Changer installed Check Box 
Mark this check box if your instrument is equipped with an optionally available 
sample changer. 

Use Correction Values Check Box 
Mark this check box to enable the usage of correction values for sample plates. In 
the dialog box Enter the Sample Plate Parameters an additional command button 
will be visible. Click this command button to edit the correction values. 

Options Group Box 

Stand-By Sample Plate installed 
Mark this check box if your instrument is equiped with a standby plate. 

Sample Rotation Installed Check Box  
Mark this check box to make sample rotation available for use. 

Target by Target Option Button  
In this measuring mode, the samples on the sample plate are measured according 
to the target. First the first measurements, then the second measurements, etc. 
are conducted. The first results are obtained after the complete measurement of 
the first sample in this measuring mode. This measuring mode enables the use of 
methods with different settings for the options for vacuum and gas flush for the 
individual measurements. 

Sample by Sample Option Button  
In this measuring mode, the samples on the sample plate are measured according 
to sample. Each sample is completely measured and then directly evaluated. The 
first results are obtained quicker than with the target by target mode. Only 
methods for which all of the settings for the vacuum and gas flush options are the 
same should be used together on one plate in this mode.  

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

 

Enter the Sample Plate Parameters Dialog Box  
This dialogbox is used to enter or change additional settings for the sample 
plate.The dialog box contains following elements:  

Sample Plate Parameters Group Box 

Number of positions on the sample plate Text Box  
Enter the number of sample position for a sample plate in this text box. Valid 
entries lie in the range between 0 and 40. Standard sample plates delivered with 
the instrument have 8, 12, 14, 18, 20 or 36 sample positionen.  

Number of offset steps after initialization Text Box  
Enter the number of steps that should be additionally driven to in order to correct 
the position after an initialization in this text box. Valid entries lie in the range 
between -20 und +20. 
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Additional Settings for Special Plate Group Box  
This dialog elements will only be shown, if you mark the checkbox Extented 
Sample Plate in the Sample Plate Parameters Group Box. 

Number of positions (32 mm)Text Box 
Enter the number of 32mm positions on the sample plate in this text box. 

Number of positions (40 mm)Text Box 
Enter the number of 40mm positions on the sample plate in this text box. 

OK Command Button  
Click on this command button to close the dialog box and store any changes.  

Cancel Command Button  
Click on this command button to close the dialog box. Changes to the settings are 
not stored.  

Correction... Command Button... 
This command button is only visible if the check box Use Correction Values in the 
dialog box Sample Plate is marked. Click this command button to open the 
position correction dialog box. In the dialog box you can edit the correction values.  

6.3.6 Detector Dialog Box 
This dialog box is used to view and edit various settings for the detector. This 
dialog box is opened with the Detector icon. The dialog box contains the following 
elements: 

Basic Settings Group Box 

Type of Detector Drop-Down List Box  
Select the type of the detector in this drop down list box. Possible entries depend 
on your instrument. 

Type of Entrance Window Drop-Down List Box  
Select the type of entrance window in this drop-down list box. Valid entries are: 
Beryllium, Boron, Diamond, Glass, Mox Tex and Siliconnitride. 

Colimator 
Select the type of colimator, your detector is equipt with. 

Beryllium Equivalent Thickness Text Box 
Enter a value in this text box which gives the thickness of an equivalent beryllium 
window in regards to absorption behavior. Valid entries lie in the range between 0 
and 100 µm. 

Thickness Gold Contact Layer Text Box 
Enter a value for the thickness of the gold contact layer in this text box. Valid 
entries lie in the range between 0 and 50 nm. 

Thickness Silicon Dead Layer Text Box 
Enter a value for the thickness of the silicon dead layer in this text box. Valid 
entries lie in the range between 0 and 0.5 µm. 



                     
 

X-LabPro  5  
 

Thickness Active Layer Text Box 
Enter a value for the thickness of the active layer in this text box. Valid entries lie 
in the range between 0 and 5 mm. 

Additional Parameters for Sirius Detectors 

This dialog elements will only be visible if the Sirius detector is selected. 

Regenerations Time[s] Text Box 
The Sirius 10 detector needs a regeneration time after the measurement. During 
this time the detector is switched of. Enter the timespan for the regeneration time 
in this text box. The typical value is 60 s. 

Stabilization Time[s] Text Box  
After the regeneration is finished, the Sirius detector needs a stabilization time to 
be able to show exact measurement results. Enter the timespan for the 
stabilization time in this text box. The typical value is 180 s. 

Stabilization before Measurement Check Box 
The stabilization of the Sirius 10 can be done after the measurement of a sample 
plate is finished or during the initialization of the next measurement.  

Stabilization after the measurement: 

 

Stabilization before the measurement 

 

Activate the checkbox if you want the stabilization be started before the 
measurement. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

SPECTRO Analytical Instruments GmbH 

6.3.7 Filenames Dialog Box 
This dialog box is used to view and enter the settings for file names for the data 
tables used by the program. This dialog box is opened with the Filenames icon. 
The dialogbox contains following elements: 

Settings Group Box 

Use Programm Directory Check Box 
Mark this check box, if the data tables will be stored in the program directory of the 
X-LABPro software.  

Directory Text Box with Command Button  
Click this command button to open the Select Directory dialog box. In this dialog 
box you can select the directory in which the data tables will be stored. Only 
existing directorys will be shown. Please use the windows explorer to create a new 
subdirectory. The text field displays the selected directory. The program directory 
from the X-LABPro software is the default directory. 
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This dialog elements will only be visible, if the Use Programm Directory check box 
is not marked. 

Database Group Box 

Use DSN Name Radio Button / Drop Down List Box 
Select this option if you want to use a SQL Database with X-LabPro software. In 
the Microsoft Windows settings you can define one or more DSN Names for SQL 
Databases. Select in the drop down list box the data source you want to use. 

Use X-LabPro File Structure Radio Button 
Select this option if you want to use the file structure as database for your X-
LabPro software. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

 

 

6.3.8 Interface Dialog Box 
This dialog box is used to view and edit the preset interfaces between the 
spectrometer and the personal computer. The parameters for the following 
interfaces can be set here:  

Serial interface for instrument components and generator 

Serial interface for detection electronics 

The dialog box is opened with the Interfaces icon and contains the following 
elements:  

Serial Interface Drop Down List Box 
Select the serial interface to be used to control the X-Ray generator 
communication or the detection elektronics communication in this drop down list 
box. 

Baudrate Drop Down List Box 
In this drop down list box you can choose the baud rate for the serial 
communication. Typical value is 38400 for all intruments. 

Serial Interface Parameters Text Box 
This text box shows you the parameters for the serial interface. These parameters 
are baud rate, parity, data bits, stop bits and Xon/Xoff 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 
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6.3.9 Artefacts Dialog Box 
In this dialog box parameters depending on your instument will be shown. These 
parameters can only be modified in service mode. 

6.3.10 Geometry and Protection Foil Dialog Box 
This dialog box is used to display the geometry data and to edit the parameters for 
the detector protection foil and the target protection foil. 
This dialog box is opened with the Geometry icon. The dialog box contains the 
following elements:  

Geometry Tab Control 
Distance Sample ⇔ Detector [mm] Text Box 
This text box displays the distance between sample and detector. This value can 
only be changed in service mode. 

Distance Target ⇔ Sample [mm] Text Box 
This text box displays the distance between target and sample. This value can 
only be changed in service mode.meth 

Detector Protection Foil Tab Control 
Foil Drop Down List Box  
Select the used detector protection foil in this drop down list box. 

Target Protection Foil Tab Control 
Foil Drop Down List Box  
Select the used target protection foil in this drop down list box . 

Angles Tab Control 
In this Dialog parameters depending on the used device type can be entered. 
These parameters should not be modified. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

6.3.11 User Dialog 

6.3.12 Routine Dialog Settings Dialog Box 
This dialog contains the settings for the Routine Dialog. This dialog is opens by 
clicking on the Routine Dialog icon.  

Presets Tab Control 
Method Class Drop Down List Box 
Use this drop down list box to select the method class that is used when opening a 
new sample plate in the Routine Dialog. 
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Sample Plate Drop Down List Box 
Use this drop down list box to select the type of sample plate that is used when 
opening a new sample plate in the Routine Dialog. 

Locked Positions Drop Down List Box 
Use this drop down list box to select the sample plate positions that will be locked 
when opening a new sample plate in the Routine Dialog. The lists of locked 
positions can be configured in the Locked Positions tab control. 

Default Job Number radio buttons 
With these radio buttons you can you can decide how the job name will be created 
automatically. You can choose between collective job as automatically used, a 
daily generated job (e.g. 2001_06_05), a weekly generated job (e.g. 2001_23) or a 
monthly generated job (e.g. 2001_06). 

Open Last Sample Plate Automatically Check Box 
Mark this check box if you want the Routine Dialog automatically load the last 
document after starting and save the current used document at closing. 

Method Classes Tab Control 
Insert Command Button 
Click this command button to generate a new method class. You will be prompted 
by the Insert Method Class dialog box to enter the name of the new method class. 
After enetring the name the new method class will be added to the list. 

Delete Command Button  
After prompting the selected method class will be deleted. 

Method Assignment Tab Control 
The dialog items on this tab control can be used to assign the different methods to 
the method classes. 

Available Methods List Box 
This list box contains all methods of your X-LabPro system. 

Selected Methods List Box 
After selecting a method class by using the drop down list box at the top, the 
methods assigned to this class will be shown in the list box below. 

Insert Command Button 
The selected method in the left list (Available Methods) will be added to the 
selected method class on the right side. 

Delete Command Button 
After prompting a selected method in the method class (right list) will be deleted 
from the list. 

Columns Tab Control 
The columns of the Routine Dialog sample table representation can be configured 
by using the list on this tab control. The order of the columns can be defined and 
the different columns can be defined as visible or hidden. 
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Up Command Button 
Moves the selected column in the list to the previous position. Use the Up/Down 
command buttons to define the order of the columns 

Down Command Button 
Moves the selected column in the list to the next position. Use the Up/Down 
command buttons to define the order of the columns. 

Double Click on the Column List 
By double clicking a list item the item toggles from visible to hidden. 

Locked Positions Tab Control 
Insert Command Button 
Generates a new list of locked positions and opens the Locked Positions dialog 
box. 

Edit Command Button 
Opens the Locked Positions dialog box to edit the selected list of locked positions. 

Delete Command Button 
After prompting the selected list of locked positions will be deleted from the list. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

6.3.13 Locked Positions Dialog Box 
This dialog is used to define the locked positions of the sample plate. After 
selecting the locked positions and confirming by clicking OK, the locked positions 
will be included in the list. This dialog is opened by clicking the buttons Edit or 
Insert from the group Lists of locked positions or by double-click on the locked 
positions table. 

Sample plate Group Box 
By clicking the positions in the sample plate of the dialog box, the position status 
toggles between locked/unlocked. Locked positions are displayed in dark gray and 
the word Lock will be shown in this position. Every sample plate position will be 
toggled (lock/unlock) by clicking into it. 

Sample size Drop Down List Box 
In this drop down list box, you can select the Sample Plate Size for which the 
settings are valid. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 
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6.3.14 Spectral Representation Settings Dialog Box 
This dialog box is used to select the colors for the Spectra Viewer and the printer 
output of the spectra as well as setting the parameters for the spectral 
representation in the Routine Dialog. You can set the colors for the monitor and 
the printer independently from one another. This dialog box is opened with double 
click on the Spectra icon. 

Colors for the Representation Group Box 

Screen / Printer Register 
In this tab you can select for which output device the various settings will be 
shown. You can choose between screen and printer. 

Box with Sample Diagram  
This box shows how the spectral representation will appear by making usage of 
the current settings. The example will automatically be updated by changing the 
settings. 

Drop Down List Box 
Select a component of the example in order to change the color with this drop 
down list box. 

Red Scroll Bar and Text Box 
Set the value of the color red with these dialog elements.  

Blue Scroll Bar and Text Box 
Set the value of the color blue with these dialog elements.  

Green Scroll Bar and Text Box 
Set the value of the color green with these dialog elements.  

Windows Colors 
Click on this command button if you want to use windows colors for the spectra 
representation. 

Fill Spectra Check Box  
Mark this check box in order to fill the areas of the spectra underneath the spectral 
lines. It is recommended to disable this check box for printer output. 

Box with Sample Color  
The appearance of the currently selected color is shown in this box. 

Measurement Window Group Box  
The settings made in this box affect the spectral representation during a 
measurement in the Routine Dialog. 

Grid Check Box 
Mark this check box if a grid should be displayed. 

R.O.I. Check Box 
Mark this check box if the Regions Of Interest should be displayed. 

Line Markers Check Box 
Mark this check box if the line markers should be displayed. Select the line 
markers after activating the Select Line Markers command button. 
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Select Line Markers Command Button 
Click on this command button to open the Select Element dialog box. You can 
select the elements for which the line markers will be displayed using the periodic 
table of elements in this dialog box. 

Automatic Range Switch Check Box 
Mark this check box if you want the range automatically switched to smaller 
number of channels. Enter the thresholds for the automatic range switch in the ½ 
Spectrum and ¼ Spectrum edit controls. 

½ Spectrum Text Box 
Enter the threshold for the automatic switch to half-spectrum-range in this text box. 

¼ Spectrum Text Box 
Enter the threshold for the automatic switch to quarter-spectrum-range in this text 
box. 

First Channel Text Box 
Enter the first displayed channel of the spectral representation in this test box. 
Valid entries lie in the range between 1 and 4031. The sum of this number and of 
the selected number of channels must be less than or equal to 4097.  

No. of Channels Drop-Down List Box 
Select the number of channels in this drop-down list box. The entries are: 64, 128, 
256, 512, 1024, 2048 and 4096. See First Channel text box for further restrictions. 

Line Cursor Text Box 
Enter the position of the line curser in this text box. The entry here must lie in the 
range between the first channel and the last channel (first channal + number of 
channels -1). 

X-Axis Drop-Down List Box 
Select the format of the X-Axis of the spectral representation in this drop-down list 
box.Valid entries are: Channel Representation and Energy Representation. 

Y-Axis Drop-Down List Box 
Select the format of the Y-axis of the spectral representation in this drop-down list 
box. Valid entries are: Logarithmic Representation, Linear Representation and 
Square Root Representation. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 
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6.3.15 Select Elements Dialog Box 

This dialog box is used to select several elements or the respective line markers. 
Click on the box for an element in order to select it. The different colors have the 
following meanings:  

 
This element can be analyzed with the spectrometer. The 
element is not selected. Click on the element to select it. 

 
This element can be analyzed with the spectrometer. The 
element is selected. Click on the element to remove the 
selection. 

 
This element cannot be analyzed with the spectrometer. The 
element is not selected. Click on the element to select it. 

 
This element cannot be analyzed with the spectrometer. The 
element is selected. Click on the element to remove the 
selection. 

 
This element cannot be analyzed with the spectrometer. The 
element cannot be selected at this time. 

 
This element can be analyzed with the spectrometer. 
However, the element cannot be selected at this time. 

There is a blue triangle in the lower right corner of each box. Click on this triangle 
and hold the mouse key pressed; detailed information about the selected element 
is displayed in a dialog box.  

Multiple elements can be selected in this dialog box. The current selections remain 
until the selection is removed from them by clicking on them. 

In addition to the periodic table this dialog box contains the following elements: 

OK Command Button  
Click on this command button to close the dialog box and accept the current 
selection. 

Cancel Command Button  
Click on this button to close the dialog box and cancel the procedure for selecting 
multiple elements. 

Suggest Command Button 
This command button is only displayed when the dialog box is opened from the 
dialogs for configuration of the printout. For print functions, all of the elements 
between atomic number 1 and 92 can be selected. Click on this command button 
to select the elements that have actually been calibrated in the respective method.  

K-Shell Check Box 
Mark this check box if the line markers for the K-shell for the last selected element 
are to be displayed. The atomic number for the last selected element is displayed 
in the Element text box.  

L-Shell Check Box 
Mark this check box if the line markers for the L-shell for the last selected element 
are to be displayed. The atomic number for the last selected element is displayed 
in the Element text box. 

SPECTRO Analytical Instruments GmbH 

M-Shell Check Box 
Mark this check box if the line markers for the M-shell for the last selected element 
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are to be displayed. The atomic number for the last selected element is displayed 
in the Element text box. 

Element Text Box  
Enter the atomic number for the element to be selected in this text box. Then click 
on the Add or Remove command button to select or remove the selection from an 
element. 

Add Command Button  
Click on this command button to add the element in the Element text box to the 
selection. 

Remove Command Button  
Click on this command button to remove the element in the Element text box from 
the selection. 

Select All Command Button  
Click on this command button to select all of the elements in the dialog box that 
can be selected. 

Delete All Command Button  
Click on this command to remove all of the elements from the selection. 

Help Command Button  
Click on this command button to display this help text. 

See also: 

Spectral Representation Settings Dialog Box 
Edit Deconvolution Method Dialog Box 
Special Options for Standard Printing Dialog Box 
Special Options for Multi List Dialog Box 
Special Options for Special (Roche) DialogBox 
Tools 

6.3.16 Sample Settings Dialog Box 
This dialog box is used to view and edit various settings for the samples. This 
dialog box is opened with the Samples icon. The dialog box contains the following 
elements:  

Allowed Sample States Group Box 

State and Sample Table 
The possible sample states including its assignment to a sample type, diameter, 
dilution material and the dilution factor is displayed in table. 

Insert Command Button  
Click on this command button to open the Sample State dialog box in order to 
insert a new sample state into this list box. 

Edit Command Button  
Click on this command button to open the Sample State dialog box in order to 
change the sample state currently selected in this list box. 
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Delete Command Button  
Click on this command button to delete the sample state currently selected in the 
list box. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

6.3.17 Sample State Dialog Box  
This dialog box is used to enter and edit a sample state and the assignment of a 
state to a sample type. This dialog box is opened with the Insert or Edit command 
button.  

Sample State Name  
Enter a name of the sample state in this text box. 

Sample Type Drop-Down List Box 
Select one of the sample type entries in order to assign your sample state to a 
sample type. Valid sample types are: Pressed Tablet, Melt Tablet, Liquid, Layer, 
Glass, Alloys, Other, Powder and Layer Thickness. 

Sample Diameter Edit Field 
Enter the sample diameter in mm in this edit field. 

Dilution Material Drop-Down List Box 
This list box contains all dilution materials from the library of standards. Select a 
deilution material or "-" for no dilution material here. 

Sample Mass Text Box  
The sample mass (in g) can be changed in this text box. 

Dilution Mass Text Box  
The dilution mass (in g) can be changed in this text box. 

Sum/Factor Text Box  
The sum of the sample mass and the dilution factor can be changed in these text 
boxes. 

Edit sample mass and dilution mass Option Button  
Select this option button in order to enter the sample and dilution masses. The 
total mass and dilution factor will automatically be calculated. 

Edit sum of mass and dilution factor Option Button  
Select this option button in order to enter the total mass and dilution factor. The 
sample and dilution masses will automatically be calculated. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 
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6.3.18 Global Corrections Dialog Box 
This dialog box is used to view and edit the standardization factors determined 
during the global standardization. The calculation of the standardization factors is 
normally performed automatically when a global standardization is conducted.  

Target Drop-Down List Box 
Select the target from which the intensity values will be displayed in the Intensities 
table. 

Intensities Group Box 
The correction values for all elements in combination with the selected target is 
shown in this table. This values can be edited in the edit fields in the ”correction” 
column of the table. 

In the both upper lines the correction factor for the coherent and the incoherent 
back scatter intensities from the selected target position can be entered. 

In the columns N, Symbol and Element the atomic numbers, atomic symbols and 
the name of the element are displayed.  

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

Reset Command Button 
Click on this command button to set the correction values for the selected target to 
the value "1".  

6.3.19 MCA Recalibration Dialog Box 
This dialog box is used to view and edit the settings for the detection electronics.  

Selection Group Box 

Peak Time and Gain Table 
The possible combinations of peak time and gain are shown in this table. The 
values are pre-setted and depend on the used instrument and detector.  

Settings Group Box 

Use Settings Check Box 
This check box will only be available in service mode.  

Max. Energy Difference Edit Control 
The value in this edit control depends on the used instrument and will only be 
available in service mode.  

Resolution Limit Text Box 
The value in this edit control depends on the used instrument and will only be 
available in service mode.  
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Zero Peak Energy Text Box 
The value in this edit control depends on the used instrument and will only be 
available in service mode.  

Optimal Target Group Box 

Secondary/Compton and Barkla/Crystall Option Buttons 
Select with this option buttons the best target for the selected combination of peak 
time and gain . 

Name Drop-Down Listbox  
This drop-down listbox will be shown, if you select Barkla/Crystal as optimal target. 
Choose a target name in this drop-down list box. 

Combinations: Element Text Box, PSE Command Button and Display Field 
This combination of dialog elements will be shown, if you selected Barkla/Cristal 
as optimal target. The element for the target material can be chosen with this 
combination of dialog elements. Use either the text box to enter the atomic number 
or the PTE command button to select an element using the periodic table of 
elements. The Select Element dialog box is opened when the PTE command 
button is chosen. The name of the selected element is displayed in the display 
field. 

Global Group Box 

Dead Time Correction Text Box 
This text box will be only available in service mode. 
Processing an impulse in an energy dispersive spectrometer requires a certain 
amount of time. During processing of the impulse, the measuring channel is 
blocked for additional impulses; this results in a dead time.  
The impulse processing capacity, limited by this, results in dead time effects that 
must be taken into consideration during spectral evaluation. 
In the SPECTRO X-LAB, the dead time is determined using the zero peak. The 
zero peak is generated by opening a gate for noise impulses at the entrance to the 
ADC. To do this, the amplifier input is scanned with a set clock frequency. The 
gate at the ADC input is only opened when there is no impulse to be measured at 
the time of scanning. The dead time can be calculated by comparing the number 
of scans with the number of processed noise impulses. 
An error of < 1% results for the correction of dead times up to 70% using this 
method. 

Min. Peak Height Text Box 
The value in this edit control depends on the used instrument and will only be 
available in service mode.  

Sigma Min. Peak Height Text Box 
The value in this edit control depends on the used instrument and will only be 
available in service mode.  

Max Energy Shift Edit Control 
The value in this edit control depends on the used instrument and will only be 
available in service mode.  
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Results Group Box 
The values in this text boxes represent the results of a MCA Recalibration und will 
be automatically updated after a new calibration. 

Reset Command Button 
Click on this command button, to reset the calibration constants to the standard 
settings. 

Calibration Peaks Group Box 

Number of Calibration Peaks Drop-Down List 
Select the number of calibration peaks in this drop-down list box. The same 
number of element text boxes and channel text boxes will be editable.  

Combinations: Element Text Box, PSE Command Button and Display Field 
The element for the target material can be chosen with this combination of dialog 
elements. Use either the text box to enter the atomic number or the PTE command 
button to select an element using the periodic table of elements. The Select 
Element dialog box is opened when the PTE command button is chosen. The 
name of the selected element is displayed in the display field. 

Channel Text Boxes 
Enter the channel for the selected element in this text box. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

6.3.20 Select Elements Dialog Box 
This dialog box is used to select several elements or the respective line markers. 
Click on the box for an element in order to select it. The different colors have the 
following meanings:  

 
This element can be analyzed with the spectrometer. The 
element is not selected. Click on the element to select it. 

 
This element can be analyzed with the spectrometer. The 
element is selected. Click on the element to remove the 
selection. 

 
This element cannot be analyzed with the spectrometer. The 
element is not selected. Click on the element to select it. 

 
This element cannot be analyzed with the spectrometer. The 
element is selected. Click on the element to remove the 
selection. 

 
This element cannot be analyzed with the spectrometer. The 
element cannot be selected at this time. 

 
This element can be analyzed with the spectrometer. 
However, the element cannot be selected at this time. 

There is a blue triangle in the lower right corner of each box. Click on this triangle 
and hold the mouse key pressed; detailed information about the selected element 
is displayed in a dialog box.  
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Multiple elements can be selected in this dialog box. The current selections remain 
until the selection is removed from them by clicking on them. 

In addition to the periodic table this dialog box contains the following elements: 

OK Command Button  
Click on this command button to close the dialog box and accept the current 
selection. 

Cancel Command Button  
Click on this button to close the dialog box and cancel the procedure for selecting 
multiple elements. 

Suggest Command Button 
This command button is only displayed when the dialog box is opened from the 
dialogs for configuration of the printout. For print functions, all of the elements 
between atomic number 1 and 92 can be selected. Click on this command button 
to select the elements that have actually been calibrated in the respective method.  

K-Shell Check Box 
Mark this check box if the line markers for the K-shell for the last selected element 
are to be displayed. The atomic number for the last selected element is displayed 
in the Element text box.  

L-Shell Check Box 
Mark this check box if the line markers for the L-shell for the last selected element 
are to be displayed. The atomic number for the last selected element is displayed 
in the Element text box. 

M-Shell Check Box 
Mark this check box if the line markers for the M-shell for the last selected element 
are to be displayed. The atomic number for the last selected element is displayed 
in the Element text box. 

Element Text Box  
Enter the atomic number for the element to be selected in this text box. Then click 
on the Add or Remove command button to select or remove the selection from an 
element. 

Add Command Button  
Click on this command button to add the element in the Element text box to the 
selection. 

Remove Command Button  
Click on this command button to remove the element in the Element text box from 
the selection. 

Select All Command Button  
Click on this command button to select all of the elements in the dialog box that 
can be selected. 

Delete All Command Button  
Click on this command to remove all of the elements from the selection. 

Help Command Button  
Click on this command button to display this help text. 
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See also: 

Spectral Representation Settings Dialog Box 
Edit Deconvolution Method Dialog Box 
Special Options for Standard Printing Dialog Box 
Special Options for Multi List Dialog Box 
Special Options for Special (Roche) DialogBox 
Tools 

6.3.21 Evaluation Dialog Box 
In this dialog box parameters depending on your instument will be shown. These 
parameters can only be changed in service mode. 

6.3.22 Data Transmission Dialog Box 
This dialog is only shown if the optionally available data transmission is activated 
in service mode. 

Format Drop-Down List Box: 
Select the used data transmission protocol in this drop-down list box. 

Data Path Text Box with Command Button 

  
 

You can select a directory for the automatic data storage by clicking this command 
button. The filename of the data can be edited in the specified method. 

Transmission Program Text Box with Command Button 

  

You can select a program sending the stored data by clicking this command 
button. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

  

6.3.23 Users and Passwords 

SPECTRO Analytical Instruments GmbH 

6.3.24 User Management Dialog Box 
This dialog box is used by the supervisor to manage user information. Up to 16 
users with up to 4 different user levels can be entered here. The user 
management function enables the control of access to the analytical system when 
there are multiple users. The user levels can be setup so that the users assigned 
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to the different user levels have access only to certain functions for the analytical 
system. The dialog box is opened with the User management menupoint in the 
Tools menu. The dialog box contains the following elements: 

Users must enter a username and password to use X-LabPro Check Box 
Activate this check box if you want the X-LabPro Login dialog box to be displayed 
when the program is started. This enables access control to the system. If this 
check box is deactivated, then the user does not need to login when the program 
is started. The first user entered is automatically selected as the user. This user 
then automatically has the same access rights as a supervisor. 

Allow delete only in Supervisor Mode Check Box 
Activate this check box if you want that deletion of sample or spectra data is only 
possible in the supervisor mode. In all other modes in the job, routine and spectra 
window it is not possible to delete any data of measured samples. 

User data List Box 
A list of all of the defined users is displayed in this list box. Up to 16 users can be 
entered here. There must be at least one user entered and this must be in position 
1. This user must be assigned to the supervisor user level even if user 
management is deactivated. Additional users may be defined as required. 

Add Command Button 
Click on this command button to open the Edit User Data dialog box for creating a 
new user.  

Remove Command Button 
Click on this command button to delete the currently selected user from the list. 

Properties Command Button 
Click on this command button to open the Edit User Data dialog box. The data for 
an entered user can be changed, or if an empty position has been selected, a new 
user can be entered. 

Your User Data Group Box 
The data for the currently logged in user is shown in this group box. This includes 
the login name, the complete user name and the assigned user level. 

Save + OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 
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6.3.25 User Levels 

The usage of the software contains of several user levels to do justice to the 
demands of the different users and if necessary to restrict the access to some 
functions.  
Maximally 16 users can be subordinated with the following user levels: 

Routine 
User 

The routine user can only have access to the Routine Dialog, not 
to the main program. This is the lowest user level. 

Level 3 
User 

The level 3 user can only have access to the routine window. He 
can create new amples, make measurements and analyze but not 
delete them. For this user level can be fixed a password but it isn´t 
necessary. 

Level 2 
User 

The level 2 user can additionally to the possibilities of the level 3 
user also access to the job and the spectra window. He has the 
possibility to delete samples and to print results in form of reports. 

Level 1 
User 

The level 1 user has access to all windows but in the method 
window he can only edit non-protected samples or the ones he 
creates himself. 

Supervisor The supervisor has access to all windows and all options and 
functions. Only the from Spectro delivered methods can´t be 
edited by him. 

  

6.3.26 Recalibration Dialog Box 
This dialog box is used to define the sample plate settings for the different types of 
recalibrations. The recalibration sample plates defined in this dialog will be used 
as a default setting in the Routine Dialog. 

When using the recalibration menu points in the Routine Dialog, the Routine 
Dialog will create a new sample plate document containing automatically new 
replicated recalibration sample data. E.g. the description of the MCA recalibration 
will contain more details. 

Recalibration Tab Control 
The type of recalibration (e.g. global recalibration, MCA, intercept recalibration, 
method recalibration) for which you want to define, edit or view the recalibration 
sample plate data can be selected here. 

Sample Plate Drop Down List Box 
Select the sample plate size for the selected recalibration here. 

Recalibration Sample Table 
The table contains a representation of the sample plate.  
If you want to define a new reclibration sample on the plate, click the  button in 
the line numbered as the sample position where you want to place the sample. 
The Select Sample Dialog Box opens, pre-setted with the method you selected for 
the respective recalibration sample plate. Select the sample you want to place. 
Note: You must select the reference samples here. New recalibration samples will 
automatically be created by the Routine Dialog like described above.. 
If you want to delete a recalibration sample from the selected recalibration plate, 
use the  button. 
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OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

6.3.27 Bond Classes Dialog Box 
This dialog box is used to view and edit bond classes. This dialog box is opened 
with the Bonds icon.  

Bond Classes Tab Control 
Each page of this tab control contains a defined bond class. You can add, edit or 
delete bond classes. The name of the page shows the name of the bond class. 
The table that is displayed on a page contains the chemical bond data. Click on 
the edit button in each row to open the edit chemical bond dialog box for editing a 
bond class. In this dialog you can edit the chemical bond data. 

New Command Button  
Click on this command button to open the New Bond Class dialog box. In this 
dialog you can enter a name for a new bond class. Use the Use Base check box to 
derive your bond class from an existing one. The new register card with the bond 
class name will be inserted into the tab control. 

Edit Command Button  
Click on this command button to open the New Bond Class dialog box. In this 
dialog you can change the name for a new bond class. The name of the tab 
control page will be changed. 

Delete Command Button  
Click on this command button to delete the currently selected bonds class. The 
register card will be removed from the tab control. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

6.3.28 Foils Dialog Box 
This dialog box is used to view and edit the composition of different foils. This 
dialog box is opened with the Foils icon.  

Foils Table 
This table contains all defined foil compositions.  

New Command Button  
Click on this command button to open the Edit foil dialog box in order to insert a 
new foil composition. 
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Edit Command Button  
Click on this command button to open the Edit foil dialog box in order to edit the 
current selected foil composition. 

Delete Command Button  
Click on this command button to open the Edit foil dialog box in order to delete the 
current selected foil composition. 

OK Command Button 
Click on this command button to close the dialog box and store any changes. 

Cancel Command Button 
Click on this command button to close the dialog box. Changes to the settings are 
not stored. 

 

 

7 Library of Atomic Data 

7.1 Using the Library of Atomic Data 

7.1.1 Items of the client area 
The data stored in the library of atomic data is displayed in the Library of Atomic 
Data. This data is used as the basis for evaluations.  

The dialog box for display of the data stored in the library of atomic data is divided 
into the following display regions: 

General Information Group Box 
General information about the selected element is displayed in this group box. 
These parameters are: Atomic Number, Atomic mass, Name, Symbol, Melting 
Point, Density, Valence, electronic Structure.  
It is possible to select an element directly be entering the atomic number in the 
atomic number edit control. 

Mass Absorption Coefficient Group Box 
The mass absorbtion coefficient depending on the absorbing element can be 
calculated in this dialog box. To calculate the mass absorbtion coefficient, edit the 
energy that will be absorbed and select the absorber element. 

Line Energies Group Box 
The line energies of the lines for the selected element are shown in a Spread table 
in this group box. This data is not stored for all elements. To edit the current 
selection in the supervisor level, click into the specific field to edit the values. 

Coster-Kronig Rates Group Box 
The Coster-Kronig rates for the selected element are shown in a spread table in 
this group box. To edit the current selection in the supervisor level, click into the 
specific field to edit the value. 
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Discontinuity Energies and Fluorescent Yields Group Box 
The discontinuity energies, the discontinuity ratios and the fluorescent yields for 
the selected element are shown in a spread table in this group box. To edit the 
current selection in the supervisor level, double click into the specific field to edit 
the value. 

Scattering Group Box 
This group box contains data for scattering  

Atomic Form Factor, Scatter Amplitude, Coherent and Incoherent Collision 
Cross Sectiones are physical values to quantify the scattering of X-rays on 
matter.  

7.1.2 Parameters Dialog Box 
This dialog box shows the polymom parameters to calculate the mass absorption 
coefficient. It will be opened by clicking the parameter command button and 
contains the following dialog elements:  

Parameters to calculate the Mass Absorption Coefficient Table 
In this table you can edit seleted values. 

OK Command Button  
Click on this command button to close the dialog box. The element displayed in 
the marked line of the list box will be selected. 

Cancel Command Button  
Click on this button to closed the dialog box and cancel the search for lines. 

7.1.3 Select Element Dialog Box 
This dialog box is used to select an element. Click on the box for an element in 
order to select it. The different colors have the following meanings:  

 
This element can be analyzed with the spectrometer. The 
element is not selected. Click on the element to select it. 

 
This element can be analyzed with the spectrometer. The 
element is selected. Click on the element to remove the 
selection. 

 
This element cannot be analyzed with the spectrometer. The 
element is not selected. Click on the element to select it. 

 
This element cannot be analyzed with the spectrometer. The 
element is selected. Click on the element to remove the 
selection. 

 
This element cannot be analyzed with the spectrometer. The 
element cannot be selected at this time. 

 
This element can be analyzed with the spectrometer. 
However, the element cannot be selected at this time. 

There is a blue triangle in the lower right corner of each box. Click on this triangle 
and hold the mouse key pressed; detailed information about the selected element 
is displayed in a dialog box. 
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Only one element can be selected in this dialog box. A previous selection is 
automatically removed when a new element is selected. 

In addition to the periodic table of elements, the dialog box contains the following 
elements: 

OK Command Button  
Click on this command button to close the dialog box and accept the current 
selection. 

Cancel Command Button  
Click on this button to close the dialog box and cancel the procedure for selecting 
an element. 

Element Text Box  
Enter the atomic number for the element to be selected then click on the Select 
command button to confirm the selection. 

Select Command Button  
Click on this command button to select the element displayed in the element list 
box or to remove the selection if it is already selected. 

Help Command Button  
Click on this command button to display this help text. 

See also: 

Library of Atomic Data Dialog Box 
Target Position Parameters Dialog Box 
Absorption Discontinuity Dialog Box 
Average Atomic Number Calibration Dialog Box 
Calibration, Compton/Empirical Dialog Box 
Calibration, Fundamental Parameters Dialog Box 
Select Elements (Calibration) Dialog Box 
Edit Element Bonds Dialogbox 
Edit Deconvolution Method Dialog Box 
Edit Method Data Dialog Box 
Method Development (Calibration Line) 

7.1.4 Search for Element Dialog Box 
This dialog box enables you to select an element whose line energies lie within a 
given energy range. Confirm the search to select the element in the marked line of 
the list box which shows you the results of the search. This dialog box is opened 
with the Search menupoint (Element menu) or with the  button in the toolbar. 
The dialog box contains the following elements.  

Line Energy Text Box  
Enter the energy value for any lines for which you want to search in this text box. 
Valid entries lie in the range between 0 and 150 keV. 

Search Range Text Box  
Enter a value that defines the search range in this text box. All lines in the range of 
the line energy ± the entered value are then displayed in the list box described 
below. 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 134 of 391 
 
 



                     
 

X-LabPro  5  
 

List Box with the Located Lines 
All of the lines that are stored in the library of atomic data for the selected range 
are displayed in this list box. Double-Click (or click the OK button) on a line in 
order to select the element for the XLAdLib representation. 

Repeat Command Button  
Click on this command button to repeat the search after making changes to the 
settings for the line energy or the search range. The list box with the located lines 
is updated. 

OK Command Button  
Click on this command button to close the dialog box. The element displayed in 
the marked line of the list box will be selected. 

Cancel Command Button  
Click on this button to closed the dialog box and cancel the search for lines. 

 

7.2 Menu Commands 

7.2.1 Library of atomic data 
The library of atomic data XLAdLib is a new module of the X-LabPro 2.3 software 
package to view the atomic data. The atomic data is the basis for evaluation on 
your X-LabPro system. 

Moreover, XLAdLib gives you the possibility to calculate the mass absorption 
coefficient. 

Menu overview 

File Menu 

Element Menu 

View Menu 

Help Menu 

7.2.2 Commands in the File Menu 
Exit 
Use this command to end your XLAdLib session. You can also use the Close 
command on the application Control menu. 

Shortcuts 

Mouse: Double-click the application's Control menu button. 

 
Keys: ALT+F4 
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7.2.3 Commands in the Element Menu 
Next 
Select the next element. The atomic number will be increased. 

Previous 
Select the previous element. The atomic number will be decreased. 

Select 
Opens the Periodic Table dialog box. 

Search 
Opens the Search for Element dialog box. 

7.2.4 Commands in the View Menu 
Toolbar 
Use this command to display and hide the Toolbar, which includes buttons for 
some of the most common commands in XLAdLib. A check mark appears next to 
the menu item when the toolbar is displayed. 
See Toolbar for help on using the toolbar. 

Statusbar 
Use this command to display and hide the Status Bar, which describes the action 
to be executed by the selected menu item or depressed toolbar button, and 
keyboard latch state. A check mark appears next to the menu item when the 
Status Bar is displayed. 
See Status Bar for help on using the status bar. 

 

7.2.5 Commands in the Help Menu 
The help menu contents the following commands which will assist you by using 
this application: 

Contents 
Select this menupoint to display a table of contents for the help system for the X-
LABPro program. In the help system, select the Contents command button below 
the menuline to show the table of contents. 

Context Sensitive 
Select this menupoint to display a context sensitive help text. This menupoint 
corresponds to the command button with a question mark in the toolbar. 

Concept 
Select this menupoint to display a table of contents for concepts. The physical and 
technical principles for using the X-LAB energy dispersive x-ray fluorescence 
spectrometer are described in this section. 

Software 
Select this menupoint to display a table of contents for the software description. 
Use of the operation and control software for the X-LAB energy dispersive x-ray 
fluorescence spectrometer is described in this section. 
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Procedures 
Select this menupoint to display a table of contents for the procedures. Instructions 
for commonly used procedures when working with the X-LAB energy dispersive x-
ray fluorescence spectrometer are given in this section. 

Shortcuts 
Select this menupoint to display an overview of the keyboard shortcuts. 

About XLAdLib 
Show the version and copyrights of XLAdLib. 

7.2.6 Commands in the Control Menu 
Restore 
Use this command to return the active window to its size and position before you 
chose the Maximize or Minimize command. 

Move 
Use this command to display a four-headed arrow so you can move the active 
window or dialog box with the arrow keys. 

 

Note: This command is unavailable if you maximize the window. 

Size 
Use this command to display a four-headed arrow so you can size the active 
window with the arrow keys. 

 

After the pointer changes to the four-headed arrow:  

Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the 
pointer to the border you want to move.  

Press a DIRECTION key to move the border. 

Press ENTER when the window is the size you want. 

Note: This command is unavailable if you maximize the window. 

Shortcut 
Mouse: Drag the size bars at the corners or edges of the window. 

Minimize 
Use this command to reduce the XLCedi window to an icon. 

Shortcut 
Mouse: Click the minimize icon  on the title bar. 

Maximize 
Use this command to enlarge the active window to fill the available space. 

Shortcut 
Mouse: Click the maximize icon  on the title bar; or double-click the title bar. 
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Close 
Use this command to close the active window or dialog box. 

Clicking the Close icon  and double-clicking the Control menu icon is the same 
as choosing the Close command. 

Note: If you have multiple windows open for a single document, the Close 
command on the document Control menu closes only one window at a time. You 
can close all windows at once with the Close command on the File menu. 

Shortcuts 
Keys: CTRL+F4 closes a document window 

 

7.3 Other 

7.3.1 Status Bar 

 

The status bar is displayed at the bottom of the XLAdLib window. To display or 
hide the status bar, use the Status Bar command in the View menu. 

The left area of the status bar describes actions of menu items as you use the 
arrow keys to navigate through menus. This area similarly shows messages that 
describe the actions of toolbar buttons as you depress them, before releasing 
them. If after viewing the description of the toolbar button command you wish not 
to execute the command, then release the mouse button while the pointer is off 
the toolbar button. 

The right areas of the status bar indicate which of the following keys are latched 
down: 

Indicator Description 

CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down. 
SCRL The Scroll Lock key is latched down.
  

  

7.3.2 Toolbar 

 

The toolbar is displayed across the top of the application window, below the menu 
bar. The toolbar provides quick mouse access to many tools used in XLAdLib. 

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). 
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Click To 

 
Click on this toolbar button to view the information for the element with 
the next lower atomic number. The last element is shown again once the 
first element has been reached. 

 
Click on this toolbar button to view the information for the element with 
the next higher atomic number. The first element is shown again once the 
last element (atomic number 105) has been reached. 

 
Click on this command button to select an element using a representation 
of the periodic table of elements. The Select Element dialog box opens. 

 
Click on this command button to search an elementby entering a line 
energy range. The Search for Element dialog box opens.  

 
Display the online help. 

  

  

7.3.3 Scroll bars 
Displayed at the right and bottom edges of the document window. The scroll boxes 
inside the scroll bars indicate your vertical and horizontal location in the document. 
You can use the mouse to scroll to other parts of the document. 

 

7.3.3.1 Title Bar 

 

The title bar is located along the top of a window. It contains the name of the 
application. 

To move the window, drag the title bar. Note: You can also move dialog boxes by 
dragging their title bars. 

The Titel Bar contains the following command buttons: 

 Exit command button 

 Maximize command button

 Minimize command button
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8 Hot Keys 
In the different windows, the program offers "hot keys". These enable some of the 
program functions to be started directly with key combinations. The following hot 
keys are available: 

General Hot Keys 

Special Hot Keys for Method Administration 

See also: 

Toolbar 

8.1 General Hot Keys 
The hot keys that can be used in X-LabPro 5 are listed in the following table: 

Key(s) Description 
F1 Display context sensitive help 
F9 Activate/open Job window 
F10 Activate/open the Routine Dialog 
F11 Activate/open Spectra window 
F12 Activate/open window for Method 

Development 
Alt+F4 Exit Program 
Alt+F12 Open dialog box with periodic table 
Ctrl+F4 Close window 
Ctrl+F6 Next window 
Shift+F1 Display Table of Contents for Help 
Delete Delete sample(s)/sample position 
Shift+Delete Cut sample(s) and copy to clipboard 
Ctrl-Insert Copy sample(s) to clipboard 
Shift-Insert Insert sample(s) from clipboard 
Shift+F5 Cascade open windows  
Shift+F6 Tile open windows 
See also: 

Hot Keys 
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8.2 Job Manager Shortcuts 
Shortcuts of the Job Manager window are listed in the following table: 

Key(s) Description 
Ctrl+A Mark all standard samples in the list 
Ctrl+C Copy standard sample(s) into clipboard 
Ctrl+Ins Copy standard sample(s) into clipboard 
Ctrl+V Paste standard sample(s) 
Shift+Ins Paste standard sample(s) 
Ctrl+D Paste standard sample(s) with data 
Shift+Ctrl+Ins Paste standard sample(s) with data 
Del Delete selected standard sample(s) 
Ctrl+P Print selected standard sample(s) 
F1 Open the online help 
F2 Edit standard sample 
Ctrl+F4 Close active job window 
Ctrl+Q Close active job window 
Ctrl+O Open job 
F7 Evaluate standard sample(s) 
F11 Open selected standard sample(s) in the Spectra Viewer 

 

8.3 Shortcuts 
The following shortcuts can be used in the Routine Dialog: 

Key Description 
F1 Shows help topics for the Routine Dialog. 
Alt + F4 Closes the active document. 
Ctrl + N Opens a new document. 
Ctrl + F6 Switches to the next document window. 
Del Deletes the selected area of the table. 
Ctrl + X or  
Shift + Del 

Cuts the selected elements from the table and adds them to 
the clipboard. 

Ctrl + C Copies the selected elements of the table to the clipboard. 
Ctrl + V or  
Shift + Ins 

Pastes the contents of the clipboard to the table. 

Ctrl + Left 
Ctrl + Right 

Navigate in table cell (only if activated). 
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8.4 Method Administration Shortcuts 
Shortcuts of the Method Administration window are listed in the following table: 

Key(s) Description 
Ctrl+A Mark all standard samples in the list 
Ctrl+C Copy standard sample(s) into clipboard 
Ctrl+Ins Copy standard sample(s) into clipboard 
Ctrl+V Paste standard sample(s) 
Shift+Ins Paste standard sample(s) 
Ctrl+D Paste standard sample(s) with data 
Shift+Ctrl+Ins Paste standard sample(s) with data 
Del Delete selected standard sample(s) 
Ctrl+P Print selected standard sample(s) 
F1 Open the online help 
F2 Edit standard sample 
Ctrl+F4 Close active method window 
F5 Update standards list 
Ctrl+F5 Update tree 
F7 Evaluate standard sample(s) 
F11 Open selected standard sample(s) in the Spectra Viewer 
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X-LABPro 5 General Tutorial  
9 Application guide 

Additives in oil/lubricants   
Application:  Check for the elements Na – Zn in oil 
Sample prep.:  Pouring liquid into sample cup 
Precision:  1-3 % 
LOD:  Depends on elements 
Quantification: Fundamental parameters 
    
Fuels   
Application: Check for S 
Sample prep.:  Pouring liquid into sample cup 
Precision:  1-3 % 
LOD:  < 1 ppm 
Quantification: Fundamental parameters 
    
Minerals/Geology/Slags/Ceramics   
Application:  Check for main components 
Sample prep.:  Fusions 
Precision: 0.2 % 
LOD:  Depends on elements 

Quantification:  Fundamental parameters or alpha 
coefficients 

    
Application:  Check for trace elements 
Sample prep.:  Pellets 
Precision:  1-10 % 
LOD:  > 0.2 ppm 

Quantification: Fundamental parameters or empirical 
method 

    
Metals   

Application:  Analysis of metals of a defined matrix 
(like brass, steel...) 

Sample prep.: Polishing surface 
Precision:  1-3 % 
LOD:  > 100 ppm 
Quantification:  Fundamental parameters  
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Ferro alloys   
Application:  Check for main components 
Sample prep.: Pellets 
Precision:  1-3 % 
LOD:  > 100 ppm 
Quantification:  Empirical calibration 
    
Remark: Ferroalloys show strong particle size effects. Therefore, standards must 
represent the same grain size effects as the samples do.  
Caused to that no international standards can be used for calibration. 

    
Food   

Application:  Na, Mg, P, Cl, K, Ca, Fe, Zn in 
milkpowder 

Sample prep.: Pellets, powders in sample cups 
Precision:  1-5 % 
LOD:  > 0.5 ppm 

Quantification:  Fundamental parameters or empirical 
methods 
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10 Sample Preparation 

10.1 Sample Preparation for Liquids 
If a homogenous liquid sample like water or oil / gasoline should be measured, it 
can be poured into a cuvette. 

Important note: 
The weights are approximated values! It is not necessary to reach exactly 4.000 g. 
It is sufficient to weigh between 3.8 g and 4.2 g (5 % deviation) and to enter the 
correct weight in the Routine Dialog. 

To analyze polyphased liquids (liquid/liquid or solid/liquid) or high volatile liquids 
it is recommended to use 4 g (plus-minus 5 %) of a homogenized mixture, 
prepared taking 6 g sample and 2 g charcoal (Merck)  
(weights = plus-minus 5 %). 

 

This mixture can be measured in the next step. 

 

 

 

10.2 Sample Preparation for Powder Samples 
Prepare a sample cup with powder. 

 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 145 of 391 
 
 



                     
 

X-LabPro  5  
 

 Approx. 4 g of a powder ground down to e.g.< 63 µm is poured into a cuvette.  

The bottom of the cuvette is covered by a 4 µm Prolene foil.  

After pouring the powder will be slightly pressed with a pistil to form a good 
surface to avoid any cavities or pores at the bottom. 

Important note: 
The weights are approximated weights! It is not necessary to reach exactly 4.000 
g. 
It is sufficient to weigh between 3.8 g and 4.2 g (5 % deviation) and to enter the 
exact weight in the Routine Dialog. 

 

10.3 Sample Preparation for Liquids / Powders  
Sample type:              Liquids / Powders 

Additives:                   None 

Preparation utilities:    Sample cup (outer diameter 32 mm), Prolene foil (4 µm 
thickness) 

 

 

Most sample cups are built from 
three parts: snap-on-ring (1), lid (2) 
and cell (3). 

    

 

Cover cell (3) with film. 
Recommendation: 4µm 
Polypropylene film. 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 146 of 391 
 
 



                     
 

X-LabPro  5  
 

    

 

Click snap-on-ring (1) over the 
prolene foil and cell (3). Surface 
should be flat and smooth (no 
wrinkles). After placing the snap-
on-ring never overstretch the foil, 
because this would change the 
thickness. 

    

 

Cut foil. 

 

Place the sample cup on a 
balance. 4 g of liquid is poured into 
the sample cup. 
 
Please use a weighing paper, to 
prevent contamination. 
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Close the sample cup with the lid 
(2). Label the sample. Leave the 
sample for some time (1 minute 
minimum is recommended) on a 
sheet of clean paper to check for 
leakage. 

 

10.4 Sample Preparation for Pellets 
The most common sample preparation for solid samples is a pressed pellet. 

 

 Approx. 4 g of a powder (e.g. < 63 µm) is homogenized with approx. 0.9 g of 
Hoechst Wax C and pressed to a 32 mm pellet or a 40 mm pellet. 

 

Sample:  Powder 

Additives:  Hoechst Wax C, Binder Licowax C 

Preparation  Mill 

Utilities:  Container for grinding and mixing 

  Die (diameter 32 or 40 mm) 
Important note: 
The weights are approximated values (3.8 g - 4.2 g and 0.85 g - 0.95 g, 
respectively)! Enter the exact values in the Routine Dialog. 
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10.5 Preparation of Pressed Powder Pellets in Rings 

Some powders may require pressing to insure that the bulk density of the samples 
is reproducible. If elements like Na and Mg need to be analyzed with highest 
sensitivity, the powdered samples need to be prepared as pressed pellets or as 
fused beads. 

In case of a pressed pellet the powder can either be pressed directly or a binding 
material is added. 

To achieve highest stability of the pressed pellets and to get best possible 
precision of the sample preparation procedure it is recommended to press the 
samples into 40 mm (1.57”) steel rings. 

 

Weigh 5 (± 0.1) g of pulverized 
sample material (optimum grain 
size < 60 µm) into a mixing 
beaker and add 1 (±0.05) g of 
binder Clariant Licowax C 
(HWC). Note all weighs because 
these have to be entered into the 
software when analysing the 
sample. 

 

Add two Polyamide balls 
(diameter 7-10 mm) into the 
mixing vessel. 
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Use a blender or mixer mill at 
40- 60 % speed for 3 (±0.5) 
minutes to create a 
homogeneous mixture. 

 

Prepare all parts of the die and 
make sure, that all parts are 
clean and dry. 

 

Put the outer part of the die on 
the bottom part of the die. 
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Press the outer part down as 
much as possible. 

 

Insert of the pressing plate 
(shining side to the top) into the 
die and make sure that this has 
moved to the bottom of the inner 
hole. 

 

Insert a reusable steel ring into 
the die and make sure, that this 
has moved to the top of the 
pressing plate. 
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Insert the longer steel-tube into 
the die and onto the steel ring. 

 

  

 

Remove the two Polyamide balls 
out of the mixing beaker. 
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Fill the sample-mixture carefully 
into the die and make sure, that 
a relatively plane surface is 
achieved on the top side. 

 

Hold the steel tube with two 
fingers and insert the pressing 
cylinder into the die carefully. 

 

Put the die into a press and 
press the content into a pellet at 
a pressure of 10 - 25 t.  
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Hold the pressure for 20 - 30 s. 

 

Release the pressure and 
remove the die from the press. 

 

Remove the bottom of the die 
and press the die to the table as 
long as the pressing plate and 
the sample steel ring become 
visible. 
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Remove the pressing plate, the 
steel ring with the pressed pellet. 

 

Take out the steel tube and the 
pressing cylinder as well.  
Clean all parts of the die 
carefully else with Iso-Propanol 
or a mixture of cleaning agent. 
Dry all parts carefully after 
cleaning and store them in a dry, 
dust-free environment. 

 

Place the pressed pellet with the 
steel ring on the precision 
sample tray.  
The combination of this sample 
preparation technique together 
with the precision plate offers the 
highest grade of stable, 
reproducible sample preparation 
for pressed pellets with highest 
accuracy of sample positioning 
in the analyzer. 
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10.6 Sample Preparation for Fused Beads 

 

After the mixture is prepared and possible additives like nitrates for preoxidations 
were added prepare a bead 
as shown in the following picture. 

 

Sample:  Powder 

Additives:  Lithiumtetraborate or other borates, wetting agent 

Preparation Utilities:  Platinum/Gold crucible and mould 

  Fusion machine or furnace 
The sample material must be dried and milled to a grain size below e.g. 63 µm. 

Approx. 0.7 g of the powder is homogenized with around 6.0 g of 
Lithiumtetraborate and then fused at 1100 °C to form a bead. As standard 
procedure 10 minutes fusion time should be sufficient.  
Depending on the material and the fusion machine time and temperature may 
vary.  
Also, for some materials a preoxidation can be necessary. Especially Sulfur 
present in sulfidic form is very sensitive against too high temperatures and it tends 
to evaporate. To avoid this, a preoxidation (for example with Nitrates) can help. 
Another possibility is the use of different borate like Tetraborate-Metaborate-
Mixture, which melts at around 950 °C. 

In some cases it is obligatory to reduce the sample amount down to 0.2 g. If a lot 
of fusion remains in the crucible the use of a wetting agent (e.g. NH4I) can be 
necessary.  

Note: There are some materials which may destroy your Pt/Au crucible.  
The most dangerous ones are all kind of metals, especially elemental silicon, 
boron or iron.  
Also, carbides are dangerous.  

Important note: 
The weights are approximated values! It is not necessary to reach exactly 0.70 g 
and 6.00 g, respectively. 
It is enough to weigh between 0.65 g and 0.75 g (5 % deviation) and 5.7 g - 6.3 g, 
respectively, and to enter the exact weight in the Routine Dialog. 
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11  Measuring a sample - The Routine Dialog 
All measurements are initialized from the routine dialog. To 
open the Routine Dialog  
select the following symbol in the icon bar or use the X-
LabPro Communication Server. 

 

  

 

As an example the foregoing picture shows the Routine Dialog for the SPECTRO 
iQII comprising three different parts: 

- The left part of the screen shows either a spectum. 

- The right part shows a table presenting the results of the measured sample or, 
  as shown in the screenshot above, the sample plate as spreadsheet. 

- The bottom part shows the control buttons to start or stop the measurement and 
a presentation of the actual logfile. 

To configure the Routine Dialog, use the section Routine Dialog in the 
Configuration Editor. 
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11.1 Configure Routine Dialog 

The Routine Diakog is the user interface to use the X-LabPro software for daily 
work.  

 

The configuration of the Routine Dialog is handled from the Configuration Editor.  

Start the Configuration Editor from the X-LabPro  Communication Server. 
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If a Supervisor is logged-in, the settings for the Routine Dialog can be reached 
with the corresponding icon. 

The first tab (Presets) allows to define some parameters like: 
- Preset Method Class 
- Sample Plate (number of samples - if available) 
- Locked Positions (of a sample tray) 
- The suggested Job Name (Job Number) 

 

Several Method Classes can be created using the second tab: 
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A method can be assigned to a method class (third tab).  
That's an important step, because only methods belong to a method class can 
be used in Routine Dialog! 
 

 

 
 

For other instruments, which use a table instead of the result screen, the Columns 
can be selected: 
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On a sample tray some positions can be locked (right tab). 
This can be done to ensure that no liquid sample in position 1 can be forgotten in 
the instrument. 

 

 

11.2 Routine Dialog 
All measurements are initialized from the Routine Dialog.  
To open the Routine Dialog select the following symbol in the icon bar  
or use the X-LabPro Communication Server. 
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As described before, the Routine Dialog comprises three different parts: 

- At the left the presentation of the spectra of the actual measurement is shown. 
- The right part shows the sample information. 
- At the bottom the control buttons to start or stop the measurement are placed, 
together with a presentation of the actual logfile. 

To create a new sample define a sample name and a related job name and select 
a method.  

Normally, all settings (like available methods) are defined in the right way.  
Whether a job can be selected depends on the configuration of the software, 
because there are different options:  
A job name will be created automatically by the software (e.g. the actual week) or 
the name of the job can be edited. 

If a method is missing, please ask your supervisor to adjust it, using the 
Configuration Editor. 

Each sample needs a name, a method and a job as a description. The name does 
not have to be unique but it should help identifying the samples. By selecting a 
method the measurement conditions and the sample type are preset to the default 
settings of this method. To change the selected Method or Job use the respective 
drop-down menu. 

Jobs are the different sub-directories for your database. Similar to folders on your 
hard disk they help you to organize your measurements. 
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By selecting a method the default values of the Method will be displayed. The 
details like sample weightes and diameter can be edited if needed. 

Now it is possible to create additional samples on different positions or to start the 
measurement. To start the measurement click Start. 

Depending on the selected method, the samples will be measured in vacuum, with 
gas flush or in air. Whenever the samples shall be measured either with vacuum 
or gas flush a warning message will pop up on the screen to inform you about this 
measurement condition. Never run liquids in vacuum to prevent harm to your 
instrument. If you are sure about the measurement conditions confirm with Yes 
and the measurement will begin. Selecting No will cancel the entire measurement. 

An additional message will inform about a protection foil, if the last one is defined 
in the selected method. 

While the measurement is running, the screen looks like the following one. 

 

It is possible to use the Spectra Viewer Tool-Box, e.g. to identify peaks in the 
spectrum. 
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At the end of the measurement 
(depending, whether a sample 
cup for liquids or powders was 
used or not), an additional 
message will appear: 

 
After the measurement is completed, the results will be shown (two pictures 
above). To start a new measurement, use New (right side of the sample name) or 
paste the sample from Job/Method using the clipboard. 

The SPECTRO iQ also allows the use of a Easy user interface, which is even 
easier to handle: 

 

Simulation Mode 

There are two situations, when software starts the Simulation Mode: 
1. If no instrument could be detected (Instrument off or not connected) 
2. If the Simulation Mode ist selected manually. 
 
The Simulation Mode allows to simulate a measurement without an instrument 
(e.g. on exhibitions). Doing this a set of stored spectra will grow in the Routine 
Dialog and it looks like a real measurement. Please note that these spectra are 
just simulated and do not show the samples placed into the instrument. Therefore, 
a messagebox will inform you during the start of the Routine Dialog, if the 
Simulation Mode is activated.  
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12 Printing results 
The layout of the output is defined in the method.  

To print results select the Print... option from the pull-down menu File or select the 
printer symbol in the icon bar or enable the Direct Print option in the lower left part 
of Routine. 

Various printing options can be selected as shown in the screen below. 

 

In the same window it is possible to change the layout for the selected print job.  
Modifications will not affect the default settings of the method. 

 

To get a first impression, it is 
possible to display a preview 
before printing by selecting Print 
Preview in the file pull-down 
menu. 
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12.1 Output 

The tab Output is used to select the elements, which should be printed / shown on 
the screen. 

In addition, that's the place to define, whether bonds should be used, whether the 
elements should have a special Order, and to select the Output Units for each 
element separately. 

 

 

12.2 Print Preview 
The feature Print Preview as part of the file menu allows getting an impression of 
the printout before printing. 
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13 Working with jobs 
The Job Manager is a tool to organize the measured samples. The jobs are 
comparable to subdirectories or folders. In each job the software can handle up to 
1000 samples. How to sort the samples in different jobs is up to the user.  

To work with jobs select the Job Manager... option from the X-LabPro menu. 

 

In the left part, all available jobs are shown and you have access to the general 
information for each job.  

At the right side, a list of all samples in the selected job is shown. 

  

To create a new job select the New... button in the Job menu.
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Whenever a new job is created, a window will pop up to edit the name and other 
information for the new job.  

 

As default entries for the new job the settings of the job selected before will be 
used as template.  
Change the Name of Job to the desired new name. 

In addition to the Name of Job and Description, further information can be edited.  
This additional information might be the address of a customer (especially if only 
samples for a specific customer are stored in a specific job) and a comment. If you 
select the coversheet option in the print options dialogue the coversheet will 
contain this information. 

Confirm the settings of the new job by selecting the OK button. 
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14 The Recycle Bin 
An additional feature in X-LabPro is the Recycle Bin.  
It allows to "undelete" samples, which were erased 
before. 

  

 
If a sample is deleted, it will not be erased completely. Instead of erasing, the 
sample is moved into a special job - the Recycle Bin. 

If the deleting was made by mistake, the sample can be moved back to its orignal 
place, where it was stored before deleting. 

This only works, if the respective method still exists! 

 

15 Configuration Editor 
The Configuration Editor can be used to edit a lot of parameters of X-Labpro.  
Several of them describe SPECTRO inhouse instrument details and therefore they 
are write-protected. 

 

  

15.1 User Management 
To restrict the access on data and methods by unauthorized persons, it is possible 
to equip the software with a login procedure. 

The user names, user rights and passwords are handled by the User 
Management, which can be entered in the Configuration Editor by Users and 
Passwords.  
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Up to 16 users with individual authorization levels are possible. The limitations of 
the different  user levels are listed at the end of this page. 

With the Properties... button it is possible to change the settings for an existing 
user. 

New users are inserted by using the Add... button. Then the Login Name, the 
Name  (not necessary) and the Password can be edited. The password has to be 
confirmed by retyping under Retype Password. Finally the User Level has to be 
assigned.  

Non-supervisors have no access to the User Management. 

 

The limitations of the different user levels: 
A maximum of 16 users can be subordinated with the following user levels: 

Routine User The Routine User has only access to the Routine Dialog and not to 
the main program. This is the lowest user level  

Level 3 User The Level 3 User has only access to the Routine window. He can 
create new samples, make measurements and analyze samples, 
but cannot delete them. For this user level a password can be fixed 
but it isn´t necessary. 

Level 2 User Additionally to the possibilities of the Level 3 user, the Level 2 User 
also has access to the job and the spectra window. He has the 
possibility to delete samples and to print results in form of reports. 

Level 1 User The Level 1 user has access to all windows. But in the method 
window he can only edit non-protected samples or the ones he 
created himself. 
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Supervisor The Supervisor has access to all windows and all options and 
functions. Only methods delivered from SPECTRO can´t be edited.

 

15.2 Definition of Foils 
At the general tab in the method window several foils can be selected; the first film 
for the sample cup (for liquids or powders) and a second film to protect the 
instrument. 

The place to define these foils is the Configuration Editor: 

 

A new type can be added. Existing foils can be deleted or modified: 
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15.3 Definition of Bonds 

The use of bonds (e.g. as printout option) can be enabled at the method tabs 
General and Output. 

At the general tab in the method window Bonds can be selected or defined to 
describe the kind of sample: 
If the calculation of concentrations will be done using Fundamental Parameters it 
can be helpfull/necessary to "tell" the software the chemical state of the elements 
in the samples: pure elements, oxides, ... 
This selection has a big influence on the calculation and its results. Therefore, it is 
important! 

At the Output tab in the method window the option Bond is used to define a factor 
for the presentation of results. Modifications in these bonds will have no influence 
on the mathematical part: It is only a factor, which is used to calculate the bond, 
based on the calculatd element concentration. 

But, at both tabs (General and Output) only a pre-defined type of bonds can be 
selected.  
The place to define these bonds and classes of bonds is the Configuration Editor: 

The icon Bonds gets access to the Bond Classes: 

 

New classes can be added, existing types of bonds can be deleted or modified. 
To modifiy them, use the Edit button right to each line: 

At this screen a new kind of bond can be defined or an existing one can be 
modified. 

To create a new class, decide between starting with an empty class or a copy of 
an old class. 
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15.4 Definition of Recalibration Samples and Methods 
At the General tab in the method window it can be defined, if a method is an 
analytical one or a special one for recalibration. 
If a method is designed as recalibration method it can be used for Global 
recalibration, Method recalibration, Intercept recalibration or for the Energy-
Channel recalibration (MCA). 

For each of the named methods/procedures a card exists to define the details: 

 

For both MCA-recalibrations an automatic start of the measurements can be 
defined. 
Therefore, an additional icon Edit Time can be found on the card: 
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15.5  Definition of Samples 
At the General tab in the method window Sample Type and Sample State are 
important details to describe a sample. Using the General tab, these parameters 
are defined as the template for all future samples. 

In the list of standards the Sample Type and Sample State can be edited for each 
sample individually. This can be done, using either the right mouse button and 
selecting Edit... or by selecting Adopt Defaults from the Method menu. 

The available types/states are pre-defined in the Configuration Editor. Click on the 
icon Samples to get access to the following screen: 
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A new Sample State/Sample Type can be inserted or edited/deleted (see below): 
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16 General 
This tab is the main tab in the method window. It allows to edit the most important 
parameters of a method: 

 

The parameters in this screen are: 

Global Settings: 
In this section some global settings can be defined, like name of the method or 
sample state. 
One of the most important parameters is called Mathematics. It describes the 
mathematical procedure used for calibration and evaluation. 
The parameter Option is used to define, whether a method will be used as an 
analytical method (Standard) or for recalibrations (e.g. MCA). 

Dilution: 
It describes the default settings for a new sample, which will be created during 
routine use of this method. 
The dilution material and the masses defined here will be used later. 

Additional Settings: 
This section contains the diameter of the sample, information about foils and the 
standard for comparison. 

Normalization: 
Here, the different possible normalization options can be selected: 
- Normalize results: The results will be normalized e.g. to 100%. 
- MSK: The Mass Attenuation Coefficient is used to calculate the "non-visible part" 
(elements with atomic number < 10) of the sample. 
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  Accordingly, the results can be normalized to the "visible part". 
- Difference element: This can be used to tell the mathematical procedure, what's 
the "non-visible" part of the sample.This can be e.g. CH2 for an oil sample, H2O 
for a water sample or Oxygen for a slag... 

  

16.1 Recalibration 
An existing calibration is based on the relation between a known concentration 
and a measured count rate. Whenever this count rate is changing with time, it is 
necessary to either calibrate the instrument again or to recalibrate it. The number 
of standards to run a recalibration is much less than for an initial calibration. 

A recalibration is necessary, if the count rates change or if the excitation geometry 
of the instrument was modified. During a recalibration the ratio of the original count 
rates (at the moment of the calibration) to the actual count rates are calculated. 
This ratio is used as a correction factor for the original calibration. 

Recently measured count rates are multiplied by the correction factor and then the 
old calibration curves can be used. The X-LabPro software supports three different 
kinds of correction factors: 
·        target correction factors 
·        global correction factors 
·        method correction factors 

If the correction factor for all elements, analyzed with a specific target, is the same, 
a target correction factor is used. If the difference between the correction factors is 
too large, an individual global correction factor for each element has to be used. 
Global and target correction factors affect all methods, so if only a specific method 
should be recalibrated, method correction factors must be used. 

A recalibration is automatically in use from the instant of running it. With the 
exception of target correction factors, the correction factors are even used, when 
old measurements are reevaluated.  

Two different recalibration procedures exist. 
·        Global recalibration  
·        Method recalibration  

The global recalibration can be used to correct influences that are affecting all 
methods in the same way. This includes a drift correction due to aging of 
components (e.g. x-ray tube, detection system) or changes in the geometry or 
excitation conditions (e.g. changed protection film material). 

The method recalibration is only affecting the selected method and therefore has a 
completely different application. The method recalibration should be used when 
the modification of the geometry is only affecting a specific method. This can be a 
modified purge gas (nitrogen instead of helium) or a different foil for the 
preparation of cuvettes. 

For both types of recalibration the software offers special routines to simplify these 
procedures. They can be adjusted in the Configuration Editor. 
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16.2 Global Recalibration 

To correct for global effects that are affecting all methods in the same way the 
global recalibration must be used. The easiest way to do this is to use a special 
set of glass beads. The method containing the glass samples is typically called 
Global. 

To do the Global Recalibration select Prepare Global Recalibration from the menu 
Recalibration.  

 

The recalibration procedure starts by selecting the Start button. 

After the measurements and evaluations are finished, the software automatically 
calculates the correction factors.  
These are written in the instrument configuration file. Additionally, the results of the 
recalibration are stored in a text file named "GlobalRecalibration.txt" in the 
directory C:\Xlabpro\LogFiles.  

The calculated correction may be the target correction factors or element specific 
global correction factors.  
Both are stored in the configuration file of the instrument, but at different places. 
Target correction factors can be found in the configuration editor under 
Targets/Filter,  
while the global correction factors are strored under Global Corrections. 
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To view the target correction factors, the appropriate target has to be selected 
and then the Display button has to be used.  
An alternative way is to double click on the desired target. 
The target correction factor is named Intensity Correction Factor. 
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The global correction factors can be shown for each of the installed targets of an 
instrument by selecting "Global corrections" in the configuration editor. After 
selecting a target, the correction factors are shown in the table. 

 

 

16.3 Method Recalibration 
In comparison to the global recalibration, that is used to correct influences 
affecting all methods in a similar way,  
the Method Recalibration is used to adjust a specific method without affecting the 
other methods.  
This can be necessary, when the measurement conditions of a method have been 
changed (e.g. if a different purge gas or protection foil are used). 

To do the Method Recalibration select minimum one sample from the method as 
recalibration sample.  
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Define the elements, which you want to use from this sample by marking the tick 
box for Std. at the given concentrations of this sample. 
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In the routine dialog select the Prepare Method Recalibration from the menu 
Recalibration.  
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The recalibration procedure is started by selecting the Start button. 

After the measurements and evaluations are finished, the software automatically 
calculates correction factors.  Additionally, the results of the recalibration are 
stored in a text file named "MethodRecalibration.txt" in the directory 
C:\Xlabpro\LogFiles. Please note that the according method needs to be closed 
during evaluation progress! 
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The correction factors are automatically stored in the method. To check or adjust 
them manually, the Method Administration must be selected in the sub-module 
Elements. In the last column one can find the correction factors (Corr.factor).  

  

 

16.4 Intercept Recalibration 
A special kind of recalibration can be used, if analysis very close to detection limit 
will be done.  
This Intercept Recalibration is especially created for the Low-Sulfur-Application. 
Running this, recalibration the offset of the Sulfur calibration will be recalculated to 
adjust the instrument after a long time of using. 

To do the Intercept Recalibration select minimum one sample from the method as 
recalibration sample.  
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Define the element(s), which you want to use from this sample by clicking the 
ticking the tick box for Std. at the given concentrations of this sample. 

 

 
To do the Intercept Recalibration the recalibration sample(s) have to be in the 
defined positions of the sample plate.  
Select the Prepare Intercept Recalibration from the menu Recalibration.  

Please note that the respective method needs to be closed during evaluation 
progress! 
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The recalibration procedure is started by selecting the Start button. 

 

After the measurements and evaluations are finished, the software calculates 
automatically the new offset.  
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The offset is automatically stored in the method. To check or adjust it manually the 
method must be selected in the sub-module Calibration of the Method 
Administration module. 
After selecting the tab Parameters the offset is displayed as the first parameter, 
called "Offset" (in this example 4.0035).  

   

 
 
 
 
 

16.5 Run MCA Calibration  
The energy channel calibration, also known as MCA (Multi Channel Analyzer) 
calibration should be performed once a week.  

The first MCA calibration is done in Kleve measuring a glass bead and calculating 
several parameters. 

To check this calibration (once a week), this glass bead has to be measured 
again.  
To do this, select the Prepare MCA Calibration (glas tablet) from the menu 
Recalibration:  
A sample with a new extension is created, automatically. 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 188 of 391 
 
 



                     
 

X-LabPro  5  
 

   

To start the MCA calibration, select the Start button (with enabled Evaluation box 
right hand of the Start button).  

To configure it, use the Configuration Editor. 

This MCA can also be used in combination with a Global Recalibration. 

 

16.6 Standards 
The method comprises the calibration standards. These can be edited at the tab 
Standards. 
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It contains different columns which can be used to change the order of 
presentation. 

Using the right mouse button a context menu gives 
access to all important functions regarding standard 
samples.  
One of them is the given concentrations, which are 
necessary for calibration.  
Especially for the non-empirical procedures like 
Fundamental Parameter Models or Spectro 
procedure, it is important to tell the software all 
available informations, because these mathematical 
procedures require a 100%-knowledge. 
E.g. we cannot determine Oxygen. But, if you know, 
that elements in a sample are bonded as oxides,  
you should edit the Oxygen concentration - 
independent from the fact, that it will not be 
calibrated. 
In addition some shortcuts are introduced like "Show 
Spectra...". Without using the clipboard the selected 
sample will be copied into the Spectra Viewer. 
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Given Concentrations: 

 

This window is to define the given concentrations - the goal of the calibration. 
As mentioned before, it can be necessary for FPM to describe the sample 100 % 
(if all these concentrations are of interest or not!). 

The first details, which should fit to the sample and its given concentrations should 
be the Typical Unit. 
This should be the right one before entering concentrations. It can be changed at 
each time, but BEFORE entering a number. Changes of the unit afterwards will 
have no influence to "old" concentrations. 

To make it more comfortable, if bonds like Oxides are to define, the feature 
"Bonds" can be used. A sum is counting all defined concentrations as additional 
control option. 

In the list in the lower part of this screen all elements ALL elements - (independent 
from selections) are visible. A concentration, the error of this concentration and the 
level of cerification can be defined. 
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The last 5 columns are not really important, because there's another location to 
get access to the informations stored here. 

Dilution Material: 
If the sample should be a new Dilution material, that can be selected for new 
routine samples, this should be selected. 

 

Std-. Lib.: 
The Standard-Library (or Library of Standards) is a tool to 
accelerate the definition of the given concentrations, if a well-
known, certified standard is used:  
Many of these Certified Reference Materials (CRM) are pre-
defined in the Library of Standards and own standards can be 
added. 
To use the stored data or to add the actual sample into this library, 
these buttons can be used. 
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17  Data Storage 
The User of the Spectro X-LabPro software is fully responsible for data storage and 
backup copies!!! 

We - as SPECTRO - have prepared a backup of your instrument specific data 
before shipment of the instrument, but we are not able to store / to archive the 
data you have measured after delivery / installation. 

Therefore, it is your responsibility to assure a regular data storage. 
We suggest to copy the complete c:\xlabpro directory to a CD. 
If you need to restore your data, please do not hesitate to contact 
us for details on how to restore.                     

In addition to such a complete backup, there are different storage options:  

The software offers tools to export measurements, methods or jobs from the 
database structure to allow data storage and data transmission. 

The motivation to store methods, jobs and samples is quite different: 
·     Methods do not change very often so the main motivation is to get some 
backup copies. 
·     If a new method will not work properly and will need some assistance from us, 
the method can be transmitted to us. 
·     A new method was developed on another computer. After finishing the 
calibration, it can be copied to the instrument computer. 

      Export Methods                     Import Methods                               

·     Jobs contain the routine measurements and here the archiving is the main 
reason. 

      Export Jobs                            Import Jobs                                      
        

·     Single samples are exported to make them available to other users (e.g. 
SPECTRO). 

      Export Samples                      Import Samples                                
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18  Import/Export 

18.1 Export Methods  
Methods are stored from the sub-module Method Development. At first, the 
method to store should be selected. In the pull-down menu Method is a function 
called Export Method...  

   

This function opens a box to select the directory for the data storage. To change 
the directory double-click on the corresponding drive or directory.  

The name of the method is used automatically as name of this new subdirectory. 
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If the method was stored before (the directory still exists ), a message will inform 
you before overwriting the old export files. 

The progress of storing (e.g. the just stored sample) is shown on the screen and  
at the end of the archiving a message box is shown.  

 

 

 

 

 

 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 195 of 391 
 
 



                     
 

X-LabPro  5  
 
18.2 Import Methods  

In the X-LabPro software only the methods in the database structure can be used. 
Therefore, methods can be exported (for data storage or to transfer methods to 
other computers) and imported.  

To load a method into the database the sub-module Method Administration has to 
be selected. In the pull-down menu Method is a function Import Method... to load a 
method.  

 

In the following selection box the method archive file (with the extension .mar if 
using software version 2.5 or older) of the specific method has to be selected.  
This method archive file is generated automatically when a method is stored. It 
contains a list of all samples that are part of this method. Without this .mar file, the 
method can not be restored.  

In the line above the selection field, the just selected directory is shown.  
To change this directory, a double-click on the target directory is necessary.  
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When the directory is selected, only the methodname.mar file will be shown. 
This file should be selected and the selection confirmed by OK.  

In the next window the name for the method can be modified. The default name is 
the old name of the method.  
The software needs unique method names: If the name of the method already 
exists, please rename the new method. 

 

After the confirmation or modification of the Method Name, the files will be loaded.  
The progress of this task is shown in a message box.  

 

The end of the restoring procedure is displayed in a message box.  
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18.3 Export Jobs 

Jobs are stored from the submodule Job Manager. The job to store must be 
selected and then the function Export... from the pull-down menu Job must be 
activated. 

 
 

A selection box opens to choose the target directory. The software is automatically 
creating a subdirectory, so only the directory to store all jobs should be selected. 
The default setting is the archive subdirectory in the program directory (X-LabPro). 

The selected directory is shown above the selection window. To change the 
directory, double-click on the corresponding drive or directory.  
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The selection of a specific directory is confirmed by clicking on the OK button. The 
completed storage is indicated by a message box. 
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18.4 Import Jobs 

To reload archived jobs, the function Import... from the pull-down menu Job must 
be selected. 

 

The following selection box shows the subdirectory where the samples are 
archived. If the directory is correct, this path has to be confirmed. 
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After selecting a Job, there's the possiblity to change the name of the re-imported 
job. 

 

A message box shows the end of the restoring process. 

 

The samples are restored automatically. It is essential that the Method that was 
used for the samples still exists. 

 
 

18.5 Export Samples  
Sometimes it is necessary to export single samples instead of entire methods or 
jobs; e.g. to transfer them to another computer or to transmit them to Spectro or 
just to store them. In addition to the Store Job and Store Method functions the 
software offers the Export (Standard) Samples... function in the submodules Job 
Manager and Method Administration.  

The samples must be selected. To export the selected samples the function 
Export (Standard) Samples... from the pull-down menu Job (or Method) has to be 
selected.  
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In the following box the sub-directory for the stored samples can be selected.  
The default sub-directory for exporting samples is Xlabpro\Archive. After the first 
data exchange, the last used directory will be the default for the next action. 
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18.6 Import Samples  
Samples can be imported into the database structure even without being part of a 
stored Job or Method. It is possible to load samples into Jobs or Methods by quite 
similar procedures.  

At first the method (or job) in which the samples should be imported must be 
selected.  
The following example is demonstrating the import of samples as standards to an 
existing method.  

In the pull-down menu Edit the function Import (Standard) Samples... must be 
selected.  

 

After selecting the directory, a sample (or samples) can be selected. 
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When samples are imported it is necessary to select the dilution material (if 
necessary) for the samples.  

 

18.7 Protocol File for Recalibrations 
During a Global Recalibration a protocol file is created. This allows to check 
whether the recalibration was successful and logical! 

Hints to control the calculated factors: 

 The factors should be around 1.000. Please check, if the range of these 
factors is between 0.90 and 1.10 (that means 10 % difference to 1.000) and 
no factor like 1,234.5 is calculated (because a wrong sample was used...). 

 The run of the curve of the factors against the atomic numbers should be 
controlled, whether jumps or discontinuities occur. The only known 
discontinuity is for the HOPG target between the elements Chlorine and 
Potassium. 

 The heavier the neighbouring elements the smaller is the difference of their 
factors. Especially for elements heavier than Iron (Atomic Number > 26), 
there is very often only one factor for the whole sub-measurement (Target). 
For each target the average and the standard deviation for all factors are 
calculated at the end of the summary. 
If the standard deviation for the Average Target Value is small enough, one 
"Target-factor" is used instead of individual factors. 

 In the following, a part of this document is shown: 
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Spectro Midex Easy GUI 
20 How to start 

To start the X-LabPro Easy Routine Dialog right-click on the Communication 
Server symbol. In the upcoming menu select Easy Routine Dialog. 

 

 

       Figure 1: Using the ComServer 
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21 Starting up 

21.1 Log in 
When the Easy Routine dialog starts up, first you have to provide your login and 
password. 

 

       Figure 2: Log in 
 
 
  
 

21.2 Standby mode 
As next you are asked whether to go into standby mode. If you do not want to go 
into standby mode right now, you can switch it on later by using the Standby 
button. 
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22 Using Easy Routine 

22.1 Introducing the dialog 
When the start up procedure is finished the dialog will look like in Figure 3. 

 

 

       Figure 3: Easy Routine Dialog 
 

In the upper part of the main dialog you can see the Parameter Bar stating the 
actual measurement parameters. While measuring, the bar will be updated 
continually. 

Right next to the Parameter Bar is the Close Button. 

On both sides of the dialog are several Function Buttons. 

Below the buttons are three State Icons. 

In the center you can see the Sample View. The Sample View is shown by default 
on start up. By using the buttons below the center view you can switch between 
Sample View, Spectrum View and Video. 

While measuring the Spectrum View shows the measured spectrum. 

After a measurement is completed the Sample View shows the analysis results. 

Video shows a live picture of the measured sample to adjust the manual sample 
table. 
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22.1.1 Sample view 

 

       Figure 4: Sample View 
 

The Sample View contains all needed controls to prepare a measurement. 

In the first four rows you can edit the sample name and select the method class, 
method and job. 

Below is the Result List where the measurement results are shown. After 
performing a Validation the list contains an additional row with the validation result. 

The progress controls show the remaining measurement time; separated into 

 Sample time: the time remaining for measuring the current sample. 

 Plate time: the time remaining for the complete measuring process 
( incl. time for preparing a measurement with gas flush or vacuum). 

The two buttons below let you switch between Sample View and Spectrum View. 
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22.1.2 Selecting a Method class 

Press the Select button next to the edit field. A dialog ( Figure 5 ) opens and you 
can select the desired method class. 

22.1.3 Selecting a Method 
Press the Select button next to the edit field. A dialog ( Figure 5 ) opens and you 
can select the desired method. 

The dialog only shows methods which are in the current method class. 

 

       Figure 5: Select dialog 
 

22.1.3.1 Selecting a Job 
At start up the job is preset according to the setting from the Configuration Editor. 

To select a different job press the Select button next to the edit field. A dialog  
( Figure 5 ) opens and you can select the desired job. 
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22.1.3.2 Editing a Job 
To edit the job press the Edit button next to the edit field. A Virtual Keyboard  
( Figure 6 ) appears. Type in the new job and press OK to accept it. 

 

22.1.3.3 Editing the sample name 
At start up the sample name is preset with 'NewSample'. 

To edit the sample name press the Edit button next to the edit field. A Virtual 
Keyboard  ( Figure 6 ) appears. Type in the new sample name and press OK to 
accept it. 

 

22.1.3.4 Pasting a sample 
Click here, to paste a sample from the Job Manager into Easy Routine Dialog. 

It is not possible to paste a standard. For pasting standards, please use the 
Routine Dialog. Further on, the method to which the sample belongs must not be 
hidden or finalized. 

It is possible to resume the measurement of a not completely measured sample. 
For example: if your sample contains 6 measurements and 5 of these are already 
measured, you can paste the sample and start measuring the last one. 

It is not possible to paste a completely measured sample. 
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22.1.3.5 Using the virtual keyboard 

 

       Figure 6: Virtual keyboard 
 

The Virtual Keyboard can be used like a normal keyboard. Shift and Caps Lock 
work in the expected way. Selecting characters with Shift is not possible. 

To move the cursor in the edit field use the Arrow buttons left to the edit field. 

To delete the character left to the cursor use the Delete button on the right side of 
the edit field. 

Press OK to accept the name or Cancel to close the dialog. 
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22.1.4 Spectrum view 

 

       Figure 7: Spectrum View  
 

During a measurement the Spectrum View displays the currently measured 
spectrum. 

The Spectrum View can be enabled / disabled in the Settings dialog. 
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22.1.5 Close Button 

 

       Figure 8: Close button  
 

Clicking the Close button exits the Easy Routine Dialog. You will have to confirm 
exiting. If the high voltage is switched on, it will be powered down before the dialog 
is closed. 

 

22.2 Function Buttons 

22.2.1.1 Start 

 

       Figure 9: Start button 
 

The Start button is active only when no measurement is performed. 

Clicking the Start button starts a new measurement. 

It will change into the Stop button while measuring. 

 

22.2.1.2 Stop 

 

       Figure 10: Stop button 
 

The Stop button appears only during measurements. 

Clicking the Stop button stops the actual measurement. The high voltage will stay 
switched on. When the measurement is stopped, the Start button is shown again. 
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22.2.1.3 Off 

 

       Figure 11: Off  button 
 

The Off button is active only when the x-ray tube is on. 

Clicking the Off button ends the Standby mode. 

 

 

 

22.2.1.4 Standby 

 

       Figure 12: Standby button 
 

The Standby button is active only when the x-ray tube is off. 

Clicking the Standby button switches the instrument into Standby mode. 

 

22.2.1.5 Settings 

 

       Figure 13: Settings button 
 

The Settings button is active only when no measurement is performed. 

Clicking the Settings button opens the Settings dialog ( see chapter Settings 
dialog for more details ). 
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22.2.1.6 Recalibration 

 

       Figure 14: Recalibration button 
 

The Recalibration button is active only when no measurement is performed. 

Clicking the Recalibration button opens the Recalibration dialog ( see chapter 
Recalibration dialog for more details ). 

 
 

 

 

22.2.1.7 Validate 

 

       Figure 15: Validate button 
 

The Validate button is active only when no measurement is performed. 

Clicking the Validate button to prepare a validation. In the upcoming dialog you 
have to select which method contains the needed Validation Sample. After 
successfully selecting the method, click Start to perform the validation. 

 

22.2.1.8 Print 

 

       Figure 16: Print button 
 

The Print button is active only when no measurement is performed. 

Clicking the Print button will print the actual measurement results directly to the 
default printer. When no results are present nothing is printed. 
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22.2.2 Set Video 

  

        Figure 17: Set Video button 
 

The Set Video button helps to adjust different parameters of the video display 
(Brightness, Contrast, Hue, Saturation), of the crosshair (X-Pos, Y-Pos, Size) and 
light and laser intensity: 

 

 

       Figure 18: Set Video button 
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22.2.3 Light 

 

   

  Figure 19: Light button 

With the Light button the light can be switched on and off. 

22.2.4 Laser 

   

  Figure 20: Laser button 
 

With the Laser button the laser can be switched on and off. 

 

 

22.2.5 Parameter Bar 

 

       Figure 21: Parameter Bar 
 

The Parameter bar states the actual measurement parameters: 

• the part measurement of the actual sample. 

• the gas flow in liters per hour. 

• the voltage in kilovolts. 

• the current in milliampere. 

• the maximum measurement time for the part measurement of the sample in 
seconds. 

• the measurement time for the part measurement of the sample in seconds. 
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22.2.6 State Icons 
The State icons reflect the actual instrument state. Therefore each icon has two 
different states. 

 

22.2.6.1 Lock/Unlock 

 

       Figure 22: Sample chamber locked 
 

The sample chamber is locked. 

 

 

       Figure 23: Sample chamber accessible 
 

The sample chamber is accessible. 

 

22.2.6.2 X-Ray on/off 

 

       Figure 24: X-Ray on 
 

The x-ray tube is switched on. 
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       Figure 25: X-Ray off 
 
The x-ray tube is switched off. 
 
 

22.2.7 Settings dialog 

 

       Figure 26: Settings dialog 
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The Settings dialog lets you configure some parts of the Easy Routine dialog. 

• enable / disable the Spectrum view. 

• enable / disable printing directly after evaluation of the measurement. 

• enable / disable Full screen mode. The Full screen mode is suitable only 
when a touch screen monitor is used because in Full screen mode the 
mouse pointer is hidden. 

• enable / disable the question for an inserted protection foil. 

 

22.2.8 Recalibration dialog 

 

       Figure 27: Recalibration dialog 
 

With the Recalibration dialog you can prepare the instrument calibration. 

Click one of the Recalibration method buttons to prepare the recalibration. 

For information about the different calibration methods click the Help button next to 
the Recalibration method button. 
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22.3 Recalibration 
In this chapter the application flow of the different recalibration methods is 
explained. 

For information about the different calibration methods open Recalibration dialog 
and click the Help button next to the Recalibration method you are interested in. 

 

22.3.1 MCA 
To perform a MCA Recalibration, open the Recalibration dialog and click the 
MCA button. The recalibration is then prepared. If the actual method does not 
contain any MCA sample you will be noticed. 

If a MCA sample was found, the Easy Routine Dialog then switches into 
Recalibration Mode: only the Start button and the New Sample button are active. 
To perform the recalibration click Start. To cancel the recalibration click New 
Sample. 

When the recalibration is complete the results are shown in the Result List. The 
Easy Routine Dialog switches back to Normal Mode. 

 

22.3.2 Global 
To perform a Global Recalibration, open the Recalibration dialog and click the 
Global Recalibration button. The recalibration is then prepared. If the actual 
method does not contain any Global sample you will be noticed. 

If a Global sample was found, the Easy Routine Dialog then switches into 
Recalibration Mode: only the Start button and the New Sample button are active. 
To perform the recalibration click Start. To cancel the recalibration click New 
Sample. 

Depending on the settings in the Configuration Editor the Global Recalibration 
is performed with one or more samples. 

If more than one sample is calibrated, a message box advises you when to insert 
the next sample into the Sample Chamber. 
When the recalibration is complete the results are shown in the Result List. If more 
than one sample was measured,  the results are only written to file and nothing will 
be shown in the Result List. The Easy Routine Dialog switches back to Normal 
Mode. 

 
 



                     
 

X-LabPro  5  
 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 225 of 391 
 
 

22.3.3 Intercept 
To perform a Intercept Recalibration, open the Recalibration dialog and click the 
Intercept Recalibration button. A Select Dialog opens and you can choose a 
method for calibration. The method must contain an Intercept Sample. After 
successfully selecting a method, the recalibration is then prepared. 

The Easy Routine Dialog then switches into Recalibration Mode: only the Start 
button and the New Sample button are active. To perform the recalibration click 
Start. To cancel the recalibration click New Sample. 

Depending on the settings in the Method Configuration the Intercept 
Recalibration is performed with one or more samples. 

If more than one sample is calibrated, a message box advises you when to insert 
the next sample into the Sample Chamber. 
When the recalibration is complete the results are shown in the Result List. If more 
than one sample was measured,  the results are only written to file and nothing will 
be shown in the Result List. The Easy Routine Dialog switches back to Normal 
Mode. 

 

22.3.4 Method 
To perform a Method Recalibration, open the Recalibration dialog and click the 
Method Recalibration button. A Select Dialog opens and you can choose a method 
for calibration. The method must contain a Method Sample. After successfully 
selecting a method, the recalibration is then prepared. 

The Easy Routine Dialog then switches into Recalibration Mode: only the Start 
button and the New Sample button are active. To perform the recalibration click 
Start. To cancel the recalibration click New Sample. 

When the recalibration is complete the results are shown in the Result List. In an 
additional column in the Result List the recalibration factors are shown. 

The Easy Routine Dialog switches back to Normal Mode. 
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22.4 Validation 
In this chapter the application flow of the validation is explained. 

To perform a Validation, click the Validation button. A Select Dialog opens and 
you can choose a method for validation. The method must contain a Validation 
Sample against which the new sample is validated. After successfully selecting a 
method, the Validation is then started. 

When the Validation is complete the results are shown in the Result List. In an 
additional column in the Result List the validation result is shown: 

• a  marks a valid result, the measured concentration was within limits. 

• a  marks an invalid result, the measured concentration was out of range. 

The Easy Routine Dialog switches back to Normal Mode. 
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SPECTRO MIDEX Tutorials 
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23 About this Manual 
This manual describes the operation of a MIDEX device. Unlike the older versions 
of the MIDEX device the new version does not use the common X-LabPro Routine 
Dialog for setup and operation. All options and controls appear as the user needs 
them, not before. This makes it easy to get started using the Spectro MIDEX. Even 
complex scan scenarios can be configured fast and clear. 

Conventions 
Throughout this document, a set of typographical conventions is used to define 
elements and references to the application items. Familiarity with these 
conventions will help your understanding of the topics covered. 

 

Colored 
Text 

Identifies a text you will find in the current dialog, view or application 
(e.g. title of a dialog box or the entries of a combo box). 

 This symbol is used for a Note, for general instructions and advices. 

 
This symbol is used for a Tip, for special instructions for optimal use of 
the system.  

 
This symbol is used for a Warning (instructions to avoid dangerous 
situations). 

  
 

 

 

24 Getting started 

24.1 Application Requirements 

24.1.1 Starting the Application 
The Routine Dialog is started through the X-LabPro Com server application running 
in the system tray: 

 

 

Right click the icon to open the X-LabPro application launcher (Com Server) and 
choose the menu item MIDEX – Routine Dialog. This will launch the application 
and require authorization as first step. 

It is possible to create a shortcut to the application on the desktop. Right click on 
the desktop and select Create shortcut.  Choose 
C:\XLabPro\Bin32\XLRoutineDlgMII.exe as target path. Then enter Routine 
Dialog Midex II as shortcut name. 
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24.1.2 Shutting down the Application 

When the Routine Dialog is running the application can be closed like any typical 
window using the  button in the top right corner of the main application 
window. Another option is to use the main menu of the application (Routine  
Exit) or the windows taskbar (right click on the window item and select close). The 
application will shut down the device if necessary which can take some time. 
Review the measurement parameters bar for the shutdown status. 

 

 
Never, under any circumstances use the windows task manager to 
terminate the application process! The high voltage of the device 
would not be shut down properly. 

 

 

In case of an abnormal termination of the application process start the 
application again. The MIDEX Routine Dialog will detect the device 
state after launch and shut down the high voltage of the device if 
needed. 
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24.2 Quick Scan Guide 
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WWeellccoommee  PPaaggee  

- (Configure the application) 
- Click start to begin the configuration 

SSttaaggee SSeettuupp PPaaggee

- Put the sample onto the sample 
stage  
  and move it to the center crosshair 
- Move the stage up until the 
maximum   
  position is reached (2mm below roof) 

Click Start 

- Lock the Z-Position 

Click Next 

PPrreevviieeww SSccaann PPaaggee ((RRaasstteerr))  

- Select segments for preview 
- Click Scan selected 
- Wait for the scan to finish 

PPrreevviieeww  SSccaann  PPaaggee  ((PPnnSS))

- Click onto the area to scan  
- In the live video click on the center  
  spot for exact positioning  
- Click on Capture to accept Switch between Modes 

Click Next Click Next 

SSccaann SSeettuupp  PPaaggee  

- Choose Mode (Mapping, Linescan or Pointscan) 
- Add one or more Scans (Add button on toolbar and click on 
preview)  
- Select method class 
- Choose a Method for each scan (if necessary) and edit the scan 
duration for each spot 
 
Note: Only the scans on the active tab (Mapping, Linescan, 
Pointscan) will be executed during scan 
 

Click Next 

VVeerriiffyy  SSeettuupp PPaaggee

- Review scan setup 
- Choose evaluation mode 

Click Start 
This is where the scanning starts! 

SSccaann  PPrrooggrreessss  PPaaggee

- Relax and watch the scan being  
  executed automatically 

SScan Results Pacan Results Paggee

- Review the scan results 
- Select color maps view or 
- Select threshold colors view or 
- Select threshold mix view or 

Switches automatically 
when finished - Select Spectrum/List (for Pointscans) 

Congratulations! 
Your scan is done! 
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25 Routine Dialog 
The Routine Dialog for the Midex was developed to simplify the scan process. It 
will assist the user from the beginning at setting up a scan and supports all 
required actions at the moment they are needed.    

25.1 Wizard Style 
The user interface of the MIDEX Routine Dialog implements a wizard style 
workflow. The user is directed through the device setup, scan configuration and 
scan processes step by step  

The process of setting up a scan, scanning and reviewing results can be done in 
some very easy steps: 

 Place the sample onto the stage inside the test chamber 

 Move the sample into the center of the camera (using live video) 

 Move the sample to the highest possible position and lock it (protects the 
sample from damaging the detection system) 

 Capture a preview image of the sample (combining one or more camera 
images) 

 Select the spots to scan on the preview image  

 Multiple spots, rectangular  =  Mapping or 

 Multiple spots, linear  =  Linescan or 

 Single spots   =  Pointscan 

 Select scan method and scan duration 

 Start the scan (executes automatically, shows progress) 

 Review the scan results (multiple result presentations available) 

 

25.2 Integration into X-LabPro 5 
The MIDEX Routine Dialog is one component of X-LabPro 5.0. 

X-LabPro 5.0 consists of several components used to configure and manage the 
device and the scan methods, to execute evaluations and to review scan results. 

The following table lists all components of X-LabPro 5.0 for use with the MIDEX 
device. For detailed information or help on the component please consult its 
Online Help: 

Method 
Administration 

The Method Administration is used to manage and develop 
scan methods. Methods listed here can be used for scanning 
using the MIDEX Routine Dialog. See chapter  “Method 
class and method selection” for more information 
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Job Manager  The Job Manager combines multiple Pointscans to 
jobs. MIDEX Routine Dialog supports jobs only for 
Pointscans. Mappings  
 and Linescans use their own archive file format. See 
chapter  
 “Setup Pointscans” for more information on jobs. 

Spectra Viewer  The Spectra Viewer displays results of scans either as  
 spectra, for Mappings and Linescans also as color 
maps  
 or threshold maps. 

Configuration Editor  The Configuration Editor manages all settings of the   
 X-LabPro application and the device. 

Library of Atomic 
Data 

 This library contains all atomic data for use within the  
 evaluation process.  

 

25.3 Login and Authorization 
After starting the application it requires to authorize with X-LabPro 5.0. If there is 
already a component of X-LabPro authorized and running, the credentials of that 
component will be used and no further login is required. 

The Log-In dialog will be shown as follows: 

 

 

 

 

 

 

 

 

User accounts and passwords can be created and edited using the Configuration 
Editor.  

Enter a username and password and click on OK to authorize. If the authorization 
succeeds, the login dialog disappears and the initialization sequence of MIDEX 
Routine Dialog continues. 

If the login details are not correct a message is shown. Click OK and try again. 
Username and password fields are not case sensitive. 
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If you click on Cancel the authorization process will be aborted. In this case the 
MIDEX Routine Dialog will be closed and the application will shut down.  

 

 MIDEX Routine Dialog cannot be used without authorization! 

 

25.4 Connecting to the Device 
After authorizing the application attempts to connect to the MIDEX device 
connected to your computer. If the system is set up to run in simulation mode a 
connection will only be simulated (see Chapter 4.2.3 Simulation Mode).  

The status of the connection process will be shown in the device control log 
window (see Chapter 4.3.6 Device Control Log Window). This window is part of 
the main application window and will automatically pop up until the initialization 
process finished. 

 

 

 

 

 

 

 

The interface provides a status icon to verify a device was successfully connected 
and initialized. This status icon is described below in Chapter 4.2.2 Testing the 
connection. 

 

25.4.1 Connection Setup 
To setup a connection the device must be connected to the computer running the 
MIDEX Routine Dialog application. The connection options can be edited using the 
Configuration Editor. Please consult the Configuration Editor Online Help for 
more information.  

 

25.4.2 Testing the Connection 
There are two ways to verify a successful connection: 

 Review the device control log 
The device control log window displays status messages generated during 
the initialization of the application/device. It lists all instrument components 
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found and the device connected. If the device was detected the connection 
was successful. 

 Notice the status icon in the bottom bar 
The bottom bar of the application window contains several status icons. The 
second is showing the connection status of the device. The following list 
shows the meaning of the different status icons: 

 

 
The device is connected successfully and ready for use 

 
A device is not connected or not yet initialized 

 
The application is busy connecting to the device 
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Move the mouse pointer over the status icon and leave it there; a 
popup window will open and display a notification regarding the 
current status. Move the mouse pointer outside of the icon and the 
popup window disappears immediately. 

 

 

  

25.4.3 Simulation Mode 
Without a connected device the application can still be started. The application has 
to be started in simulation mode. This setting can be set in the options dialog of 
the X-LabPro Com Server (launcher in the system tray). Right click on the tray 
icon and choose Options. The following dialog will show up: 

 

 

 

 
 

 

 
Mark the simulation mode checkbox to enable it. Click OK to save the new setting. 
This setting will get active when the MIDEX Routine Dialog is restarted. 

When started in simulation mode all actions and reactions of the interface are just 
simulated. The application will not connect to a device, even if it is connected. The 
last (right) status bar icon shows a simulation mode symbol if it is active: 
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Simulation mode is activated  

 

 

 
 

In simulation mode all spectra generated are simulated and do not contain 
measurement information!       

 

 

25.5 Routine Dialog Main Window 

 

1 Main Menu See chapter 4.3.1 

2 Measurement Parameters Bar See chapter 4.3.2 

3 Wizard Page Area See chapter 4.4 

4 Tool Windows Toggle Buttons See chapter 4.3.5 – 4.3.7 
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5 Status and Notification Area See chapter 4.3.3 & 4.3.4 

6 Wizard Navigation Area See chapter  4.3.8 

 

25.5.1 Main Menu Items 
The MIDEX Routine Dialog main menu contains general items which are not 
directly required for device operation. The main menu provides additional 
functionality like shutting down the application, switching the device on/off, 
launching this help file, etc. 

The following list shows all available menu items and describes their functionality: 

Routine Contains menu items affecting the routine 
application 

------- Exit Shuts the application down. 
If high voltage of the device is active, the routine 
shuts the device down first. This may take some 
time. The measurement parameters bar informs 
about the current state of the device generator 
values. 

Edit Contains menu items affecting the data in the 
Routine Dialog. 
Sub items get only active when it is possible to use 
them. 

------- Paste Standard Pastes a standard to the Pointscan list on Scan 
setup Page  
(see chapter 4.4.5.11.2) 

 View Switches toolbars/windows and sets view options 

------- X-LabPro 5 Bar Toggles the visibility of the X-LabPro Bar (see 
chapter 4.3.5) 

------- Device Control Toggles the tool window for device messages (see 
chapter 4.3.6) 

Tools  Device operations and service menu items 

------- Instrument Test 
Window 

 Allows controlling the device components manually 
(Supervisor only) 

------- Test Measurement  Allows starting a measurement for testing purposes 
(Supervisor only) 

------- Init Sample Stage Moves the sample stage back to its root position 
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------- Reload Methods Reloads the Method buffer and reads newly added 
methods 

------- Switch Instrument Off  Shuts the device down 

------- Enter Standby Mode  Activates the standby state of the device (holding 
voltage) 

X-LabPro  Contains items to launch other X-LabPro 
components (same items like  
X-LabPro Bar) 

------- Method 
Administration  Launches the Method administration of  X-LabPro 

------- Spectra Viewer  Launches the Spectra Viewer of  X-LabPro 

------- Job Manager  Launches the Job Manager of  X-LabPro 

------- Atomic Library  Launches the Library of atomic data of  X-LabPro 

------- Configuration Editor Launches the Configuration Editor of  X-LabPro 

------- Evaluation  Launches the Evaluation of  X-LabPro 

------- Routine Help  Opens this Help Manual 

Help  Help and information about MIDEX Routine Dialog 

------- Help Manual  Opens this manual 

------- About MIDEX Routine  Shows a dialog containing application and version 
information 

   

 

 

25.5.2 Measurement Parameters and Information Bar 
Below the main menu the interface presents the measurement parameters bar. 
This bar is always visible and contains essential information about the state of the 
device and the progress of the measurement. 

 

 

The following table describes the values shown in the parameters bar: 
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Smp. Pos/Meas.  Shows the current scan id and sub measurement id (Pointscan 
only) 

Pressure [Pa]  (reserved for use with vacuum option) 

Voltage [kV]  Shows the current voltage produced by the X-ray generator 

Current [mA]  Shows the current  mA value produced by the X-ray generator 

Maximum Time [s]  Presents the time span in seconds scheduled for the active scan 

Remaining time [s]  Presents the remaining time of the current scan in seconds  
 (not overall time) 

 

 

25.5.3 Status Icons 
The bottom bar of the main application window contains 5 bubble icons presenting 
the current device/application status.  

The first icon shows the status of the X-ray tube. Is the icon grayed out the X-ray 
generator is not active. The status icon turns yellow when X-ray gets active: 

 
 X-ray is inactive 

 
 X-ray is active. 

 

The second icon displays the connection status to the MIDEX device. If the icon is 
grayed out there is no device connected: 

 
 There is no device connected (at least not yet) 

 
 The application is busy connecting to the MIDEX device. 

 
 The application successfully connected to the MIDEX device 

 

The third icon shows the state of the device power supply. The icon will be grayed 
out if no status was detected. This can happen if the optional UPS (uninterruptible 
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power supply) is not installed. A UPS is recommended to support a soft shutdown 
of the x-ray tube if the main power was interrupted. 

 

 

 The power status of the device could not be detected. 

 

 The main power line was interrupted. The Routine Dialog will  
 shutdown the device safely and close the MIDEX routine  
 dialog application. 

 

 The main power line is connected and supplying the device  
 with power. 

 

The fourth icon presents the state of the sample chamber door lock. If the icon is 
red, the chamber is locked and cannot be opened. 

 

 The chamber door is unlocked and can be  
 opened at any time. 

 
 The door to the chamber is locked and cannot be opened. 

 

The fifth and last icon is usually empty (gray). It will change if the application is 
launched using the simulation mode flag (see 4.2.3). It will also show if the device 
is transmitting data to the computer or if the detector I regenerating. 

 

 This is the default state of the icon. There is nothing wrong  
 about it. 

 

 The simulation mode is activated. All actions and device  
 responses are only simulated. There is no real device  
 communication. 

 

 The device is busy transmitting data from the device to the  
 computer. 

 
 The detector is regenerating. (not yet used) 
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25.5.4 Popup Notifications  

To clarify the meaning of the displayed status icons the interface provides popup 
notifications. These notifications appear immediately as you move the mouse 
pointer over the status icon. If you move the mouse pointer outside of the icon or 
notification area it will disappear. The notification displays the state of the 
corresponding icon as simple text. Here are some examples of these notifications: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

25.5.5 X-LabPro Bar 
The bottom bar of the main application window contains 3 buttons which can be 
used to toggle tool and notification windows. The first button can be used to switch 
the X-LabPro Bar on and off. 

 

 

 

 

The X-LabPro Bar lists the commonly used components of X-LabPro to make them 
easy to access from the MIDEX Routine Dialog interface. Available options are: 

Method Administration 

Spectra Viewer 
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Job Manager 

Library of Atomic Data 

Configuration Editor 

Evaluation 

Help 
(for MIDEX Routine Dialog) 

 

Simply click on the button to launch the corresponding X-LabPro component. As 
you are already authorized by logging into Midex M Routine Dialog it is not 
required to log into the started component again. 

Please note that instead of the buttons in the X-LabPro Bar you can use the X-
LabPro menu item in the application main menu. 

 

 

 

25.5.6 Device Control Log Window 
The bottom bar of the main application window contains three buttons which can 
be used to toggle tool and notification windows. The second button can be used to 
switch the device control log window on and off. 
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The Device Control Log lists all notifications related to the device operation. During 
connection the device control log window is shown automatically. It will be hidden 
if the connection process has finished.  

On the right side of the window you can find three tool buttons. These buttons can 
be used to clear the log, save to a file or copy the listed text into the Windows 
clipboard.  
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25.5.7 Device Communication Log Window 

The bottom bar of the main application window contains 3 buttons which can be 
used to toggle tool and notification windows. The third button can be used to 
switch the device communication log window on and off. 

This information is required for service purposes only. 

25.5.8 Wizard Navigation 
The right side of the window bottom bar contains the navigation buttons. These 
buttons allow switching between the wizard pages. 

 

 

 

The button state depends on the current state of the wizard page. For example the 
process can only advance to the scan setup page if there is a preview image 
available. Because of that the next button in the preview scan page gets enabled 
after the preview image was scanned correctly.    

The navigation buttons will switch to a special state if the following step executes 
an action. For example on the setup verification page the next button switches to a 
Start button to clarify that the click on it will launch the scan process. 

 

 

 

25.6 Wizard Pages and Device Operation 
This chapter will describe the application workflow in detail. Every major step 
during the scan process is represented by a wizard page. It is easy to navigate 
back and forth through the steps/pages using the navigation buttons (see chapter 
4.3.8) 

When launching the application it always shows the same state: The welcome 
page. This is where the process starts. 

 

25.6.1 Wizard Workflow 
Chapter 2.4 Quick Scan Gide gave a brief introduction on the workflow of the 
Routine Dialog. The following list shows how the wizard style Routine Dialog 
advances through the process of scanning a sample step by step: 
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ID Page Task 

1  Welcome Page  Start page of the application shown after login and 
connecting 

2  Stage Setup Page 
Define the maximum Z position (height) of the stage/ 
sample, set camera properties (e.g. zoom level), define 
light intensity, calibration tasks 

3  Preview Scan Page
Scan a preview image of the stage/sample. This preview 
will be used to define the scan positions. There are two 
scan modes available: Raster Scan and Point and Shoot. 

4  Scan Setup Page 
Easily navigate over the preview image and define the 
spots to scan using Mapping mode, Linescan mode or 
Pointscan mode. 

5   Verification Page Review your setup and select an evaluation mode (fast or 
advanced) 

6  Scan Progress 
Page 

During the scan the Scan Progress page shows 
intermediate results and the remaining time until the scan 
is finished. When finished the Page automatically switches 
to the next page: 

7  Scan Results Page 
Review the results of the scan using Color  
Maps View, Spectra View (Pointscan only) or Results List 
View (Pointscan only) 
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25.6.2 Welcome Page 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Welcome Page is shown after the application is launched and initialized. This 
page is meant to give an overview of the initial state of the device before entering 
the scan process.  

Use this dialog to check if the device is connected properly (see chapter 4.2 
Connecting the Device); check if the simulation mode is deactivated (unless you 
want it to be active) and if the device parameters are correct. 

When the application initializes there may be some messages notifying about 
required actions. For instance if the high voltage of the X-ray generator is active at 
launch a message will ask to shut the voltage down.  

In case of errors during the connection initialization of the application (e.g. if no 
device could be found) an error message is displayed. The application will exit 
after closing the message box. 

After successful connection another message will ask if the standby mode of the 
device should be activated (see chapter 4.4.2.1 Entering Standby Mode for more 
information). 

When the application initialization sequence has finished, the device was 
connected properly and a choice about the standby mode was made, the Start 
button of the wizard navigation gets enabled. 
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Click the Start button to begin the scan process using your MIDEX device and the 
MIDEX Routine Dialog. The wizard switches to the Stage Setup Page (see chapter 
4.4.3) 

 

25.6.2.1 Entering Standby Mode 
The device supports a standby state to maximize the lifetime of the X-ray tube. 
The lifetime of the tube reduces the more often it is restarted. After launching the 
MIDEX Routine Dialog application it asks to activate standby of the device. 
Another option to enter standby mode is to use the application main menu (Tools 

 Enter Standby Mode). 

When standby is activated the X-ray generator runs on a level defined in the X-
LabPro configuration editor. The shutter, protecting the sample chamber from X-
rays, remains closed. It is safe to open the chamber and place a sample on the 
stage. 

The device remains in standby until a scan is started. After the scan has finished, 
the standby mode will be reactivated. 

 

 The standby mode becomes active after every scan, even if it was not activated before. 

 

 
Never switch off a device running in standby mode using the hardware switch. This could 
drastically reduce the lifetime of the X-ray tube or cause direct damage to it. The X-ray tube 
requires to be shut down softly by the MIDEX Routine Dialog to ensure a maximum lifetime  

 

25.6.3 Instrument Setup Page 
The Instrument Setup dialog is used to prepare the device, the stage and the 
sample for the scan setup. It is suggested to process the following task remaining 
their order: 

Place the sample onto the center position of the stage 
When the sample stage initializes it moves to the lowest possible position. This 
makes it easy to place the desired sample onto it. It is recommended to put it into 
the middle of the stage. Leave the door to the sample chamber open for now. 
 

Move the sample to the center position of the camera live image 
Use the stage navigation controls (see 4.4.3.2) to move the sample to the middle 
position of the live image. Use the crosshair displayed on the screen as point of 
reference. 
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 Lift the stage carefully to the top of the sample chamber 
This step needs to be handled very carefully! Lifting the stage too high can push 
the sample into the detection system and cause damage to the device. Use the 
stage navigation controls (see 4.4.3.2) to lift the stage to the top of the chamber 
without touching it. If your device uses 2 mm distance for measurement, be sure 
to have the sample at least at that distance. Move the last centimeters using the 
fine adjustment buttons. 
 

Lock the maximum stage position 
After reaching the desired position click the Lock Z Position button. This position 
of the Z-axis will be written to the hardware controller of the MIDEX device. During 
all following steps the stage cannot be lifted higher than the locked position. 

 If you put another sample into the chamber the position must be  
    defined again. 
 

Set the camera preferences 
You are free to set a camera zoom level and the intensity of the lights inside the 
chamber.The following image shows the Stage Setup page. The table below 
describes its components. For details about these controls see the following 
chapters starting at chapter 4.4.3.1 Live Video: 
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1 Live Video Image See chapter 4.4.3.1 

2 Stage Navigation Controls See chapter 4.4.3.2 

3 Camera Controls See chapter 4.4.3.3 

4 Maximum Z-Lock Switch See chapter 4.4.3.4  

25.6.3.1 Live Video 
The live video control displays a realtime video image of the stage. The center of 
the live video displays a crosshair. This crosshair can be used as a point of 
orientation. The crosshair can also be used when calibrating the device or defining 
the right distance for measurement (see 4.4.3.4.1 Finding the right distance for 
measurement). 

 

 

 

 

 

 

 
 

 
The crosshair marks the center of the image captured by the camera. This point is not equal to 
the point of the X-ray beam. The offset may vary for each device and was calibrated during 
production. 

 
 
 

25.6.3.1.1 Live Video Settings 
The video image color settings can be dynamically adjusted. To modify these 
settings and save a current image of the sample stage the Routine Dialog offers a 
context menu on the live video control. Right click on any part of the live video to 
open the context menu and choose the desired option. 

The color settings of the camera applied at startup are defined in the device 
configuration file (.xcf). The default settings can be modified using another context 
menu item. 

The following functions are available: 
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1 Video Color Settings – opens a dialog to modify the color options of the camera. See 
4.4.3.2 

2 Reset Color Settings – resets the color settings to default as defined in the 
configuration file. 

3 Save Color Settings to Config – changes the default settings in the configuration file 
to the current settings 

4 Capture Image – opens a Save Image Dialog Box to save a snapshot of the current 
camera image 

 

25.6.3.2 Stage Control 
The MIDEX Routine Dialog allows moving the sample plate into 3 directions: 
left/right, back/forth and up/down. The navigation left/right and back/forth can be 
controlled like moving over a street map using north, east, south and west 
directions. The MIDEX Routine Dialog offers a navigation wheel for intuitive 
navigation in these directions: 

 

 

 

 

 
 

Push the button leading into the desired direction to move the stage. The button 
can be pushed and hold to move continuous. Leave the button to immediately stop 
the movement. The faster the button is hit and left, the smaller is the distance the 
sample stage moved. 

Similar to these navigation buttons the interface provides buttons to move the 
sample plate up and down:  

  

 

 

 

 

The lift and lower buttons work like the navigation wheel buttons. Holding the 
button moves the sample plate continuously into the corresponding direction. 
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These buttons should only be used as long as the distance to the detection area at 
the roof of the sample chamber is large enough. If the distance gets lower use the 
fine adjustment buttons supporting movement of the sample plate in very small 
steps: 

 
 

 

 
 
These fine adjustment buttons move the sample plate up or down like the former 
buttons but they behave differently. If a button is pushed the stage moves a 
defined length. If the button is held down, the plate does not move continuously, it 
moves a pre-defined amount of motorsteps. There are three different (but small) 
distances to move the stage. It is recommended to test the movement using the 
fine adjustment buttons in a safe distance to get a feeling for the distance moved.  

For easier and faster handling of the stage the MIDEX Routine Dialog supports navigating 
by keyboard. Every navigation button of the Routine Dialog has a corresponding keyboard 
button: 

 

 

 

 

 

 

 

 

Cursor Keys 
(Up/Down/Left/Right) 

Navigate North, East, South and West like using the Navigation 
wheel 

Page Up/PageDown Keys Lift or lower the sample plate like the lift and lower buttons of the 
interface 

Num Pad 7, 8, 9 
Lift the stage in small steps like the fine adjustment lift buttons 
(number on the button matches the key on the number pad of the 
keyboard) 

Num Pad 1, 2, 3 
Lower the stage in small steps like the fine adjustment lower buttons 
(number on the button matches the key on the number pad of the 
keyboard) 
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Num Pad / Switch the light on/off 

Num Pad * Switch the laser on/off 

 

25.6.3.2.1 Point and Shoot Navigation 
Another option to navigate north/east/south/west directions is Point and Shoot 
mode, named after the MIDEX Routine Dialog fast preview scan mechanism (see 
4.4.4.3 Point and Shoot Scan). The functionality of this navigation option is very 
intuitive and fast to use. By clicking into any part of the live image, the clicked spot 
will be moved to the center of the crosshair. 

Very easy: Left-click onto the position you whish to be the center of the live image 
and the stage moves it automatically to the center. 

Before: 

 

 

 

 

 

 

 

 

 

 

 
After:  

 

 

 
 
 
 
 
 
 
 

2. The spot is moved to  
     the center 

1. Click the 
desired spot 
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25.6.3.3 Camera Control 

The camera controls can be used to define the zoom level of the camera image, 
adjust the brightness of the light inside the sample chamber and to set the 
intensity of the laser. 

  

 

 

 

 

The Zoom level of the camera image can be chosen from a dropdown box 
provided by the stage setup page. The available zoom factors are configured in 
the device configuration file. The values can be edited using the X-LabPro 
Configuration Editor. 

When selecting a different zoom level it is immediately applied to the camera. 

 
 

 
Zoom levels in the dropdown list are relative to the initial setting (1x) and may not be equal to 
the real measurements of the sample. 

 

25.6.3.3.1 Light Level 
  

 

 

 

 

 

 

 

The light level (brightness) inside the sample chamber can be adjusted using the 
slider of the dropdown area of the light button. Clicking the other part of the button 
toggle the light on/off. 

Move the slider to increase or decrease the brightness level until the desired result 
is reached. Then just click outside of the button area to close the slider. 

A glowing bulb signals the light is switched on, a gray bulb shows the light is 
switched off. If the light is switched off and on again, the former brightness level is 
restored. 
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25.6.3.3.2 Laser Intensity 

  

 

 

 

 

 

 

The laser intensity can be adjusted similar to the light adjustment button. Click the 
button to toggle the laser on/off. Open the slider and move it to increase or 
decrease the laser intensity.  

Review the state of the laser in the live video image.  

 
The laser is calibrated to match one defined zoom level and because of that the 
laser can not be used in any other defined zoom level. In this case the Laser 
button is disabled.   

25.6.3.4 Define the Maximum Z-Position of the Stage 
Defining the maximum position means also defining the measurement distance. 
The distance required for measurement depends on your device. Possible 
distances are 2mm and 20mm. As stated before, this step requires to move the 
sample to the center of the video image and to lift the sample plate up to the 
measurement (or maximum) position.  

The following chapter 4.4.3.4.1 describes in detail how this position can be 
determined using the MIDEX Routine Dialog. 
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If this position is reached click the Lock Z-Position button to define the distance. 
Now the position of the Z axis is written to the device what makes it impossible to 
lift it higher during further processes. 

If the position needs to be readjusted click the Unlock Z-Position button to do so. 
Now the movement options are available again until the Lock Z-Position button is 
clicked again. 

If the maximum position was defined, the Next button of the wizard navigation gets 
active and it is possible to proceed to the next wizard page Preview Scan.  See 
chapter 4.4.4 for more information on scanning a preview image. 

 

25.6.3.4.1 Finding the right distance for measurement 
The right position can be determined using the laser. The laser is configured to be 
exactly at the center (crosshair) position of the live video if the right distance for 
measurement is reached. 

This setup is used to support samples of variable height. The following process is 
the same as described in chapter 4.4.3 but this time it includes the laser to 
determine the right measurement position: 

 

1. Place the sample to the center position of the stage 
Move the sample to the center position of the camera live image 
Be sure to move the highest part of the sample into the center. This prevents from 
touching the sample chamber roof and damage the detection area. 
 

 Lift the stage carefully to the top of the sample chamber 
a. Turn the laser on and choose the optimal intensity 
    (Lower intensities are better for reflecting surfaces) 
b. Lift the stage up until the sample is near the roof of the chamber.   
c. Stop movement in a safe distance before the roof.  
d. Review the live video image and step upwards using the fine  
    adjustment buttons. Remember to take care of the distance between  
    roof and sample. 
e. If the laser dot is exactly in the center of the crosshair the  
    measurement position is reached. Adjust by stepping up and down until that 
position is reached. 
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2. Lock the maximum stage position 
 

3. Set the camera preferences and proceed to the next wizard page 
 

25.6.4 Preview Scan Page 
The MIDEX Routine Dialog supports two different modes to scan a preview image: 
Raster Scan and Point and Shoot. 
 

 

 
 

It is recommended to close the chamber door at this point. Best preview 
scan results are reached using the internal illumination of the device 

25.6.4.1 Scan Modes 
Both scan modes support the creation of a preview image taken from the sample 
inside the sample stage. In most cases a single capture of the camera is not 
sufficient, for instance to create large Mappings across the sample. In this case 
the whole sample plate can be scanned by moving a piece of the sample plate 
below the camera and creating a snapshot, then moving to the next piece (or 
segment) and so on. All segments are combined to a big (raster) image. 

Another, faster option is Point and Shoot. It supports moving the stage quickly to a 
desired position and capturing the segment. Then it can be directed to the next 
desired segment and so on. This mode is recommended for small parts of the 
sample to be scanned (e.g. Pointscans) 

 

25.6.4.2 Raster Scan 
The Raster Scan page shows a representation of the stage (as black plate) 
separated into segments. The amount of segments is defined in the device 
configuration file and can be edited using the X-LabPro Configuration Editor. 
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At this point there is no preview scanned and no segment selected for scanning, 
all segments are black. The next step is to define which segments to scan. Every 
combination is possible. If it is sure that a segment does not contain a part of the 
sample or if there is no spot to scan, the segment does not need to be selected. 

To select a segment just click it. The segment changes its color. To deselect an 
already selected segment click it again. The segment will turn black again. To 
quickly select all segments click the All button, to deselect everything click the 
None button. 

When every desired segment is selected, the selection may look like this: 
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To scan the preview, click the Scan Selected button and wait until the scan 
process has finished. The MIDEX Routine Dialog application will move the sample 
plate and capture all segments of the sample fully automated. It is not possible to 
perform any tasks during this process. 

If you wish to abort the operation click the Abort Scan button (Scan Selected has 
changed). The scan will stop and the partly created preview image will be deleted. 
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25.6.4.3 Point and Shoot Scan 

The Point and Shoot Scan mode, like the Raster Scan (see previous chapter) 
displays a black presentation of the stage. But here the stage is not separated into 
segments. The Point and Shoot page displays a single segment as a red 
rectangle. This segment can be dynamically moved across the sample plate.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To define the exact position of the segment on the sample plate click into an area 
near the desired position on the black field. The stage will be moved to display the 
clicked spot in the center (crosshair) of the live video image on the right side of the 
Point and Shoot page. 

You can use Point and Shoot navigation on the miniature live video image as 
described in chapter 4.4.3.2.2. This allows defining the position exactly. Click the 
part of the sample you wish to be in the center of the live video. The application 
will move the stage there automatically to the target position.  

Verify the desired part of the sample is visible in the live video image, then click 
Capture to add this segment the preview image. Repeat these steps until all parts 
of the sample needed for scanning are visible. 

 
The best results can be received if the segments scanned do not 
overlap. 
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If the preview image fits your needs (and you have at least one segment 
captured), click Next to go to the Scan Setup Page. 

25.6.5 Scan Setup Page 
The Scan Setup page is the most important page of the scan setup process. This 
is where you can define the spots or parts of the sample to scan. You can define 
method and scan duration for each scan. This is what the page looks like: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 Scan type selection tab 

2 Toolbar for edit modes 

- Add Mode: Allows adding entries 

- Delete Mode: Allows removing entries 

- Grab Mode: Grab and move the  
    preview image  

- Zoom Mode: Draw a rectangle on the preview to zoom in to the   
        rectangle area 

and 

- Full screen: Shows the complete preview  
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   image inside the preview area 

- Options: Opens an options tool window 

3 Toolbar for saving and loading list entries to/from a file. 

4 Preview area 

5 Thumbnail preview 

6 Zoom selector 

7 Mapping Entry – a table entry presented in the preview window 

8 Information Fields – Shows coordinates of the cursor position on the 
preview. 

9 Setup properties – Choose Method Class for scanning and define the units 
to show 

10 Table with scan entries – one entry is one Mapping, Linescan or Pointscan. 
Table values (method, duration, coordinates, etc.) can be edited. 

 

 

 

25.6.5.1 Toolbars 
The scan setup page offers two different toolbars. The first is used to switch edit 
modes, the second offers options to save or load from/to the current table setup. 

   

 

 

 

Add Mode 
Toggles the ability to add Mappings by drawing them into the preview image. 

  

 

Delete Mode 
Toggles the ability to remove entries from the table 
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Grab mode (enabled by default) 
Toggles the ability to click and hold inside the preview and drag the preview 
image. This moves the visible section of the preview image the amount the mouse 
cursor was dragged. 

  

 
Zoom Mode 
Toggles the ability to zoom into a smaller area of the preview image by drawing a 
rectangle around the desired region. 

 

 
 
Fullscreen 
Switches the zoom slider to show 100% of the scanned image inside the preview 
area. 

  

 

Options 

Opens a window to adjust the color of the Mapping presentation on the preview 
image and to save the preview (full stage image) as image file.  

 

 

 
 

 
Load Table 
Opens a dialog box to load a previously saved list of Mapping, Linescan or 
Pointscan entries. (depends on scan type, see chapter 4.4.5.8) 

  

 

Save Table 

Opens a dialog box to save the current list of Mapping, Linescan or Pointscan 
(depends on scan type, see chapter 4.4.5.8) entries into a file. 
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25.6.5.2 Preview Image 

The Preview area of the scan setup page is divided into two controls. The larger 
main preview is used to perform actions like adding Mappings, the smaller 
thumbnail preview is used to show which section of the complete image is 
currently visible in the main preview (see next chapter 4.4.5.2.1 for more 
information on the thumbnail preview). 

 

 

 

 

 

 

 

 

 

 

The main preview area shows the scanned image generated in the previous 
wizard page (Raster Scan or Point and Shoot). The zoom level and the portion of 
the image visible in the preview area can be defined dynamically using the zoom 
and navigation tools provided on the scan setup page. See chapter 4.4.5.3 for 
more information on zooming and chapter 4.4.5.4 for more information on moving 
the image to display a desired region of the preview. 

If there are entries in the table, the preview shows these Mappings, Linescans or 
Pointscans as crosses or as lines/rectangles if the zoom level is too small to 
display crosses. The color of the crosses can be defined in the options tool 
window. Each cross represents a point to scan. See chapter 4.4.5.9 for more 
information on scan positions and how they are defined. 

 
The main preview displays only entries of the current scan mode (Mapping, 
Linescan, Pointscan) defined by the activated tab on top of the scan setup 
page (see 4.4.5.8) 

  

 
If an entry is not visible in the main preview this be caused by wrong 
coordinates (e.g. outside the preview), too low resolutions (0 or 1) or a mark 
color similar to the background of the sample (e.g. black on black). 
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25.6.5.2.1 Thumbnail Preview 

 

 

 

 

 

The thumbnail preview area shows a miniature version of the full image scanned 
before. It marks the region of the image which is currently presented in the main 
preview area. The thumbnail preview can be used to navigate over the full stage 
preview image by dragging the section rectangle. Short clicking inside the 
thumbnail preview area moves the center of the section rectangle to the clicked 
spot. The main preview is updated immediately.  

25.6.5.3 Zooming the preview 
The scan setup dialog supports zooming in and out of the preview image. Using 
image zoom you can easily define a position on the image exactly (up to one 
pixel). On the other side it is easy to have an overview of the whole image or large 
areas of it (by zooming out). 

To completely zoom out use the Fullscreen button of the toolbar or simply right 
click into the main preview area. The main preview updates to show the complete 
image scanned before. If there is a portion of the main preview area left (e.g. 
because of the aspect ratio) this part is filled using black color. The zoom level 
cannot be set lower than this.   

 

To zoom in using the preview image there are two possibilities: 

 

The Zoom Slider 
 

 

 

 

 

 

 

 

 

 + -
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Below the thumbnail preview area a zoom slider control is displayed. Moving the 
slider increases/decreases the zoom level. Moving the zoom slider to the right 
decreases the zoom level, the segment of the picture shown in the main preview 
area gets larger. 

Moving the zoom slider to the left increases the zoom level, the segment of the 
preview displayed in the main preview area gets smaller. 

The maximum Zoom level (slider fully left) is reached if the main preview area 
displays a segment of 5% of the full preview image.  

 The view will not be interpolated; upscaling increases the pixel size of the image. 

 

 

1. The Zoom Mode 

Zoom mode offers the ability to define the rectangle to be displayed directly in the 
main preview area. Zoom mode is activated using the toolbar button Zoom. 
Proceed as follows: 
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1. Click on a spot inside the main preview area as start point and hold the left 
mouse button down.  

 

 

 

 

 

 

 

 

 

 

 

 

Drag the mouse cursor to the desired end point. Notice that the selection keeps 
the aspect ration automatically. Release the left mouse button to finish. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
3. The main preview now shows the contents of the selection using proper scaling 
and moving.  

 
Zoom mode remains active until it is deactivated or another mode was activated. It 
is possible to zoom in until the maximum zoom level is reached.  
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To restart the zooming process, simply right click into the main preview. The 
whole image is now visible and a new region to be zoomed in to can be 
selected. 

 

25.6.5.4 Navigating through the preview 
If the zoom level is higher than the minimum, the preview image is not completely 
visible. During creation of Mapping, Linescan or Pointscan setups it may be 
necessary to move the visible area of the preview image in the preview area of the 
scan setup page to another position. This can be established using the grab mode 
or the thumbnail preview. 

 

Grab Mode 
The grab mode can be used to easily move the sample preview image. It works 
using drag and drop. In grab mode the cursor becomes a hand when moving over 
the preview area. Click on any spot inside the preview area and hold the mouse 
button down. The hand cursor grabs the picture. Now move the mouse cursor in 
any desired direction, the image moves the same amount. To apply the new 
position just leave the left mouse button. 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 
1. Click (and hold) a spot 
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Thumbnail Preview 

Click anywhere into the thumbnail preview image and the clicked spot will become the 
center of the main preview area. The zoom level will not be altered. Click, hold and 
drag the rectangle to review the movement and the resulting display in the preview 
area. 

 

 

 

 

 

3. Leave mouse button 
2. Drag to the desired position 

 
1. Click and hold a spot 
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25.6.5.5 Preview Options 
Click the Options button in the toolbar to open the View Options tool window. 
The tool window can be opened while working inside the scan setup page. It does 
not block input or progress on that page. 

 

 

 

 

 

 

 

 

 

 

 

The Mapping Color region allows modifying the color used to mark the Mapping, 
Linescan or Pointscan display (crosses, lines or rectangles) in the main preview 
area.  
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The display color in the preview area will immediately change after selecting a new 
color. This allows checking if the color meets the requirements (high contrast to 
background). 

Click the color drop down button to choose a different color. Choose one from the 
predefined set or define a new color by clicking the More Colors button. 

The default button color is restored, if the application is restarted. If you wish to 
define a new default color select it and click the Set as default color button. This 
action will write the color value into the configuration file and restore it after each 
restart. 

 

 

 

 

 

 

 

 

 

 

 

 

The Save Current View region offers possibilities to save the preview image (the 
complete image, not just the preview area) into a file. There are two options: 

 

 

Saves the image including the presentations of Mappings, Linescans or 
Pointscans. 

  

 

Saves the original image (without marks). 

 

After clicking a button a Save Image File dialog box appears offering to save the 
image as jpg, gif, png and bmp. 
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25.6.5.6 Method Class and Method Selection 

 
It is recommended to choose a method class before adding Mappings. 

 

 

 

 

 

Method classes can be configured in the X-LabPro Configuration Editor. By defining 
method classes and assigning methods to it.  

 A Method class is a container for multiple methods of a similar type or for a similar purpose.  

 
Choose a method class from the list of available method classes. The method list 
that can be selected for an entry in the tables will be replaced with the method list 
of the newly selected method class. If there are already entries in any table, a 
warning will be displayed. If a new method class is selected the method selection 
of all entries is reset to the first item of the new list.  

For proceeding confirm the message, otherwise cancel it. After canceling the 
method class will be set back to the former setting. The table entries will not be 
changed. 

 
The method lists for Mappings and Linescans contain only those methods marked as Mapping 
compatible in the method administration of X-LabPro 

 

 

25.6.5.6.1 Scan Duration 
 
When a method is selected from a dropdown item in the table (see chapter 
4.4.5.9), the scan duration is automatically set to the value defined in the 
respective method. This default value can be edited using the method 
administration of X-LabPro. The value displayed in the table can be modified and 
applies only to the corresponding item. If the method selection changes, the value 
will be reset to the value configured in the method. 

 

 
The scan duration will also be reset if a new method class was selected and the method has 
changed.  

25.6.5.7 Saving and Loading Setup Lists 
To load a scan setup file activate the tab for the corresponding scan type, 
Mapping, Linescan or Pointscan). Click the Load Table button in the Load/Save 
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toolbar. An Open File Dialog Box pops up requesting to choose a setup file. 
Choose a compatible file from your file system. The following list shows the file 
formats available for import: 

 *. mml MIDEXapping List – contains a list of Mappings 

*.mll Midex Linescan List – contains a list of Linescans 

*.mpl Midex Pointscan List – contains a list of Pointscans. 

 

After selecting a file the list entries inside will be read and imported into the table 
for the corresponding scan type. 

 

 
If a file is loaded all existing table entries will be replaced by the imported 
entries. 

 

To save the list has to contain at least one item. Select the tab page for the 
corresponding scan type (Mapping, Linescan or Pointscan) and click the Save 
Table button. A File Save Dialog Box appears and offers to save the file as the 
format matching the currently selected scan type. 

 

25.6.5.8 Switching Scan Types (Mapping, Linescan or Pointscan) 
The scan setup page of the MIDEX Routine Dialog offers three different scan 
types:  

Mapping 

Rectangular area on the sample 

Configurable resolution, max. 128x128 (amount of 
scan points horizontal and vertical evenly 
distributed over the area)  

Short scan duration for each point 

Simple evaluation mode only (see 4.4.6.3) 

Result view as color maps, threshold maps or 
threshold mix 

Management as Mapping file 

Linescan 

Line on the sample defined by start and end point 

Configurable resolution, max 128 (amount of scan 
points evenly distributed along the line) 

Short scan duration for each point  

Simple evaluation mode only (see 4.4.6.3) 

Result view as graph (XY-chart) 

Management as Linescan file 
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Pointscan 

Single Point on the sample 

Longer scan duration than Mapping and Linescan 

Advanced evaluation mode 

Result view as spectrum or element listing 

Management using Job Manager of X-LabPro 

 

Select the scan type using the tab control at the top of the scan setup page.  

 

 

Activate the desired tab to switch the view of the scan setup page to the 
corresponding table. The table columns differ for every scan type. The following 
chapter describes how the setup of a scan entry can be done. 

 

 

25.6.5.9 Setup Mappings 
 

 

 

 

 

If the Mapping scan type is activated the scan setup page shows the table for 
Mapping scan entries.  

 

 

 

 
The following list describes the columns of the table and their properties: 

Mapping Name Text value 
A name for the Mapping entry, unique in this list. 
If a new Mapping is created, the application assigns a default name 
which can be edited afterwards. 

Method Drop down list 
List of methods according to the currently selected method class 
(see 4.4.5.6) changing the method causes a reload of the duration 
cell and recalculation of the resolution. 

Duration Numeric value Duration for scanning one point (usually millseconds for Mappings 
and Linescans, seconds for Pointscans). 
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X Numeric value 
X coordinate of the start point (units here and below as selected, 
see 4.4.5.12). 

Y Numeric value Y coordinate of the start point. 

Width Numeric value Width of the Mapping (base value to distribute horizontal scan 
points). 

Height Numeric Value Height of the Mapping (base value to distribute vertical scan points).

Res. X Numeric value  
< 128 Count of scan points to distribute along the width of the Mapping. 

Res. Y Numeric value 
< 128 Count of scan points to distribute along the height of the Mapping. 

Autofocus Checkbox Checked to do a Z axis auto correction before each scan point 
(automatic adjustment of measurement distance). 

Visualization Drop down list Selector to choose which visualization to show during scan 
progress. 

25.6.5.9.1 Adding, Deleting and Modifying Mappings 
 
To add a Mapping first make sure the Mapping tab is activated at the top of the 
scan setup page. Next use the zoom and navigation tools of the scan setup page 
to set up the preview area. Ensure the complete area required for the Mapping is 
visible. Then enter Add Mode by clicking the Add button of the toolbar.  

In add mode click the first point of the Mapping (top left corner) inside the preview 
area and drag a rectangle until the desired area of the Mapping is enclosed 
exactly. Then leave the mouse button.  

 

 

 

 

 

 

 

 

 

 

 

 

The Mapping is now added to the table at the bottom and displayed in the preview 
area. If the position of the Mapping is not correct and needs to be modified, this 

2. Drag the rectangle to 
the end point 

1. Click and hold 
the start point 
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can be done using the values in the table. Adjust a coordinate value and the 
change will immediately be applied to the preview. If the positioning is done 
choose a method from the method list in the new row of the Mapping table.  

Changing the method will load the default duration for one scan point from the 
method data and change the duration cell of the new row. The resolution values 
will also be calculated after a change of the method. This calculation is based on 
the size of the collimator. The application calculates how many points fit into the 
width of the Mapping. After the method was defined, the values for duration and 
resolution can be edited as required.  

 
It is recommended to only lower the values for the resolution because a higher resolution could 
lead to unexpected results due to overlapping scan points.   

Deleting Mappings is done using delete mode. First make sure the Mapping tab is 
activated and there are Mappings defined you wish to delete. Next enter Delete 
Mode by clicking the Delete button in the toolbar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

The border of the preview area turns red to warn that you have entered delete 
mode. It is important to be aware delete mode is activated to not accidentally 
delete a Mapping. A new column is added at the beginning of the table containing 
a button X. This is the delete button. To delete a Mapping in delete mode click on 
the delete button of the corresponding table ro 
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A message box is displayed requesting to confirm the deletion of the Mapping. 
Click Yes to do so or No to cancel. 

If you click Yes, the Mapping is removed from the list. The delete mode remains 
active after a Mapping was deleted. If the last Mapping was deleted and the table 
is empty, delete mode is deactivated automatically. 

 

 

25.6.5.10 Setup Linescans 
If the Linescan type is activated the scan setup page shows the table for Linescan 
scan entries.  

 

 

 

 
The following list describes the columns of the table and their properties: 

Linescan Name Text value 
A name for the Linescan entry, unique in this list. 
If a new Linescan is created, the application assigns a 
default name which can be edited afterwards. 

Method Drop down list 

List of methods according to the currently selected 
method class (see 4.4.5.6) Changing the method causes 
a reload of the duration cell and recalculation of the 
resolution.  

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 274 of 391 
 
 



                     
 

X-LabPro  5  
 

Duration Numeric value Duration for scanning one point (usually millseconds for 
Mappings and Linescans, seconds for Pointscans). 

StartX Numeric value 
X coordinate of the start point (units here and below as 
selected, see 4.4.5.12). 

StarttY Numeric value Y coordinate of the start point. 

EndX Numeric value X coordinate of the end point. 

EndY Numeric Value Y coordinate of the end point. 

Res. X Numeric value  
< 128 

Count of scan points to distribute along the line defined 
by the start and end coordinates. 

Autofocus Checkbox 
Checked to do a Z-Axis auto correction before each 
scan point (automatic adjustment of measurement 
distance). 

Visualization Drop down list Selector to choose which visualization to show during 
scan progress. 

 

25.6.5.10.1 Adding, Deleting and Modifying Linescans 
To add a Linescan first make sure the Linescan tab is activated at the top of the 
scan setup page. Next use the zoom and navigation tools of the scan setup page 
to set up the preview area. Ensure the complete area required for the Linescan is 
visible. Then enter Add mode by clicking the Add button of the toolbar.  

In add mode click the first point of the Linescan inside the preview area and drag a 
line until the desired end point of the Linescan is reached. Then leave the mouse 
button.  

 

 

 

  

 

 

 

 

 

 

 

 

2. Drag the line to the 
end point 

1. Click and hold 
the start point 
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The Linescan is now added to the table at the bottom and displayed in the preview 
area. If the position of the Linescan is not correct and needs to be modified, this 
can be done using the values in the table. Adjust a coordinate value and the 
change will immediately be applied to the preview. If the positioning is done 
choose a method from the method list in the new row of the Linescan table.  

Changing the method will load the default duration for one scan point from the 
method data and change the duration cell of the new row. The resolution value will 
also be calculated after a change of the method. This calculation is based on the 
size of the collimator. The application calculates how many points fit into the length 
of the Linescan. After the method was defined, the values for duration and 
resolution can be edited as required.  

Deleting Linescans works similar to deleting Mappings, see chapter “Adding, 
Deleting and Modifying Mappings”  for more information on deleting table entries 
using delete mode. 

25.6.5.11 Setup Pointscans 
If the Pointscan scan type is activated the table at the bottom of the scan setup 
page shows the table for Pointscan entries.  

 

 

 

 
 
The following list describes the columns of the table and their properties: 

Pointscan Name Text value 
A name for the Pointscan entry, unique in this list. 
If a new Pointscan is created, the application assigns a default name 
which can be edited afterwards. 

Method Drop down list 
List of methods according to the currently selected method class (see 
4.4.5.6) changing the method causes a reload of the duration cell and 
recalculation of the resolution.  

Duration Numeric value Duration for scanning one point (usually millseconds for Mappings and 
Linescans, seconds for Pointscans). 

Job Drop down list 
extendable The Job the Pointscan will be added to (see 4.4.5.11.4). 

X Numeric value 
X coordinate of the scan point (units here and below as selected, see 
4.4.5.12). 

Y Numeric value Y coordinate of the scan point. 

Z Numeric value Z coordinate of the scan point. 

Define Z Button Opens a window to define the Z-coordinate for the selected Pointscan. 
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25.6.5.11.1 Adding, Deleting and Modifying Pointscans 
To add a Pointscan first make sure the Pointscan tab is activated at the top of the 
scan setup page. Next use the zoom and navigation tools of the scan setup page 
to set up the preview area. Ensure the spot required for the Pointscan is visible. 
Then enter Add mode by clicking the Add button of the toolbar.  

In add mode click the point inside the preview area to set the coordinate for 
scanning. To exactly adjust the point, click and hold the mouse button inside the 
preview area and drag the point to the right position. Then leave the mouse button. 

The Pointscan is now added to the table at the bottom and displayed in the 
preview area. If the position of the Pointscan is not correct and needs to be 
modified, this can be done using the values in the table. Adjust any coordinate 
value and the change will immediately be applied to the preview. If the positioning 
is done choose a method from the method list in the new row of the Pointscan 
table.  

Changing the method will load the default duration for one scan point from the 
method data and change the duration cell of the new row. The resolution value will 
also be calculated after a change of the method. This calculation is based on the 
size of the collimator. The application calculates how many points fit into the length 
of the Pointscan. After the method was defined, the values for duration and 
resolution can be edited as required.  

Deleting Pointscans works similar to deleting Mappings, see chapter 4.4.5.9.1 for 
more information on deleting table entries using delete mode. 

 

25.6.5.11.2 Defining The Z-Coordinate for one Pointscan 
To specify a different Z-coordinate for each Pointscan in the table, the Table entry 
contains a Define Z Button. The default Z-coordinate is equal to the maximum Z-
Position. The maximum Z position is also the highest position to define for any 
Pointscan. The lowest position is the 0 position of the Z-stage. 
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To define the Z-coordinate click the Define Z button in the corresponding row of 
the pointscan table. A tool window opens showing a live video image of the 
sample stage. The window allows moving the stage in Z-direction and to define 
camera option like it was already possible in the Instrument Setup Page. 

 

The position defined by the corresponding pointscan row is automatically moved to 
the center of the crosshair. Use the laser and the Z-adjustment controls to specify 
the desired distance for measurement.  

If the laser spot exactly hits the center of the crosshair click apply to save the Z-
coordinate. This value will be set as Z-coordinate for the pointscan after the tool 
window was closed. 

 
 

25.6.5.11.3 Pasting Pointscans from Standards 
 
To scan standards defined in a method use the copy and paste feature of 
X-LabPro. The following procedure describes how to copy standards from a 
method and paste them into the Pointscan list: 
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1. Start the X-LabPro Method Administration 

2. Open the desired method and choose the Standards tab. 

3. Select the standards to scan by highlighting them in the list (use shift+click or 
ctrl+click to select multiple entries) 

4. Right click any selected standard and select copy from the context menu. 
(alternatively choose Edit->Copy from the main menu or push Ctrl+C) 

5. Open the MIDEX Routine Dialog, follow the instructions to perform the instrument 
setup and the sample scan and proceed to the Pointscan setup. 

6. Add Pointscans to the list maintaining the order from the standards list in the 
Method Administration. 

7. Mark the first list item by clicking in the name field. Standards will be pasted 
starting from the selected list item. This allows scanning standards and default 
samples from one list. 

8. Choose Edit ->Paste Standards from the main menu 

9. The standards are pasted to the list. All values except the coordinates are write-
protected for standards. The coordinates can be changed to redefine the position 
of the sample on the stage. 

 

25.6.5.11.4 About Jobs 
 
A job is a collection of scans (one or more). Jobs can be managed using the X-
LabPro Job Manager. Please consult the online help of the Job Manager for more 
information on managing jobs. 

To select a job for a Pointscan entry use the dropdown control in the Jobs column. 
By default the selection is set using a default naming pattern configurable in X-
LabPro Configuration Editor (e.g. current date, week of the year, etc). This pattern 
is applied to the first Pointscan entry in the list. Every following item will have the 
job selection of its predecessor as default setting. 

 

 

 

 

 

 

To change the job select another list item from the drop down list or add a new Job 
name by selecting the first list item < New Job >. 
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After choosing to add a new job a window opens requesting to enter a name for 
the new job. Enter a job name and click OK. The job name will be added to the 
dropdown list and selected for the current Pointscan. 

The job name will only be assigned to the scan; it is not created in the Job 
Manager. The job will be created when the first item using that job name is 
scanned. 

 

25.6.5.12 Stage Coordinates and Units 
The MIDEX Routine Dialog allows using different units to display and configure 
stage coordinates. The used units can be switched using the drop down list 
Display Units on the right side of the scan setup page. 

 

 

 

 

 

The coordinate values used in files and background processes are always handled 
as absolute amount motorsteps of the XYZ-stage motors starting at the 
initialization position of each motor. 

The MIDEX Routine Dialog uses a different coordinate interpretation. Values 
displayed in the Mapping, Linescan and Pointscan tables are defined as distance 
to the top left corner of the stage (which is identical to the top left corner of the 
displayed preview image. 

 
All coordinate values displayed in the MIDEX Routine Dialog base on the top left corner 
of the stage (preview image)   

25.6.5.13 Repro Scans 
To perform repro scans first activate the Allow Repro setting in the Configuration 
Editor of X-LabPro. This setting can be fount in the MIDEX Settings Dialog. 

With repro scans enabled the pointscan tab of the scan setup page displays a 
dropdown field to choose a number from 1 – 20. If 1 is selected the list is scanned 
only once (default mode). The selections from 2 – 20 define the number of times 
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the scan list will be processed. Selecting 5 means every pointscan in the list will be 
scanned 5 times. The Scan Verification page will display the full list including all 
repetitions. The routine dialog allows repeating a maximum of 10 pointscans up to 
20 times.  

 

25.6.5.14 Recalibration 
The MIDEX Routine Dialog allows recalibration using Global or MCA. To define a 
recalibration use the pointscan tab of the Scan Setup page. Add the appropriate 
number of pointscans and place them on the standards on the stage.  

Choose Edit->Recalibration->Global or Edit->Recalibration->MCA in the main 
menu. The Routine Dialog will switch to recalibration mode. Continue the 
recalibration lie a usual scan. 

To reset the Routine Dialog to default scan mode use Edit->Reset Table in the 
main menu. 

 

25.6.6 Verification Page 
After all Mappings, Linescans or Pointscans and the scan details (method, 
duration, etc.) are set up in the scan setup page, set the desired scan mode for the 
following scan. This can be done by selecting the tab on top of the scan setup 
page. Then click Next to proceed to the Scan Verification Page. 
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The Scan Verification Page displays the selected scan mode and the setup 
created before. On the right side it displays evaluation options. 

 

 

 

 
Notice that the Next button of the wizard navigation changed to Start. This means 
finishing the tasks on this page and advancing in the process will finally start the 
measurement of the selected spots. 

25.6.6.1 Review the Scan Setup 
The preview area of the verification page shows the full preview image including 
the defined Mappings, Linescans or Pointscans. Review your scan setup as 
follows: 

 

 

 

 

Make sure the desired scan type is selected. This is the only tab left at top of the 
page. If it does not match go back to the previous page, activate the desired tab 
and click Next to return to the scan verification page. 
 

 

 

 

Visually check the preview image and ensure the Mappings, Linescans and 
Pointscans are at the right positions 
 

 

 

 

 Check the contents of the table:  

 Names correct? 

 Correct methods selected? 

o Coordinates matching desired positions? 
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o Right Job(s) selected (Pointscan only)? 

o Visualization set correct? 

25.6.6.2 Select an Evaluation Mode 
On the right side of the scan verification page select an evaluation mode:  

 

 

 

 

 

 

 

 

 Simple evaluation mode 
 Only available for Mappings and Linescans. Performs a quick 
evaluation of the  
 detector information without using advances evaluation algorithms. 
The results will be displayed as relative intensities only. 

 Advanced evaluation mode 

 Only available for Pointscans. Performs a slow but very reliable 
evaluation  
 using advanced algorithms. The results will be displayed in 
concentration  
 values. 

 No evaluation  Saves the detector information and does not run any evaluation. 

 

The Direct Print option is available for Pointscans only. If this option is checked, 
the results are sent to the printer after a measurement has finished. 

After choosing an evaluation mode and selecting the Direct Print option (if desired) 
everything is set up for measurement.  

 

25.6.6.3 Start the Scan 
 
After verification of the scan setup click the Start button to start the scan and 
switch to the scan progress view. 

 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 283 of 391 
 
 



                     
 

X-LabPro  5  
 
25.6.7 Scan Progress Page 

The measurement is started while switching to the scan progress dialog and will 
be executed automatically. No user interaction other than reviewing intermediate 
results is required. 

During scan progress the view may switch to another result presentation as 
configured in your scan configuration. For more information on scan results view 
see chapter 4.4.7.3 Visualization of Results. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

During measurement the scan progress and the remaining time is displayed in the 
parameters bar (see chapter 4.3.2). The X-ray generator will be active and the 
shutter will be opened for each scan point. The voltage of the X-ray generator will 
also be displayed in the parameters bar. 

 

25.6.7.1 Display of Scan Progress 
The scan progress will be displayed as remaining time of the current scan and as 
the amount of scans remaining to scan.  
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25.6.7.2 Intermediate Results View 

The results displayed during measurement are not reliable. These results will be 
refreshed every time the detection system delivers new data. The longer the 
measurement process is running, the more reliable the intermediate result. 

The display of intermediate results is identical to the final results view. Please see 
chapter 4.4.8.1 Visualization on more information. 

25.6.7.3 Aborting the Scan 
The measurement can be aborted while it is active. To abort the measurement, 
click the Abort Scan button in the wizard navigation. All measurement data and 
results will be lost and the wizard will switch back to the scan setup page. Here 
you can correct the scan setup or go back for instance to change the sample. 
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25.6.8 Scan Results Page 

After the automated measurement process has finished, the 
MIDEX Routine Dialog automatically switches to the Scan Results page. This 
page is identical to the scan progress page but it does not display progress 
information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

25.6.8.1 Visualization 
The available visualizations depend on the scan type (Mapping, Linescan or 
Pointscan). Mappings can be visualized as color maps. Linescans offer Linescan 
view only. Pointscan results can be displayed as a list of elements or as a single 
spectrum. The following chapters describe these visualizations.  

 

25.6.8.1.1 Selecting an Element 
 
Mappings can display multiple elements in one view. These elements can be 
configured in the method using the X-LabPro Method Administration.  
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To display a single element the MIDEX Routine Dialog allows switching to a single 
element view. To select an element use the drop down list on the right side of the 
scan results page.  

The All elements list item displays all elements configured in the method. Select 
an element from the drop down list and the view switches to display only the 
selected element.  

 

25.6.8.1.2 Lossless Zooming of Results 
 
A single element view can be zoomed using the Zoom Selection drop down list. 
Choose a zoom factor and the view is updated immediately. The zoom of the 
image is lossless, there is no interpolation. Each pixel of the Mapping will be 
multiplied by the zoom factor. 

 

 

 

 

 

 

1x 
3x 

25.6.8.1.3 Color Maps 
 
Color maps are views of the intensity of an element at a scan point (one pixel). 
The higher the intensity of the element, the higher gets the intensity of the color. 
Every element is displayed as a rectangular image with its own colors. 
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The base color is black, which means if the intensity gets lower, then the color of 
the pixel gets darker. A black pixel means the element does not exist (or the 
intensity is extremely low). 

Here some examples from different scans: 

 

 

 

 

 

 

 

 

25.6.8.1.4 Linescan View 
 
For Linescans there is only one view available. The view shows an XY graph 
listing the points and their relative intensity side by side. Every element is shown in 
a separate graph and may have a different color. 

This view can be very useful to analyze the homogeneity of elements across a line 
on the sample. The more linear the line is displayed on the graph, the more 
homogeny is the element on the line. 
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25.6.8.1.5 Result List 
 
The result list is only available for Pointscans. It displays a list of elements and 
their concentrations and intensities. 

 

 

 

 

 

 

 

 

 

 

 

 

 

25.6.8.1.6 Spectrum View 
 
The spectrum view is only available for Pointscans. It displays the detailed 
spectrum received during measurement.  
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25.6.8.2 Result Files and Jobs 
 

When the measurement has finished, the results are saved for later use. This is 
where the functionality of the MIDEX Routine Dialog ends. For further evaluation 
and review of results the Spectra Viewer of X-LabPro is required.  

The results of Mappings and Linescans are saved as file archives to the file 
system of the computer running the MIDEX Routine Dialog. Pointscans are added 
to Jobs and available in the X-LabPro Job Manager. 

25.7 After measurement 
If the measurement was finished and the results are available, the wizard 
navigation displays a Finish button.  

 
 

 

To finish the scan process and continue operating the MIDEX device click Finish. 
A message box will be displayed and offer different options how to continue: 
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SPECTRO iQ II Easy GUI 
26 How to start 

To start the X-LabPro Easy Routine Dialog right-click on the Communication 
Server symbol. In the upcoming menu select Easy Routine Dialog. 

 

 

       Figure 17: Using the ComServer 
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27 Starting up 

27.1 Log in 
When the Easy Routine dialog starts up, first you have to provide your login and 
password. 

 

       Figure 18: Log in 
 
 
 
 

27.2 Interlock check 
On every start up you have to perform an interlock check. 

Please open the lid and close it again when you are asked for. Then press OK. 
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       Figure 19: Interlock check 
 

27.3 Standby mode 
As next you are asked whether to go into standby mode. If you do not want to go 
into standby mode right now, you can switch it on later by using the Standby 
button. 
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28 Using Easy Routine 

28.1 Introducing the dialog 
When the start up procedure is finished the dialog will look like in Figure 4. 

 

 

       Figure 20: Easy Routine Dialog 
 

In the upper part of the main dialog you can see the Parameter Bar stating the 
actual measurement parameters. While measuring, the bar will be updated 
continually. 

Right next to the Parameter Bar is the Close Button. 

On both sides of the dialog are several Function Buttons. 

Below the buttons are two State Icons. 

In the center you can see the Sample View. The Sample View is shown by default 
on start up. By using the buttons below the center view you can switch between 
Sample View and Spectrum View. 

While measuring the Spectrum View shows the measured spectrum. 

After a measurement is completed the Sample View shows the analysis results. 
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28.1.1 Sample view 

 

       Figure 21: Sample View 
 

The Sample View contains all needed controls to prepare a measurement. 

In the first four rows you can edit the sample name and select the method class, 
method and job. 

Below is the Result List where the measurement results are shown. After 
performing a Validation the list contains an additional row with the validation result. 

The progress controls show the remaining measurement time; separated into 

 Sample time: the time remaining for measuring the current sample. 

 Plate time: the time remaining for the complete measuring process 
( incl. time for preparing a measurement with gas flush or vacuum). 

The two buttons below let you switch between Sample View and Spectrum View. 

 

28.1.2 Selecting a Method class 
Press the Select button next to the edit field. A dialog ( Figure 6 ) opens and you 
can select the desired method class. 
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28.1.3 Selecting a Method 

Press the Select button next to the edit field. A dialog ( Figure 6 ) opens and you 
can select the desired method. 

The dialog only shows methods which are in the current method class. 

 

       Figure 22: Select dialog 
 

28.1.3.1 Selecting a Job 
At start up the job is preset according to the setting from the Configuration Editor. 

To select a different job press the Select button next to the edit field. A dialog  
( Figure 6 ) opens and you can select the desired job. 

 

28.1.3.2 Editing a Job 
To edit the job press the Edit button next to the edit field. A Virtual Keyboard  
( Figure 7 ) appears. Type in the new job and press OK to accept it. 
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28.1.3.3 Editing the sample name 
At start up the sample name is preset with 'NewSample'. 

To edit the sample name press the Edit button next to the edit field. A Virtual 
Keyboard  ( Figure 7 ) appears. Type in the new sample name and press OK to 
accept it. 

 

28.1.3.4 Pasting a sample 
Click here, to paste a sample from the Job Manager into Easy Routine Dialog. 

It is not possible to paste a standard. For pasting standards, please use the 
Routine Dialog. Further on, the method to which the sample belongs must not be 
hidden or finalized. 

It is possible to resume the measurement of a not completely measured sample. 
For example: if your sample contains 6 measurements and 5 of these are already 
measured, you can paste the sample and start measuring the last one. 

It is not possible to paste a completely measured sample. 

 

28.1.3.5 Using the virtual keyboard 

 

       Figure 23: Virtual keyboard 
 

SPECTRO Analytical Instruments GmbH 

The Virtual Keyboard can be used like a normal keyboard. Shift and Caps Lock 
work in the expected way. Selecting characters with Shift is not possible. 
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To move the cursor in the edit field use the Arrow buttons left to the edit field. 

To delete the character left to the cursor use the Delete button on the right side of 
the edit field. 

Press OK to accept the name or Cancel to close the dialog. 

 

28.1.4 Spectrum view 

 

       Figure 24: Spectrum View 
 

During a measurement the Spectrum View displays the currently measured 
spectrum. 

The Spectrum View can be enabled / disabled in the Settings dialog. 
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28.1.5 Close Button 

 

       Figure 25: Close button 
 

Clicking the Close button exits the Easy Routine Dialog. You will have to confirm 
exiting. If the high voltage is switched on, it will be powered down before the dialog 
is closed. 

 

28.2 Function Buttons 

28.2.1.1 Start 

 

       Figure 26: Start button 
 

The Start button is active only when no measurement is performed. 

Clicking the Start button starts a new measurement. 

It will change into the Stop button while measuring. 

 

28.2.1.2 Stop 

 

       Figure 27: Stop button 
 

The Stop button appears only during measurements. 

Clicking the Stop button stops the actual measurement. The high voltage will stay 
switched on. When the measurement is stopped, the Start button is shown again. 
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28.2.1.3 Pause 

 

       Figure 28: Pause button 
 

The Pause button is active only during a measurement. 

Clicking the Pause button will pause the measurement. 

It will then change into the Continue button. 

 

28.2.1.4 Continue 

 

       Figure 29: Continue button 
 

The Continue button appears only during paused measurements. 

Clicking the Continue button will continue a paused measurement. When the 
measurement is continued the Pause button is shown again. 

 

28.2.1.5 Off 

 

       Figure 30: Off  button 
 

The Off button is active only when the x-ray tube is on. 

Clicking the Off button ends the Standby mode. 
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28.2.1.6 Standby 

 

       Figure 31: Standby button 
 

The Standby button is active only when the x-ray tube is off. 

Clicking the Standby button switches the instrument into Standby mode. 

 

28.2.1.7 Settings 

 

       Figure 32: Settings button 
 

The Settings button is active only when no measurement is performed. 

Clicking the Settings button opens the Settings dialog ( see chapter Settings 
dialog for more details ). 

 

28.2.1.8 Recalibration 

 

       Figure 33: Recalibration button 
 

The Recalibration button is active only when no measurement is performed. 

Clicking the Recalibration button opens the Recalibration dialog ( see chapter 
Recalibration dialog for more details ). 

 
 

 

 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 301 of 391 
 
 



                     
 

X-LabPro  5  
 
28.2.1.9 Validate 

 

       Figure 34: Validate button 
 

The Validate button is active only when no measurement is performed. 

Clicking the Validate button to prepare a validation. In the upcoming dialog you 
have to select which method contains the needed Validation Sample. After 
successfully selecting the method, click Start to perform the validation. 

 

28.2.1.10 Print 

 

       Figure 35: Print button 
 

The Print button is active only when no measurement is performed. 

Clicking the Print button will print the actual measurement results directly to the 
default printer. When no results are present nothing is printed. 

28.2.2 Parameter Bar 

 

       Figure 36: Parameter Bar 
 

The Parameter bar states the actual measurement parameters: 

• the part measurement of the actual sample. 

• the gas flow in liters per hour. 

• the voltage in kilovolts. 

• the current in milliampere. 

• the maximum measurement time for the part measurement of the sample in 
seconds. 

• the measurement time for the part measurement of the sample in seconds. 
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28.2.3 State Icons 
The State icons reflect the actual instrument state. Therefore each icon has two 
different states. 

 

28.2.3.1 Lock/Unlock 

 

       Figure 37: Sample chamber locked 
 

The sample chamber is locked. 

 

 

       Figure 38: Sample chamber accessible 
 

The sample chamber is accessible. 

 

28.2.3.2 X-Ray on/off 

 

       Figure 39: X-Ray on 
 

The x-ray tube is switched on. 
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       Figure 40: X-Ray off 
 
The x-ray tube is switched off. 
 
 

28.2.4 Settings dialog 

 

       Figure 41: Settings dialog 
 

 

 

SPECTRO Analytical Instruments GmbH 
 

Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 304 of 391 
 
 



                     
 

X-LabPro  5  
 

The Settings dialog lets you configure some parts of the Easy Routine dialog. 

• enable / disable the Spectrum view. 

• enable / disable printing directly after evaluation of the measurement. 

• enable / disable Full screen mode. The Full screen mode is suitable only 
when a touch screen monitor is used because in Full screen mode the 
mouse pointer is hidden. 

• enable / disable the question for an inserted protection foil. 

 

28.2.5 Recalibration dialog 

 

       Figure 42: Recalibration dialog 
 

With the Recalibration dialog you can prepare the instrument calibration. 

Click one of the Recalibration method buttons to prepare the recalibration. 

For information about the different calibration methods click the Help button next to 
the Recalibration method button. 
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28.3 Recalibration 
In this chapter the application flow of the different recalibration methods is 
explained. 

For information about the different calibration methods open Recalibration dialog 
and click the Help button next to the Recalibration method you are interested in. 

 

28.3.1 MCA 
To perform a MCA Recalibration, open the Recalibration dialog and click the 
MCA button. The recalibration is then prepared. If the actual method does not 
contain any MCA sample you will be noticed. 

If a MCA sample was found, the Easy Routine Dialog then switches into 
Recalibration Mode: only the Start button and the New Sample button are active. 
To perform the recalibration click Start. To cancel the recalibration click New 
Sample. 

When the recalibration is complete the results are shown in the Result List. The 
Easy Routine Dialog switches back to Normal Mode. 

 

28.3.2 Global 
To perform a Global Recalibration, open the Recalibration dialog and click the 
Global Recalibration button. The recalibration is then prepared. If the actual 
method does not contain any Global sample you will be noticed. 

If a Global sample was found, the Easy Routine Dialog then switches into 
Recalibration Mode: only the Start button and the New Sample button are active. 
To perform the recalibration click Start. To cancel the recalibration click New 
Sample. 

Depending on the settings in the Configuration Editor the Global Recalibration 
is performed with one or more samples. 

If more than one sample is calibrated, a message box advises you when to insert 
the next sample into the Sample Chamber. 
When the recalibration is complete the results are shown in the Result List. If more 
than one sample was measured,  the results are only written to file and nothing will 
be shown in the Result List. The Easy Routine Dialog switches back to Normal 
Mode. 
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28.3.3 Intercept 
To perform a Intercept Recalibration, open the Recalibration dialog and click the 
Intercept Recalibration button. A Select Dialog opens and you can choose a 
method for calibration. The method must contain an Intercept Sample. After 
successfully selecting a method, the recalibration is then prepared. 

The Easy Routine Dialog then switches into Recalibration Mode: only the Start 
button and the New Sample button are active. To perform the recalibration click 
Start. To cancel the recalibration click New Sample. 

Depending on the settings in the Method Configuration the Intercept 
Recalibration is performed with one or more samples. 

If more than one sample is calibrated, a message box advises you when to insert 
the next sample into the Sample Chamber. 
When the recalibration is complete the results are shown in the Result List. If more 
than one sample was measured,  the results are only written to file and nothing will 
be shown in the Result List. The Easy Routine Dialog switches back to Normal 
Mode. 

 

28.3.4 Method 
To perform a Method Recalibration, open the Recalibration dialog and click the 
Method Recalibration button. A Select Dialog opens and you can choose a method 
for calibration. The method must contain a Method Sample. After successfully 
selecting a method, the recalibration is then prepared. 

The Easy Routine Dialog then switches into Recalibration Mode: only the Start 
button and the New Sample button are active. To perform the recalibration click 
Start. To cancel the recalibration click New Sample. 

When the recalibration is complete the results are shown in the Result List. In an 
additional column in the Result List the recalibration factors are shown. 

The Easy Routine Dialog switches back to Normal Mode. 
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28.4 Validation 
In this chapter the application flow of the validation is explained. 

To perform a Validation, click the Validation button. A Select Dialog opens and 
you can choose a method for validation. The method must contain a Validation 
Sample against which the new sample is validated. After successfully selecting a 
method, the Validation is then started. 

When the Validation is complete the results are shown in the Result List. In an 
additional column in the Result List the validation result is shown: 

• a  marks a valid result, the measured concentration was within limits. 

• a  marks an invalid result, the measured concentration was out of range. 

The Easy Routine Dialog switches back to Normal Mode. 
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SPECTRO iQ II XRF Tutorial  
29 Method Administration 

The term method is used in a very specific way in the X-LabPro Software. A 
method is far more than only a calibration.  
It is a complex structure built up from sub-methods: 

The Method Administration is divided into different parts: 

 General  

 Elements  

 Standards  

 Measurement  

 Deconvolution  

 Calibration  

 Output  

In General all general parameters can be found. 

In Elements the elements for the calibration (and additional elements, which can 
be in the samples) are selected. In addition the concentration range is defined 
here. 

The card Standards contains a list of all standard samples in this method. This list 
is used to create standards, to define the given concentrations... 

Measurement defines all parameters of the measurement: the x-ray tube 
conditions (voltage and current), type of sample, evacuation of the sample 
chamber, measuring time, target, and so on. 

The deconvolution section defines the elements of interest for each target / 
measurement.  
During the deconvolution the net count rates for the selected elements are 
determined. 

The calibration contains the functions typically described by the term calibration. 
The selection of a specific calibration model and the correlation between net count 
rates and concentrations are part of this sub-method. 

This options and cards can be used to modify or check an existing method. 

To create a new method, a comparable method should be selected in the tree part 
of the screen. This source is copied using New in the menu Method. The visible 
method is copied (with or without samples can be chosen in the following window). 
That is the best way to start, because a method contains a lot of parameters and 
details and all these will be copied from a working method. That's much easier 
then start to start all over. 

"How to create a new Method?" descibes the sequence of the most important 
steps. In addition to this way, the Method Wizard can be a help to accelerate this. 
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The a.m. parts are influenced by each other, and the best way to design a new 
method is to start with elements, followed by the measurement, the deconvolution, 
the calibration and finished with the output.  
But even the first steps, the selection of elements and the measurement 
conditions, are already influenced by the aims of the calibration. A brief outline of 
the steps for an idealized method development is listed below: 

1.   Select the Elements, which can be in the samples 

2.   Select the Elements, for which a concentration should be calculated (they 
have to be a part of the elements selected one step above) 

3.   Depending on 1. and 2. the Measurement Conditions have to be selected 

4.   Measure one or several standards without evaluation and use the Spectra 
Viewer to check 1. - 3.  

5.   
Optimise the measurement conditions depending on the results of 4.: This 
can be: Vacuum?, gas-flush?,  
measurement time? or excitation conditions? 

6.   Define or optimise the deconvolutrion parameters based on 1. and 2. 
7.   Measure the calibration standards 
8.   Optimise background spectra for the method 
9.   Evaluate the samples to get the net count rates 

10.   Calibrate the method. The procedure, which should be used, depends on 
the number of elements and the concentration range 

11.   Evaluate standards again 
12.   Edit the output sub-method 
 
Some of the steps are very easy to perform, while others require a detailed 
knowledge of the software.  
All of the critical steps will be explained in detail on the linked pages, but it is 
impossible to explain all of the basics of x-ray fluorescence spectroscopy in this 
guide. Please refer to the typical literature on these topics. 

 

 
 
 
 
 

30 Calibration 
The sub-method Calibration is used to get the correlation between the measured 
net count rates and the given concentrations of the standards.  
The user interface depends on the procedure which is selected at the tab General.  

 

This figure above shows the calibration screen, when the SPECTRO procedure is selected. 
This is the most comprehensive calibration and contains three different sub-procedures: 
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 Mass Attenuation Coefficient This procedure is used to calculate the 
"concentration" 
of the non-visible part of the sample. This calculation - based on the 
Compton-peak - is used to normalize the results (of an unknown sample).  
Whether this feature can be used, depends on the selected procedure. 
Whether it should be used, can be defined in General.  

 Compton Calibration This calibration is an empirical calibration. As part of the 
SPECTRO procedure, it is used to calculate start values for the following and 
final calibration based on Fundamental Parameters.  
The Compton model is using the intensity of the scattered Compton peak to 
correct matrix influences.  

 Fundamental Parameter Calibration. The Fundamental Parameter Model (FP) 
is a calibration model, which tries to explain the spectra of the sample by 
physical equations. At the end of this procedure, a theoretical sample is 
calculated, which shows the same spectra as the measured one. 

 On top of this selection list an important and well-known calibration can be 
chosen: 
Lucas-Tooth, Price. This calibration is the easiest correlation between 
intensity and concentration, because it's a line, described by concentration = 
calib-factor * intensity. 

 As summary, three analytical procedures (plus combinations for hybrid 
procedures) can be used in X-LabPro: 

 Lucas-Tooth, Price as easiest calibration model 

 Extended Compton model using the Compton peak for matrix correction, if the 
concentration range is too wide for Lucas-Tooth/Price 

 Fundamental Parameter Model, if the concentration range (and the matrix 
range) is wide 
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30.1 Calibration Procedure 

The sub-method Calibration is used to get the correlation between the measured 
net count rates and the given concentrations of the standards. The simplest case 
is a linear relation between these two values, but in most cases it will be more 
complex. In X-ray fluorescence, the net count rate is influenced drastically by the 
matrix and therefore needs an evaluation model to correct for this. 

The software X-LabPro contains a wide selection of calibration models. They can 
be selected using the function Mathematics in the tab General. 

   
The Calibration models can be divided into three sub-groups: 

 Empirical models (like Lucas-Tooth/Price or extended Compton) 

 Fundamental parameter models (FPM) 

 Specials like Layer Thickness 

 
 

Fundamental parameter models calculate the inter-element effects on the basis of 
physical relations. In empirical models, all matrix effects have to be corrected on 
the basis of real measured standards. 
One of the advantages of a fundamental calibration approach is the lower number 
of necessary standards (approximately one per element calibrated is 
recommended), but on the other hand the demands on the standards for an FPM 
are higher. As all inter-element influences are calculated on a theoretical basis the 
complete composition of a standard, even the concentrations of the elements not 
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measurable via XRF (i.e.: carbon, oxygen), are necessary. 
Empirical models are commonly used for narrow ranges of matrix variation or if 
some other influences, like grain size effects, do not allow the use of fundamental 
parameter methods. 

A brief description of the different models, their typical fields of application and 
some hindrances are listed in the following table: 

Calibration Model Typical Application 

Lucas-Tooth, Price 

Analysis of low-Z elements (Na to Fe) as main and 
minor elements. Especially in slag, dusts and minerals 
when particle size effects hinder a theoretical 
calculation. 

Standard based FP 
(thick)  

Main, minor and trace elements in a varying but known 
matrix, i.e. additives in oil. 

Standardless FP (thick)  
As FPM (thick): The normalization to 100% is only 
useful, if all main and minor elements can be analyzed, 
i.e. alloys. 

Standard based FP 
(thin)  

Low sample amount on filter material (i.e. aerosols), 
very thin films. 

Standardless FP (thin)  

As FPM (thin): The normalization to 100% is useful, if 
all of the main and minor elements can be analyzed. 
Typical application is the rubber technique with 
diamond paper. The method works without calibration. 

Layer thickness model  Analysis of the layer thickness on a substrate, i.e. 
Aluminium on Silicon wafer. 

In addition to the calibration models above, some general options can be set here. 
The calibration models will be explained in the following in more detail. 
 
The following figure compares the four most common procedures with their 
advantages and disadvantages: 
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This figure compares the four procedures regarding Accuracy and how much they 
are matrix indepentent. The meaning of this comparison is that Lucas-Tooth/Price 
is the procedure using a minimum of mathematics which results in the best 
accuracy. The more mathematics are used, the bigger the deviations. 
On the other hand, the models located at the left side of this figure, are not able to 
handle different matrices or a wide range of concentrations in the same calibration. 
If it is important to use a method, which is matrix independent, one of the models 
of the right side of the figure should be used. 
But then there can be a bigger deviation between expected and calculated results: 

In addition, there are some individual advantages / disadvantages for each 
procedure: 

 Lucas-Tooth/Price: The advantage is the simple algorithm. It can be 
controlled using a pocket calculator and it is "stupid", that means, there are no 
physical / logical tests (e.g. a concentration can be > 100%) - this can be 
used for special jobs 

 Extended Compton: The most important limitation for this model is the 
Compton-peak, which is needed. If in measurement no sub-measurement 
using a Compton-Target is defined, this procedure cannot be used for 
calculations. 

 Fundamental Parameter Model: Defining the given concentrations, the 
software has to know all information about the elements in the calibration 
standards, e.g. if a Diesel, containing 400 ppm of Sulphur should be defined, 
the residual nearly 100 % of "oil" are important for the procedure, too. This 
100%-knowledge can be a big problem. 

 Spectro-procedure: Disadvantages are the same as for FPM, additionally 
more samples (especially for mac) are needed. 

 
Unfortunately it is not possible to give a general answer to the question, which 
procedure should be used. There are too many details influencing this decision 
e.g. elements in the samples, concentration range... 

One possible way is, to start with the easiest (especially mathemetics) procedure 
to get an impression about the correlation between intensities amd concentration. 
If Lucas-Tooth/Price is able to solve this application problem, it's the best choice. 
If it is not able to solve it, the next procedure can be tried (Ext. Compton, if a 
Compton-Peak is available).  
The physical procedures using a lot of mathematics inside should be used at last 
or if completely unknown samples should be analyzed. 

  
Matrix for Calib. (Element Bonds) 

If this option is selected, all elements will be converted to their bonds. This makes 
it possible to calculate concentrations for low-Z elements (especially Oxygen) 
without measuring them directly. These calculated values for the low-Z elements 
will be taken into account during matrix correction. 
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If Matrix for Calib. should be used, they can be selected in General from a set of 
predefined bonds. To edit / create predefined Bonds the Configuration Editor has 
to be used. 

 
Normalization 
All options for the normalization are concentrated in the Normailization region on 
General.  
The normalization procedure allows to force the sum of the concentrations on a 
specific value (defined by Normalization Concentration). This function influences 
the concentrations after the calibration. The options MSK (mac) and Normalization 
to a fixed concentration are not possible at the same time. When MSK is selected, 
an additional tab is displayed in the calibration tab. 
The use of a Difference element is an additional option. This can only be one of 
the non-visible elements (typical H to F). If this option is used the difference 
between the sum of all analyzed elements and 100% is calculated as the 
difference element. It is possible to select bonds for the difference elements (see 
sub-method evaluation) to define matrices like (CH2)n for an organic sample. 

 
 
The option Normalize Results normalizes the results before each iteration step, so 
that the matrix effects are calculated again based on the new information. The 
option Normalize Results will be performed after the last iteration. This will always 
lead to a sum of all concentrations equal to the Normalization Concentration. 
These options can be used successfully, if all elements can be analyzed directly 
(i.e. alloys) or if the bonding state of the elements is exactly known (i.e. oxides in 
fusions) and the option Matrix for Calib. is selected at the same time. 
 
This normalization has nothing in common with the normalization on the Compton 
scattering peak or the normalization on regions of spectra used in the evaluation 
process. 
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30.2 Empirical Calibration using Lucas-Tooth/Price 

The easiest possible correlation between intensity and concentration is the 
following:  

 concentration = calib-factor * intensity. 
This describes the procedure called Lucas-Tooth/Price.  
In detail we find a lot of possible corrections like Offset or 2 types of Interelement-
Corrections (Overlapping elements and Matrix elements).  

 

This card shows on the left side the list of the standard samples.  
There are two possible presentations: If the option "Hide non-certified samples" (at 
the right side) is enabled,  
two important conditions will control, if a sample appears in this list:  
The standard needs a given concentration for this element AND intensity is found 
for this element during evaluation.  
If this option is disabled, one of these conditions is enough, because it is an OR-
condition. 

This standard list contains different columns: 

N This column shows, if the sample is a part of the calibration and about its 
weight: 
None      
Sample is not in the calibration 
1-5   
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The sample is in the calibration. The number shows, how many times this 
sample will be in the calibration 

Name That's the name of the sample 
Norm. Int The normalized intensity of the selected element in this sample.  

We like to use normalized intensities, because using them, we are able to 
handle different tube currents and/or measurement times in the same 
calibration. 

Given 
Conc. 

That's the goal 

C The certification level describes, how "sure" the given concentrations are: 
N      Not analyzed.     simple: not analyzed 
L       Laboratory         The given concentration is measured using another  
                                    instrument     
I        Info                    At a certification paper some values are certified as  
                                   "Info" 
C      Certified             The given concentration is certified           

Calc. 
Conc. 

The result of the calibration 

Diff. To check the quality of the calibration, the differences between calculated 
and given concentrations are an important number. 

 
At the right side of this sample list, some options were located, explained in 
the following: 
 
 
Lower Conc./Upper Conc.: 
These two values were calculated by the calibration mathematics - please do not 
change them 

 
Calibration Weight 

That's a value to control the calibration range, which should be important. If the 
calibration for smaller concentrations should be increased, reduce the value and 
vice versa for high concentrations... 

 

Color Level      

After the calibration is done the sample are shown using black or red color: The 
red color means, that the difference between given concentration and calculated 
value for this sample is too big. The limit, if a line is printed red or black, is this 
parameter (in % relative). 

 

Hide non-certified samples           

This option controls, which samples are shown in the sample list. 
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Output Unit      

The concentrations in the standard list are presented in the internal unit "ppm". 
Most times it is more comfortable to use the unit, which is used for the printout. 

 

Calibration regions     

Only for Lucas-Tooth/Price it is possible, to calibrate using up to 3 regions. If more 
then 1 region is selected, the limits to switch between the regions have to be 
defined. The presentation on this card shows only the selected region. As result, 
the region which is interesting has to be selected. All following steps are now for 
this region. If another region should be modified, it has to be selected first.. 

  

 
Possible Corrections: 
 

Intensity Ratios             

That's an unusual correction option, only available for this empirical model 
(Lucas-Tooth/Price): These are normalized matrix elements (normalization of 
count rates or weighting of the concentrations). This leads to better analyzes of 
samples with irregular surfaces. When using this correction, the calibration should 
be checked with a large number of samples  

 

Overlapping Elements 

Elements that influence the deconvolution of the main line of the element of 
interest through peak overlap. If systematic error occurs (because of this) during 
deconvolution, the respective elements should be selected here. For example the 
K-lines of S are overlapped by the M-lines of Pb. This overlapping can lead to a 
systematic error. Pb should be entered as an overlapping element for S.  

 

Matrix Elements    

Secondary excitation and discontinuity elements are entered as matrix elements 
for the Compton model. Secondary excitation elements are used for Fundamental 
Parameter Models. Elements that have a matrix influence on the element of 
interest are entered for Lucas-Tooth/Price 

 

Offset     

 If the calibration needs an offset, this can be enabled here.  

Parameters: 
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The card Parameters shows the calibration parameters.  
After a successful calibration the Slope should be shown. All other parameters are 
additional options. 

 

Calibration Diagram: 
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The Calibration Diagram shows the calibration line. The different signs are 
showing the level of certification. 
If the right mouse button is used, a context menu is available, to select different 
options like linear or logarithmic scaling. 
Touching a sample with the mouse, an info-box appears, that shows some details 
regarding this sample. 
A double-click in the top-line (with the double-line) opens the diagram as full-
screen version. 

Calculate: 

 

 
The button Calculate will start the mathematical procedure to calibrate the selected element. 
If no errors occur, this ends in the window which informs about the standard deviation during 
the calibration. 
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Enable All/Disable All: 
A faster way - especially if a complete new method has to be calibrated and each 
sample is disabled - to enable samples for calibration is the "all"-feature. Instead of 
marking each sample individually by clicking, it is much more comfortable to select 
all samples using this feature. 

Reset: 
This function allows to reset the calibration to the last set of parameters, if the 
actual calibration was not successful. 

Print: 
It is possible to print the calibration data (samples, results, parameters, standard 
deviation) e.g. for documentation.  

If something is going wrong or if some unexpected results were calculated, an 
error message will appear, which informs about the problem. 

  

  

30.3 Calibration based on a Fundamental Parameter Model 
(FPM) 
There are two different types of calibrations built-in in X-LabPro: 

EMPIRICAL CALIBRATIONS and FUNDAMENTAL PARAMETER MODELS 

The empirical procedures like extended Compton or Lucas-Tooth / Price try to find 
a correlation between intensities and concentrations using "stupid" mathematics - 
if the calculated parameters can be explained or not. 

The complete opposite of this strategy are Fundamental Parameter Models. 
They try to explain the sample during the calibration and the evaluation of 
unknown samples. It's not just a calibration factor together with an intensity which 
is creating the result - it's much more... 

During the calibration all known information about the sample is taken into 
account. These are much more then the given concentration. These are in addition 
all other concentrations (including "non-visible" elements like Oxygen), Loss of 
ignition, the (theoretical) Mass Attenuation coefficient based on the 
concentrations.... 

All this together is used for calibration. If the calibration is done and unknown 
samples are analyzed the evaluation is again not easy, because all calculated 
information/concentration are used to calculate the element of interest. 
Unfortunately the concentration of this element can have an influence to other 
elements. 
As result the calculation of the other elements has to be repeated, which will 
influence again the element of interest....That's a big circle and at the end we will 
find some concentrations. 
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The calculated concentrations are responsible for the spectra - that's the theory of 
the FP-Model. 

Following the calibration screen for Fundamental Parameter Model is described. 
This description takes care for the differences to Lucas-Tooth / Price. Similar 
functions are explained there. 

 
 
K-Shell/L-Shell: 

That can be an option for future...not available yet. 

 

Secondary excitation via Matrix Elem.: 
This option allows to work with Matrix Elements, which can be defined, using the 
"Matrix Elements" icon. 

 

Thick sample extrapolation: 
For light elements a sample with a thickness of several millimeters is thick 
compared to the penetration depth. 
But the heavier the elements, the bigger the penetration depth of the exciting 
radiation. 
For heavy elements the thickness of the sample influences the intensity in the 
spectrum. 
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This parameter uses the sample thickness for calculations. Depending on 
experience and physical data, this parameter is used starting at Bromine (Br = 35). 

Calculate: 

after pressing calculate, the calibration is done, but before the final window shows 
the standard deviation 

 

 
 
an additional screen presents some intermediate results: 

 
 

 
 
 

If something has gone wrong or if some unexpected results are calculated,  
an error message appears, which informs about the problem. 

Corrections: 

There are three places to select corrections at this calibration screen: 
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 Overlapping Elements 

 Matrix Elements 

 Calibration with Offset 

  

30.4 Special procedure for Calibration of Layer thickness 
Analysis of the layer thickness on a substrate, e.g. Aluminum on Silicon wafer or 
layers of Gold. 

The card looks different compared to the other procedures, because this 
calibration is a special one: 

 

First of all a layer thickness can be detected in different ways: 
- The Emission of the coating is detected and the thicker the coating is, the higher 
the intensity. 
- The second way is Absorption: The observed intensity is created by the 
substrate. 
   The thicker the coating is, the bigger the absorption of the radiation of the 
substrate and  
   the smaller the intensity of the observed peak of the substrate element. 
- The best way is a combination of both: Emission/Absorption 

The first calibration can be used for Au-Layers on other metals, the second can be 
used, if the coating material is not visible for XRF (like plastic coatings) and the 
combination is used e.g. for wafers. 
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The example above shows case 1 (Emission of the coating material) for Gold 
layers. In this case some options for the substrate material are disabled, because 
the substrate is not taken into account.  

The calibration is completed, if the intensity, which is found for the blank sample 
(green high-lighted in the figure above), is used as "Offset" value (here: 0,0041) 
(light blue). This has to be done manually !!!! 

 

SPECTRO Analytical Instruments GmbH 

30.5 Elements 
This tab is one of the most important tabs in a method, because it contains a list of 
all elements, which 

a) can be contained in the samples 
b) should be analyzed. 

Both will control the Measurement Conditions and the Deconvolution! 

 

As first step (using the button Elements on top) all possible elements have to be 
defined.  
These are the elements which can be in the samples. 

All the selected elements are visible in the list, shown above. 
Now, as second step, one can assign the elements of interest. This can be done 
by using the Analysis Elem column. If an element is marked here, the intensity of 
this element is fed to the calibration procedure to calculate a concentration. 

The LODs are the Limits Of Detection for each element. 
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The column Conc. Range Min. [µg/g] defines the lower limit of the calibration and it 
describes the detection limit. The following column Conc. Range Max. [µg/g] is 
important to define the size of the concentration range.  
That's an important information regarding the calibration procedure. 
The values for both columns will be extracted from the method automatically. 

Whether the columns called Coupling Factor L... and Conc. Limit [µg/g] are visible, 
depends on the user level. 

The last column contains the correction factors, which are calculated during a 
Method Recalibration.  
In addition to these factors the two factors for the scattering intensities (Coherent 
Back Scatter Correction and Incoherent Back Scatter Correction) are editable on 
top of the list. 

If Bonds should be used, they can be selected from a set of pre-defined bonds at 
General and/or Output.  
To edit / create pre-defined bonds the Configuration Editor has to be used. 

 

 

 

30.6 Measurement 
The setting of the measurement conditions is one of the first steps of the method 
development.  
It is necessary to decide the purpose of the method first. Which are the critical 
parameters, detection limits or measuring time?  
Is it possible to measure the samples in vacuum or is gas flushing necessary? 
Which elements are important?  

These questions have to be answered in advance to create a tailor made method 
for a specific application. 

For almost all elements a variation of different excitation conditions exists for each 
instrument. The first step is to select the best target combination for a specific 
method.  
A method is limited to 8 different targets. The number of targets used is influenced 
by the analytical needs and by the measuring time. 

 

Some basic rules for the development of a measurement strategy: 

1.   Always start the method with the Compton target if you need the information 
of the Compton Scattering (for details: see Calibration). 

2. 

  

Proceed with the target requiring the highest excitation energy. The 
information from this measurement about the concentration of the heavy 
elements can be used to improve the deconvolution of low-Z elements 
influenced by line overlaps of the L or M-Lines of the heavy elements.  
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Such a combination is Molybdenum and Sulfur: The Sulfur-K-line, which is 
used for calculations, is overlapped with the Mo-L-line. 
Without any correction, Mo in the samples will influence the S-results. If the 
sub-measurement which calculates Mo-K is done before the S measurement 
the result of the latter can be corrected. 

3. 
  

To analyze traces of light elements in a high-Z matrix, use a target that can 
only excite the analyte. This is only possible if the energy of the excitation 
source is between the absorption edges of analyte and matrix. 

4. 

  

To increase the count rate, it is possible to increase the tube current. 
Increasing the tube current leads to a higher intensity of the radiation. 
Increasing the tube voltage not only changes the intensity, but also the 
spectral composition of the radiation. Thus, it is necessary to create new 
background spectra when the tube voltage is changed. 

  
All measurement parameters are set in the sub-method Measurement. 

 

The General Settings of the measurement are located in the upper half of the 
screen. The number of sub-measurements can be selected here. Additionally, the 
environmental conditions (vacuum, air or He-flush) are selected here. 

The lower half of the screen contains the settings of sub-measurements for this 
method.  

Some of the values in the lower part of the window should not be changed, others 
can be varied (see below). An overview of the parameters, the possible settings 
are listed in the table below. 

 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 327 of 391 
 
 



                     
 

X-LabPro  5  
 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 328 of 391 
 
 

Parameter Notes 

Channels 1024 and 2048 channels are recommended for 
measurements at the Energy Range 12,5 and 25 keV, 
respectively. For measurements at the Energy Range of 50 
keV 4096 channels should be used. - Do not change 

Peak Time [µs] The time for the detection electronics to shape a peak. This 
time is a characteristic value for the detection electronics. It is 
important to note that all used combinations of peak time and 
energy range must be calibrated with the Method called MCA. 
- Do not change 

Zero Peak Rate 
[cps] 

Necessary for the accurate dead time correction - Do not 
change. 

Energy range 
[keV] 

The scaling of the x-axis of the spectra. For light elements we 
like to use 12.5 keV, for mid-range energies 25 keV and for 
heavy elements 50 keV. Each target or filter has its own 
recommended Energy range. - Do not change 

Target Selects the target for this sub-measurement.- Do not change 
Voltage The excitation depends on the voltage which is used. A 

voltage depending on the selected target/filter is 
recommended. Changes in the voltage will influence the 
background spectra which have to be modified after changing 
the voltage. - Do not change 

Current The optimum dead time is 25%. If Current Regulation in 
enabled (see next item), the current stored here is only the 
default start value. This will be regulated depending on the 
intensity which is influenced by the sample type. 

Current 
Regulation 

When this option is activated, the settings for tube current will 
be used as a starting current only. The software will measure 
the sample with the given settings and then optimize the tube 
current. The resulting intensity should not exceed 100,000 
cps. 

Measurement 
Time Limit 

Default: This option is selected as standard stop criteria. 

Measurement 
Time 

This is the clock time for the measurement. It is not possible to 
select a live time. 
Live time = clock time * (1 - rel. dead time). 

Measurement 
Pulse Limit 

An alternative option to end a sub-measurement. If the 
number of counted impulses is bigger than the given value in 
No. of Impulses the measurement will stop. If both options 
(Measurement Time Limit and Measurement Pulse Limit) are 
selected, the criteria first met will stop the sub-measurement. 

No. of Impulses For the Measurement Pulse Limit option the criteria for 
stopping the sub-measurement can be set here. 

First Channel For the above listed option No. of Impulses the region of 
interest (ROI) must be defined. This is done with the two 
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parameters First Channel and Last Channel. This is only 
necessary, if the option Measurement Pulse is used. 

Last Channel See above. 
 

 

 

30.7 Spectra Viewer 
The Spectra-Viewer is an important tool in X-LabPro.  

 

If elements should be identified using only the Spectra Viewer, please take care of 
the ARTEFACTS ! 

The Spectra Viewer can be used for method development, because the question, 
which elements could be in routine samples, can be answered a little bit easier 
using this tool. 

This information is necessary to define the deconvolution together with the 
measurement conditions. 
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30.8 Deconvolution 

The deconvolution is necessary to determine the net counts for the individual 
elements of the method. This includes the subtraction of a background spectrum 
and a selection which lines should be used for the deconvolution. As a method is 
constructed of several sub-measurements, the parameters have to be defined for 
each of the sub-measurements. It is possible to deconvolute elements in several 
sub-measurements to correct for line overlaps, but it is only possible to calculate 
the concentration from a single sub-measurement. 

The sub-method Deconvolution is divided into two kinds of tabs:  
The tab General is a summary of the deconvolution to get an overview. 

 
  
 

The number of background spectra and the corresponding switching limits can be 
selected here. The switchover values are the Compton to Rayleigh scattering 
ratios. Therefore, it is only possible to use several background spectra, if a 
Compton target is used in the method. With several background spectra available 
for each target it is possible to calibrate different matrices with a different scattered 
background (like organic and silicate samples) in one method. 

The list shows, which elements have to be deconvoluted during evaluation in 
general. These elements can be selected at the tab Elements.  
All elements which are present in a specific sample, should be selected. 
Even if the calculation of the concentration is not planned, it may be 
necessary to deconvolute the lines because of possible interferences and 
line overlaps. 
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Using the tabs Measurement x, all details of the deconvolution can be modified: 

 

The main part of the screen is a list of elements, which shows all selected 
elements, using the button Elements at the right side. The elements, which can be 
chosen at this place are pre-defined on the Elements tab. Only elements chosen 
on the tab are selectable here. 

 

 
If an element appears in the list, the last three columns can be modified / defined: 

The columns Line and Deconvolution describe the kind of calculation, which 
should be applied. For example, Sodium will be calculated from the K-Alpha line 
using Serial Fit as strategy. Possible strategies are: 
- Summation,  
- Series Fit ,  
- Line Fit and  
- Line Fit with Standardization 

The check boxes in the column Conc are necessary to decide, whether an 
intensity is used for the calculation of the concentration or just as intensity e.g. for 
overlapping corrections. When a number is shown (like for Chromium) that means 
that the concentration for this element must be calculated using the intensity from 
a different sub measurement (Cr = 1). 

On the right hand side there are 4 buttons to edit additional parameters. 

Elements 
If this button is selected a window with a periodic table of the elements will appear 
on the screen: 

 

In this periodic table all elements that were selected in the tab Elements are 
marked in yellow and can be selected. All elements which can be excited in this 
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sub-measurement should be selected. To select an element, click the element 
symbol and the color changes to red. 

All selected elements will be deconvoluted. It is not necessary to calibrate all of 
them or use them as concentration elements. For the Compton target it is 
essential to deconvolute the elements even if no concentration is calculated from 
the Compton target (like in most geological calibrations). In this way the overlaps 
with the scattering lines can be corrected. 

Only the elements selected in this PTE can be ticked as "concentration elements" 
in column Conc. 

Deconvolution Region: 
Most of predefined SPECTRO methods do not require any changes in the 
deconvolution settings. If this is required for a specific application, the Optimization 
must be disabled 

With the above defined settings all lines to be deconvoluted are selected, but it is 
not defined where the lines are and in which way they should be grouped in 
deconvolution areas. These deconvolution areas are selected with the button 
Deconvolution Region. These ROIs should be created in such a way that all 
elements are in ROIs but not too many lines in the same ROI. 

 
  
To create a ROI, the cursor is moved to the left edge of the planned ROI and then 
the right mouse button is pressed. When the mouse is moved to the right hand 
side – with still pressed mouse button – a region will be marked as ROI in a 
different hatching. To simplify the creation of the ROIs, it is quite useful to show 
the lines of the elements for this sub-measurement. This makes it easier to check, 
if all elements are in selected regions and if all lines of the elements with Series Fit 
are in the same deconvolution area. 
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To create the background regions, it is necessary to display a spectrum. The 
sample shown in the window can be selected at the bottom of this window. There's 
a list with all measured standards.  

The deconvolution areas will be copied together with the rest of the parameters, 
when a method is copied. So, it is not necessary to edit all the regions. 

Background Region: 
A background spectrum can be fitted to the measured spectrum after some of the 
detector artefacts (as an example: pile-up, escape, shelf) have been corrected. To 
do this, fitting regions have to be defined, according to the  
way described under Deconvolution region: 

 

 

The fitting of the background spectra allows to use longer measuring times for the 
background spectra to reduce statistical effects. The fitting regions should never 
be  
in regions where elemental lines might influence the height of the fitted 
background. 

Normalization Region: 
The normalization regions are defined exactly the same way as deconvolution and 
background regions.  
 

 

These normalization regions can be used as an internal standard even for other 
sub-measurements. Two normalization regions are allowed per sub-measurement. 

SPECTRO Analytical Instruments GmbH 

Iron-Cobalt-Correction: 
With the button Iron Cobalt Corr. a special correction for Cobalt can be activated. 
This correction improves the determination of Cobalt traces in the presence of a 
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large amount of iron. The correction factor should not be changed. This special 
correction is only possible if the Co Kα and the Fe Kβ- Lines are in separate ROIs. 

Use Optimization: 
By ticking the Use Optimization check box the parameters from the three buttons 
Deconvolution Region, Background RegionNormalization Region are calculated 
automatically.  

  

The deconvolution of a sub measurement follows the rules: 

The deconvolution areas (ROI, region of interest) are unfolded with increasing 
energy. 
 

 In each ROI, the elements with Line Fit or Line Fit with Standard will be 
processed with increasing energy. The Kα-line (or the Lα-line) will be 
deconvoluted and founded on the net count rate.  

 The additional lines of the same shell will be subtracted from the spectrum. 
For the L-series all lines of the three different sub-shells LI, LII and LIII will be 
considered. The coupling factors for the sub-shells can be edited in the 
Evaluation sub-method.  

 Then all elements with a Series Fit are deconvoluted with increasing energy. 

 
The deconvolution parameters are absolutely essential for the proper evaluation of 
a sub-measurement. Wrong or missing deconvolution parameters might result in 
severe problems of the software. 

A series fit is only allowed, if all lines for one specific element are in the same 
deconvolution area (see Deconvolution Region) and if the background under the 
lines is not too different.  
If the background is too different, the line ratio might be influenced and this will 
harm the accuracy of the series fit. 

While copying a method all of the elements, lines and even deconvolution 
strategies will be pre-set, reducing the necessary effort to a minimum. 

 
 

30.9 Deconvolution Strategies 
The deconvolution is necessary to determine the net counts for the individual 
elements of the method.  
This can be done, using different mathematical procedures: 

- Summation,  
- Series Fit,  
- Line Fit and  
- Line Fit with Standardization 
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The first one is used only for special applications (e.g. during a mapping using a 
MIDEX M instrument). 
To explain the differences between Line Fit and Series Fit, let's have a look, what 
happens with a new unknown sample during its evaluation: 

The energy-range of a sub-method is divided in different Regions of Interest 
(ROIs). 
These ROIs and their contents will be calculated from low-energy ROIs to high-
energy ROIs. 

Starting with the first ROI, the first step will be the Line-Fit for all Line-Fit-
Elements: 
It will start with the elements with the smallest Atomic-Number. In common cases 
the Alpha-line like K-Alpha is chosen. In this case, the K-Alpha-line of this element 
will be fitted. Based on this result, the corresponding Beta-line is calculated using 
a theoretical alpha-beta-ratio. After removing these lines (alpha and beta) from the 
spectra, the deconvolution will continue with the next element. 
Doing this step-by-step (or element-by-element) all elements Line-Fit was chosen 
for, will be removed from the spectra. 

The residual spectra will be taken into a next deconvolution step: 
In this last step, all elements with Series Fit (in one ROI) are deconvoluted in one 
step in a big equation-system. 

Line-Fit with Standardization means that, if a minimum intensity is reached, the 
peak is used to recalibrate the energy-channel-calibration for this sample. 

 

30.10 Artefacts: 
The following figure shows a spectrum of the sample V2O5. 
Without the artefacts the spectrum should contain the background information 
from the instrument and the V-lines. 

But in reality the spectrum looks a little bit different than expected: In addition to 
the V-lines, it shows the 4 artefacts: 
- Shelf 
- Tail 
- Escape 
- PileUp 
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As the figure shows, SHELF and TAIL are both creating additional background at 
the low-energy side of a peak. Both decrease the S/N ratio with the result of 
increased detection limits. 

If elements shall be identified manually, the artefacts described in the following are 
more difficult to handle, because they are creating "peaks": 

The artefact Escape has an energy which is reduced by around 1,75 keV 
compared to the "original"-peak. That's the energy of Silicon, which is used as 
detector chip material. 

The PileUp occurs, when 2 photons, reaching the detector at the same time are 
identified as 1 photon with doubled energy. If the "original" peak is a single peak 
(because peaks cannot be separated) like Si-K-series, we will find 1 PileUp peak. 
The figure above shows what happens with 2 lines like alpha- and beta-line: These 
two lines will generate 3 PileUp lines, because 2 alpha-photons or two beta-
photons or an alpha- with a beta-photon can combine. 

 

 

30.11 Background Spectra 

One part of the evaluation of a measurement is the subtraction of the Background 
Spectra. 
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For each sub-measurement up to 6 Background Spectra can be stored 
(Deconvolution). In a SPECTRO iQ II only one background spectrum per method 
is typically defined. 

 

 
The background spectra are stored as standards and at the Standards they are 
visible as it is marked with B.  

 

It can be necessary to modify these background spectra depending on the 
application. 
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30.12 Background and Contaminations 
In addition to the elements in the sample, which will have to be measured, there 
are some "contaminations" in the spectra, making the job a little bit more difficult. 

 

"Contaminations" of Spectra: 
********************************************************************************************** 

The Target:  
- HOPG-Target: The tube material (anode): Pd + 
Reflections 
 
The Measuring Chamber: 
- Iron 

The Detector: 
- Ta, Zr or Pd and a little bit of Sn (detector 
cooling) 

 

All these "contaminations" 
together are visible in the 
Background spectra.  

  

********************************************************************************************** 

Sample Cups / Protection Film: 
- Prolene: without contaminations 
- Mylar: P and Ca  
- Carbonat: Si 

The Dilution Material: 
- Oil: Sulfur 
- Charcoal: a variety of elements 

Artefacts 

Contaminations in the instruments, e.g. after a foil crack, or caused by sample 
preparation 

********************************************************************************************* 
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Background Spectra: 
Background Spectra for SPECTRO iQ II: 

 

  
HOPG-Target 
25 keV  
(Low-Energy 
range) 

  
HOPG-Target 
48 keV  
(Mid-Energy 
range) 
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30.13 Library of Standards 

The Library of Standards is available in the menu Tools.  

 

 

It is a database which contains the given concentrations of a lot of Certified 
Reference Materials (CRM). These data should be used during the creation of new 
samples used as standard: 

It is much faster done, if the given concentration were copied/imported from this 
database instead of entering each element concentration. 

 
 
 

30.14 Regions in Lucas-Tooth/Price 
The Lucas-Tooth/Price calibration is the only one, which supports more then one 
calibration region. 

This feature can be used, if the concentration range is too big to get good results. 

An example is Sulfur in Diesel. There are two possible regions: 
- Around 400 ppm of S as common region and 
- smaller then 10 ppm of S for Low-S-applications. 

This example is used to show the region-feature.  
First of all, the number of regions has to be increased. Doing this, the parameter 
"Limit 1 - 2:"  
is used to define the switching-limit. That's the concentration, where the next 
region  
(in this example region 2) starts. In the figure below, the limit is 10 ppm, that 
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means,  
that for concentrations smaller then 10 ppm region number 1 is used and for 
higher concentrations region 2: 

 

Pressing "Calculate" will calibrate only region 1! 
The "Selected Cal.-Region:" shows, that the list at the left side is presenting the 
samples and results for region 1. 
If the second region (> 10 ppm) should be calibrated, change the "Selected Cal.-
Region" into "2": 
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After this change, pressing "Calculate" will calibrate the second region. 

 

30.15 Error Messages during Calibration 

After pressing 

 
some error messages can appear, if something 
unusual was calculated. 
 

  

Following a summary of these messages: 
Message   Reason  Solution/next step 
Negative Offset   A negative Offset was 

calculated 
 Remove the Offset option 

Offset seems to be 
too big  

 

  Offset is unexpected big  If the reason can be found 
and explained, the message 
can be ignored (1) 

Incorrect 
correction 

  The calculated correction 
cannot be explained  
by Physical laws 

 Remove the mentioned 
element 

Negative   The calculated correction  Remove the mentioned 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 342 of 391 
 
 



                     
 

X-LabPro  5  
 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 343 of 391 
 
 

correction cannot be explained  
by Physical laws 

element 

Unexpected 
correction  

 

  The parameter for the 
correction is unexpected 
big. 

 If the reason can be found 
and explained, the message 
can be ignored (2) 

No. of Standards 
too low  

 

  Too many corrections 
No samples selected 

 More samples or less 
corrections (including Offset)
"Enable" samples 

Negative Slope   The slope of the calibration 
line is negative 

 Many times, there is an error 
in the given concentration like 
a wrong unit during definition. 
Has to be removed 

 Known examples for error messages which can be explained / ignored: 
(1)     "Offset seems to be too big"    If the detector has a Zirconium collimator, the 
offset for Zr will generate this message - that's ok. 
(2)     "Unexpected correction"         Some K- and L-series line-overlapping like Ba-
L and Ti-K are creating these messages, if they are corrected. 
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SPECTRO XEPOS XRF Tutorial 
31 Method Administration 

The term method is used in a very specific way in the X-LabPro Software. A 
method is far more than only a calibration.  
It is a complex structure built up from sub-methods: 

 

The Method Administration is divided into different parts: 

 General  

 Elements  

 Standards  

 Measurement  

 Deconvolution  

 Calibration  

 Output  

In General all general parameters can be found. 

In Elements the elements for the calibration (and additional elements, which can 
be in the samples) are selected.  
In addition the concentration range is defined here. 

The card Standards contains a list of all standard samples in this method. This list 
is used to create standards, to define the given concentrations... 

Measurement defines all parameters of the measurement: the x-ray tube 
conditions (voltage and current), type of sample, evacuation of the sample 
chamber, measuring time, target, and so on. 

The deconvolution section defines the elements of interest for each target / 
measurement.  
During the deconvolution the net count rates for the selected elements are 
determined. 

The calibration contains the functions typically described by the term calibration. 
The selection of a specific calibration model and the correlation between net count 
rates and concentrations are part of this sub-method. 

This options and cards can be used to modify or check an existing method. 

To create a new method, a comparable method should be selected in the tree part 
of the screen. This source is copied using New in the menu Method. The visible 
method is copied (with or without samples can be chosen in the following window). 
That is the best way to start, because a method contains a lot of parameters and 
details and all these will be copied from a working method. That's much easier 
then start to start all over. 
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"How to create a new Method?" desrcibes the sequence of the most important 
steps. 
In addition to this way, the Method Wizard can be a help to accelerate this. 

The a.m. parts are influenced by each other, and the best way to design a new 
method is to start with elements, followed by the measurement, the deconvolution, 
the calibration and finished with the output.  
But even the first steps, the selection of elements and the measurement 
conditions, are already influenced by the aims of the calibration. A brief outline of 
the steps for an idealized method development is listed below: 

1.   Select the Elements, which can be in the samples 

2.   
Select the Elements, for which a concentration should be calculated (they 
have to be a part of the elements  
selected one step above) 

3.   Depending on 1. and 2. the Measurement Conditions have to be selected 

4.   Measure one or several standards without evaluation and use the Spectra 
Viewer to check 1. - 3.  

5.   
Optimise the measurement conditions depending on the results of 4.: This 
can be: Vacuum?, gas-flush?,  
measurement time? or excitation conditions? 

6.   Define or optimise the deconvolutrion parameters based on 1. and 2. 
7.   Measure the calibration standards 
8.   Optimise background spectra for the method 
9.   Evaluate the samples to get the net count rates 

10.   
Calibrate the method. The procedure, which should be used, depends on 
the number of elements and  
the concentration range 

11.   Evaluate standards again 
12.   Edit the output sub-method 

 
Some of the steps are very easy to perform, while others require a detailed 
knowledge of the software.  
All of the critical steps will be explained in detail on the linked pages, but it is 
impossible to explain all of  
the basics of x-ray fluorescence spectroscopy in this guide. Please refer to the 
typical literature on these topics. 

 

 

32 SPECTRO Calibration - a Hybrid Procedure 
This special procedure combines different procedures to get a calibration that 
works with unknown samples in unknown matrices. 

This is possible, because the evaluation is done in the following steps: 
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1. 

  

Mass Attenuation Coefficient (mac): 
As option, the MAC calibration can be used as first evaluation step. If this is 
enabled, the Compton peak is used to calculate the mass attenuation 
coefficient. That's a physical parameter which can be used to calculate the 
"concentration" of the non-visible part of the sample (Carbon, Oxygen, 
Hydrogen, Nitrogen...). 

2. 

  

Extended Compton Model: 
The Compton calibration is an empirical calibration. As part of the Spectro-
procedure, it is used to calculate start values for the following and final 
calibration based on Fundamental Parameters.  The Compton model is using 
the intensity of the scattered Compton peak to correct matrix influence. 

3. 

  

Fundamental Parameter Model (FP): 
The FP calibration is the final calibration in the Spectro-procedure and it's a 
calibration model, which  tries to explain the spectra of the sample by physical 
equations. At the end of this explanation, a theoretical sample is calculated, 
which shows the same spectra as the measured one. 

4. 

  

Normalization: 
As the final step, the calculated results can be normalized (as option). This 
normalization works in two possible ways: 
- mac:  
      If the mac-calibration (see 1.) is used, the results are normalized to the 
sum of the "visible" part of the sample, which is: 100% minus "non-visible" 
part. The size of the "non-visible" part was calculated in step 1. 
- a fix sum concentration: 
      If a fix sum (like "100 %") is defined, the results will be normalized to this. 
That's an option, which can be used for alloys. 

 Such a calibration using the Spectro-procedure is done in the following steps: 

1.   The samples must be evaluated to get an intensity for all elements and the 
Compton peak. 

2.   The calibration placed on the first tab (Mass Attenuation Coeff.) has to be 
done at first. 

3.   After finishing this, the samples have to be evaluated another time. 
4.   The next step is, to calibrate using Compton procedure 
5.   After finishing this, the samples have to be evaluated again. 
6.   The last calibration step is the FPM procedure. 
7.   Finally, the samples have to be evaluated. 

 

If something is going wrong or if some unexpected results are calculated, an error 
message appears which informs about the problem. 
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33 Calibration 
The sub-method Calibration is used to get the correlation between the measured 
net count rates and the given concentrations of the standards.  
The user interface depends on the procedure which is selected at the tab General.  

 

This figure above shows the calibration screen, when the SPECTRO procedure is 
selected. 
This is the most comprehensive calibration and contains three different sub-
procedures: 

 Mass Attenuation Coefficient This procedure is used to calculate the 
"concentration"  of the non-visible part of the sample. This calculation - based 
on the Compton-peak - is used to normalize the results (of an unknown 
sample).  
Whether this feature can be used, depends on the selected procedure. 
Whether it should be used, can be defined in General.  

 Compton Calibration This calibration is an empirical calibration. As part of the 
SPECTRO procedure, it is used to calculate start values for the following and 
final calibration based on Fundamental Parameters.  
The Compton model is using the intensity of the scattered Compton peak to 
correct matrix influences.  

 Fundamental Parameter Calibration. The Fundamental Parameter Model (FP) 
is a calibration model, which tries to explain the spectra of the sample by 
physical equations. At the end of this procedure, a theoretical sample is 
calculated, which shows the same spectra as the measured one. 
 
In addition to the SPECTRO procedure both analytical calibrations (Compton 
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and FPM) can be used separately for calibrations. They can be selected in 
General.  

 On top of this selection list an important and well-known calibration can be 
chosen: 
Lucas-Tooth, Price. This calibration is the easiest correlation between 
intensity and concentration, because it's a line, described by concentration = 
calib-factor * intensity. 

  

As summary, three analytical procedures (plus combinations for hybrid 
procedures) can be used in X-LabPro: 

 Lucas-Tooth, Price as easiest calibration model 

 Extended Compton model using the Compton peak for matrix correction, if the 
concentration range is too wide for Lucas-Tooth/Price 

 Fundamental Parameter Model, if the concentration range (and the matrix 
range) is wide 

 SPECTRO procedure as combination of different algorithms. It is used, if the 
ranges are very wide and the routine samples are completely unknown 

 

33.1 Calibration Procedure 
The sub-method Calibration is used to get the correlation between the measured 
net count rates and the given concentrations of the standards. The most simple 
case is a linear relation between these two values, but in most cases it will be 
more complex. In X-ray fluorescence, the net count rate is influenced drastically by 
the matrix and therefore needs an evaluation model to correct for this. 

The software X-LabPro contains a wide selection of calibration models. They can 
be selected using the function Mathematics in the tab General. 
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The Calibration models can be divided into three sub-groups: 

 
 Empirical models (like Lucas-Tooth/Price or extended Compton) 

 Fundamental parameter models (FPM) 

 Specials like Layer Thickness 

 
Fundamental parameter models calculate the inter-element effects on the basis of 
physical relations. In empirical models, all matrix effects have to be corrected on 
the basis of real measured standards. 
One of the advantages of a fundamental calibration approach is the lower number 
of necessary standards (approximately one per element calibrated is 
recommended), but on the other hand the demands on the standards for an FPM 
are higher. As all inter-element influences are calculated on a theoretical basis the 
complete composition of a standard, even the concentrations of the elements not 
measurable via XRF (i.e.: carbon, oxygen), are necessary. 
Empirical models are commonly used for narrow ranges of matrix variation or if 
some other influences, like grain size effects, do not allow the use of fundamental 
parameter methods. 

A brief description of the different models, their typical fields of application and 
some hindrances are listed in the following table: 
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Calibration Model Typical Application 

Lucas-Tooth, Price 

Analysis of low-Z elements (Na to Fe) as main and 
minor elements. Especially in slag, dusts and minerals 
when particle size effects hinder a theoretical 
calculation. 

Extended Compton 
Model 

Trace and minor elements (K to U) in low-Z matrix (in 
some cases even low-Z elements are possible) 

SPECTRO procedure  

Combination of fundamental parameter and extended 
Compton scattering model with a calibration of the mass 
attenuation coefficient. Used for applications like the 
FPM (thick) model but even if the matrix is unknown and 
varying like in the analysis of different liquids (oil and 
water based). 

Standard based FP 
(thick)  

Main, minor and trace elements in a varying but known 
matrix, i.e. additives in oil. 

Standardless FP (thick)  
As FPM (thick): The normalization to 100% is only 
useful, if all main and minor elements can be analysed, 
i.e. alloys. 

Standard based FP 
(thin)  

Low sample amount on filter material (i.e. aerosols), very 
thin films. 

Standardless FP (thin)  

As FPM (thin): The normalization to 100% is useful, if all 
of the main and minor elements can be analyzed. 
Typical application is the rubber technique with diamond 
paper. The method works without calibration. 

ALPHA Normalization  
Method 

Analysis of fused beads with Alpha parameters by de 
Jongh. 

Compton/Rayleigh-
Method 

Traces in pharmaceutical products, developed by Dr. 
Schelcher, Hoffmann La Roche. 

Layer thickness model  Analysis of the layer thickness on a substrate, i.e. 
Aluminium on Silicon wafer. 

 

In addition to the calibration models above, some general options can be set here. 
The calibration models will be explained in the following in more detail. 
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The following figure compares the four most common procedures with their 
advantages and disadvantages: 

 

This figure compares the four procedures regarding Accuracy and how much they 
are matrix indepentent. The meaning of this comparison is that Lucas-Tooth/Price 
is the procedure using a minimum of mathematics which results in the best 
accuracy. The more mathematics are used, the bigger the deviations. 
On the other hand, the models located at the left side of this figure, are not able to 
handle different matrices or a wide range of concentrations in the same calibration. 
If it is important to use a method, which is matrix independent, one of the models 
of the right side of the figure should be used. 
But then there can be a bigger deviation between expected and calculated results: 

In addition, there are some individual advantages / disadvantages for each 
procedure: 

 Lucas-Tooth/Price: The advantage is the simple algorithm. It can be 
controlled using a pocket calculator and it is "stupid", that means, there are no 
physical / logical tests (e.g. a concentration can be > 100%) - this can be 
used for special jobs 

 Extended Compton: The most important limitation for this model is the 
Compton-peak, which is needed. If in measurement no sub-measurement 
using a Compton-Target is defined, this procedure cannot be used for 
calculations.  

 Fundamental Parameter Model: Defining the given concentrations, the 
software has to know all information about the elements in the calibration 
standards, e.g. if a Diesel, containing 400 ppm of Sulphur should be defined, 
the residual nearly 100 % of "oil" are important for the procedure, too. This 
100%-knowledge can be a big problem. 

 Spectro-procedure: Disadvantages are the same as for FPM, additionally 
more samples (especially for mac) are needed. 
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Unfortunately it is not possible to give a general answer to the question, which 
procedure should be used. 
There are too many details influencing this decision e.g. elements in the samples, 
concentration range... 

One possible way is, to start with the easiest (especially mathemetics) procedure 
to get an impression about the correlation between intensities amd concentration. 
If Lucas-Tooth/Price is able to solve this application problem, it's the best choice. 
If it is not able to solve it, the next procedure can be tried (Ext. Compton, if a 
Compton-Peak is available). The physical procedures using a lot of mathematics 
inside should be used at last or if completely unknown samples should be 
analyzed. 

  
Matrix for Calib. (Element Bonds) 

If this option is selected, all elements will be converted to their bonds. This makes 
it possible to calculate concentrations for low-Z elements (especially Oxygen) 
without measuring them directly. These calculated values for the low-Z elements 
will be taken into account during matrix correction. 

If Matrix for Calib. should be used, they can be selected in General from a set of 
predefined bonds. To edit / create predefined Bonds the Configuration Editor has 
to be used. 

 
Normalization 
All options for the normalization are concentrated in the Normailization region on 
General.  
The normalization procedure allows to force the sum of the concentrations on a 
specific value (defined by Normalization Concentration). This function influences 
the concentrations after the calibration. The options MSK (mac) and Normalization 
to a fixed concentration are not possible at the same time. When MSK is selected, 
an additional tab is displayed in the calibration tab. 
The use of a Difference element is an additional option. This can only be one of 
the non-visible elements (typical H to F). If this option is used the difference 
between the sum of all analysed elements and 100% is calculated as the 
difference element. It is possible to select bonds for the difference elements (see 
sub-method evaluation) to define matrices like (CH2)n for an organic sample. 
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The option Normalize Results normalizes the results before each iteration step, so 
that the matrix effects are calculated again based on the new information. The 
option Normalize Results will be performed after the last iteration. This will always 
lead to a sum of all concentrations equal to the Normalization Concentration. 
These options can be used successfully, if all elements can be analysed directly (i. 
e. alloys) or if the bonding state of the elements is exactly known (i.e. oxides in 
fusions) and the option Matrix for Calib. is selected at the same time. 
 
This normalization has nothing in common with the normalization on the Compton 
scattering peak or the normalization on regions of spectra used in the evaluation 
process. 

 

33.2 Empirical Calibration using Lucas-Tooth/Price 
The easiest possible correlation between intensity and concentration is the 
following:  

                 concentration = calib-factor * intensity. 
 

This describes the procedure called Lucas-Tooth/Price.  
In detail we find a lot of possible corrections like Offset or 2 types of Interelement-
Corrections (Overlapping elements and Matrix elements).  
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This card shows on the left side the list of the standard samples.  
There are two possible presentations: If the option "Hide non-certified samples" (at 
the right side) is enabled, two important conditions will control, if a sample appears 
in this list:  
The standard needs a given concentration for this element AND an intensity is 
found for this element during evaluation.  
If this option is disabled, one of these conditions is enough, because it is an OR-
condition. 

This standard list contains different columns: 

 

N This column shows, if the sample is a part of the calibration and 
about its weight: 
None      
Sample is not in the calibration 
1-5   
The sample is in the calibration. The number shows, how many 
times this sample will be in the calibration 

Name That's the name of the sample 
Norm. Int The normalized intensity of the selected element in this sample.  

We like to use normalized intensities, because using them, we are 
able to handle different tube currents and/or measurement times in 
the same calibration. 

Given Conc. That's the goal 
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C The certification level describes, how "sure" the given 
concentrations are: 
N      Not analyzed.     simple: not analyzed 
L       Laboratory         The given concentration is measured using   
                                    another instrument     
I        Info                    At a certification paper some values are  
                                   certified as "Info" 
C      Certified             The given concentration is certified           

Calc. Conc. The result of the calibration 
Diff. To check the quality of the calibration, the differences between 

calculated and given concentrations are an important number. 

 

At the right side of this sample list, some options were located, explained in 
the following: 
 
 
Lower Conc./Upper Conc.: 
These two values were calculated by the calibration mathematics - please do not 
change them 

 

Calibration Weight 
That's a value to control the calibration range, which should be important. If the 
calibration for smaller concentrations should be increased, reduce the value and 
vice versa for high concentrations... 

 

Color Level      
After the calibration is done the sample are shown using black or red color: The 
red color means, that the difference between given concentration and calculated 
value for this sample is too big. The limit, if a line is printed red or black, is this 
parameter (in % relative). 

 

Hide non-certified samples           
This option controls, which samples are shown in the sample list. 

 

Output Unit      
The concentrations in the standard list are presented in the internal unit "ppm". 
Most times it is more comfortable to use the unit, which is used for the printout. 

 

Calibration regions     
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Only for Lucas-Tooth/Price it is possible, to calibrate using up to 3 regions. If more 
then 1 region is selected, the limits to switch between the regions have to be 
defined. The presentation on this card shows only the selected region. As result, 
the region which is interesting has to be selected. All following steps are now for 
this region. If another region should be modified, it has to be selected first.. 

  

 

Possible Corrections: 
 

Intensity Ratios             
That's an unusual correction option, only available for this empirical model 
(Lucas-Tooth/Price): These are normalized matrix elements (normalization of 
count rates or weighting of the concentrations). This leads to better analyzes of 
samples with irregular surfaces. When using this correction, the calibration should 
be checked with a large number of samples  

 

Overlapping Elements 
Elements that influence the deconvolution of the main line of the element of 
interest through peak overlap. If systematic error occurs (because of this) during 
deconvolution, the respective elements should be selected here. For example the 
K-lines of S are overlapped by the M-lines of Pb. This overlapping can lead to a 
systematic error. Pb should be entered as an overlapping element for S.  

 

Matrix Elements    
Secondary excitation and discontinuity elements are entered as matrix elements 
for the Compton model. Secondary excitation elements are used for Fundamental 
Parameter Models. Elements that have a matrix influence on the element of 
interest are entered for Lucas-Tooth/Price 

 

Offset     
 If the calibration needs an offset, this can be enabled here.  

 

Parameters: 
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The card Parameters shows the calibration parameters.  
After a successful calibration the Slope should be shown. All other parameters are 
additional options. 

 

Calibration Diagram: 
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The Calibration Diagram shows the calibration line. The different signs are 
showing the level of certification. 
If the right mouse button is used, a context menu is available, to select different 
options like linear or logarithmic scaling. Touching a sample with the mouse, an 
info-box appears, that shows some details regarding this sample. 
A double-click in the top-line (with the double-line) opens the diagram as full-
screen version. 

Calculate: 

 

 
The button Calculate will start the mathematical procedure to calibrate the 
selected element. If no errors occur, this ends in the window, that informs about 
the standard deviation during the calibration. 

 

Enable All/Disable All: 
A faster way - especially if a complete new method has to be calibrated and each 
sample is disabled - to enable samples for calibration is the "all"-feature. Instead of 
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marking each sample individually by clicking, it is much more comfortable to select 
all samples using this feature. 

Reset: 
This function allows to reset the calibration to the last set of parameters, if the 
actual calibration was not successful. 

Print: 
It is possible to print the calibration data (samples, results, parameters, standard 
deviation) e.g. for documentation. 

  
If something is going wrong or if some unexpected results were calculated, an 
error message will appear, which informs about the problem. 

 

 

33.3 Calibration based on a Fundamental Parameter Model 
(FPM) 
There are two different types of calibrations built-in in X-LabPro: 

EMPIRICAL CALIBRATIONS and FUNDAMENTAL PARAMETER MODELS 

The empirical procedures like extended Compton or Lucas-Tooth / Price try to find 
a correlation between intensities and concentrations using "stupid" mathematics - 
if the calculated parameters can be explained or not. 

The complete opposite of this strategy are Fundamental Parameter Models. 
They try to explain the sample during the calibration and the evaluation of 
unknown samples. It's not just a calibration factor together with an intensity which 
are creating the result - it's much more... 

During the calibration all known informations about the sample are taken into 
account. These are much more then the given concentration. These are in addition 
all other concentrations (including "non-visible" elements like Oxygen), Loss of 
ignition, the (theoretical) Mass Attenuation coefficient based on the 
concentrations.... 

All this together is used for calibration. If the calibration is done and unknown 
samples are analyzed the evaluation is again not easy, because all calculated 
information/concentration are used to calculate the element of interest. 
Unfortunately the concentration of this element can have an influence to other 
elements. 
As result the calculation of the other elements has to be repeated, which will 
influence again the element of interest....That's a big circle and at the end we will 
find some concentrations. 

The calculated concentrations are responsible for the spectra - that's the theory of 
the FP-Model. 
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Following the calibration screen for Fundamental Parameter Model is described. 
This description takes care for the differences to Lucas-Tooth / Price. Similar 
functions are explained there. 

 
 
K-Shell/L-Shell: 
That can be an option for future...not available yet. 

 

Secondary excitation via Matrix Elem.: 
This option allows to work with Matrix Elements, which can be definded, using the 
"Matrix Elements" icon. 

 

Thick sample extrapolation: 
For light elements a sample with a thickness of several millimeters is thick 
compared to the penetration depth. But the heavier the elements, the bigger the 
penetration depth of the exciting radiation. 
For heavy elements the thickness of the sample influences the intensity in the 
spectrum. 
This parameter uses the sample thickness for calculations. Depending on 
experience and physical data, this parameter is used starting at Bromine (Br = 35). 

 

Calculate: 

after pressing calculate, the calibration is done, but before the final window shows 
the standard deviation 

 
 
 

an additional screen presents some intermediate results: 
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If something has gone wrong or if some unexpected results are calculated, an 
error message appears, which informs about the problem. 

Corrections: 

There are three places to select corrections at this calibration screen: 

Overlapping Elements 
- Matrix Elements 
- Calibration with Offset 

 

33.4 Calibration with Extended Compton Model 
Another well known procedure in XRF-calibration technique is the Compton 
Model. One of the interactions between radiation and material is called Compton 
effect: 
During this scattering, a photon will interact with one of the outer electrons of 
an  
atom of the material and doing this it will lose a part of its energy. 

Using a secondary target, this energy loss can be observed, because the 
Compton Peak is visible (at the low-energy side of the peak created by the target 
material, e.g. Molybdenum). 

What's the analytical advantage of the scattered Compton Peak? 
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The easiest empirical procedure (Lucas-Tooth/Price) has the disadvantage, that it 
will work only properly, if the concentration range is limited and the matrix is the 
same for all samples (in detail both limitiations have the same meaning, because a 
wide range of concentrations will influence the matrix...). The wider the 
concentration ranges in the matrix, the poorer the quality of such a Lucas-
Tooth/Price calibration.  

The Compton model is using the intensity of the scattered Compton peak to 
correct for matrix influences.  

 
This is working, because the 
Compton intensity depends on the 
"heaviness" of the sample: 
 
Light samples (like organic 
samples) have a big Compton peak 
and heavy samples (like ores or 
metals) have a small Compton peak 
(see end).  

This figure compares the Compton 
peaks for different solution 
materials. 
The bigger the Oxygen part in the 
chemical bond, the smaller the 
Compton peak, because water 
(shown in blue) is heavier than oil 
(in green) without any Oxygen. 

 

 

 

This effect is used to calculate a matrix correction, which allows to calculate a 
calibration with different matrices and/or with a wider concentration range 
(because a wide concentration range is similar to different matrices), compared 
with Lucas-Tooth/Price. The disadvantage of this correction is an additional 
mathematical step, which will increase the statistical error in the calibration, 
because now two intensities (element and Compton) instead of one (only the 
element in Lucas-Tooth/Price) are used. Each intensity has its own error 
(statistical and  
mathematical caused by deconvolution) and that's the reason, why the error of a 
Compton calibration is higher compared to Lucas-Tooth/Price. 
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This figure shows the tab for the Compton calibration. In the following only the 
differences to the same screen in Lucas-Tooth, Price are presented,. These 
differences are located at the right side of the tab: 

 2 or 3 calibration regions are not available 

 Log. Term:  hat's an additional calibration parameter that can be used in this 
procedure. 

 Comp./Ray. Ratio as Matrix Element: The ratio Compton/Rayleigh is used as 
internal standard to normalize results. This feature can be used for light 
matrices (organic) with a big Compton peak. 

 Compton Range:  These 2 numbers describe in which measurement (here the 
first one)   the Compton-peak is found. The second number is the number of a 
region (ROI) selected in the deconvolution - do not modify these entries. 

If something is going wrong or if some unexpected results were calculated, an 
error message will appear which informs about the problem. 

This final figure shows the above mentioned differences between light, mid-range and 
heavy matrices: 
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This figure shows the big differences in the Compton intensity for  
- Wax (Organic Matrix = green)  
- a glass sample (SiO2 = red)  
- V2O5 as a heavy oxide sample (blue) 

  

  

33.5 Special procedure for Calibration of Layer thickness 
Analysis of the layer thickness on a substrate, e.g. Aluminium on Silicon wafer or 
layers of Gold. 

The tab looks different compared to the other procedures, because this calibration 
is a special one: 
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First of all a layer thickness can be detected in different ways: 

 The Emission of the coating is detected and the thicker the coating is, the 
higher the intensity. 

 The second way is Absorption: The observed intensity is created by the 
substrate. 
The thicker the coating is, the bigger the absortion of the radiation of the 
substrate and  
the smaller the intensity of the observed peak of the substrat element. 

 The best way is a combination of both: Emission/Absorption 

The first calibration can be used for Au-Layers on other metals, the second can be 
used, if the coating material is not visible for XRF (like plastic coatings) and the 
combination is used e.g. for wafers. 

The example above shows case 1 (Emission of the coating material) for Gold 
layers. In this case some options for the substrate material are disabled, because 
the substrate is not taken into account.  

The calibration is completed, if the intensity, which is found for the blank sample 
(green high-lighted in the figure above), is used as "Offset" value (here: 0,0041) 
(light blue). This has to be done manually !!!! 
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33.6 Elements 

This tab is one of the most important tabs in a method, because it contains a list of 
all elements, which 

a) can be contained in the samples 
b) should be analyzed. 

Both will control the Measurement Conditions and the Deconvolution! 

 

As first step (using the button Elements on top) all possible elements have to be 
defined.  
These are the elements which can be in the samples. 

All the selected elements are visible in the list, shown above. Now, as second 
step, one can assign the elements of interest. This can be done by using the 
Analysis Elem column.  
If an element is marked here, the intensity of this element is fed to the calibration 
procedure to calculate a concentration. 

The LODs are the Lmits Of Detection for each element. 

The column Conc. Range Min. [µg/g] defines the lower limit of the calibration and it 
describes the detection limit. The following column Conc. Range Max. [µg/g] is 
important to define the size of the concentration range. That's an important 
information regarding the calibration procedure. The values for both columns will 
be extracted from the method automatically. 

Whether the columns called Coupling Factor L... and Conc. Limit [µg/g] are visible, 
depends on the user level. 
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The last column contains the correction factors, which are calculated during a 
Method Recalibration.  
In addition to these factors the two factors for the scattering intensities (Coherent 
Back Scatter Correction and Incoherent Back Scatter Correction) are editable on 
top of the list. 

If Bonds should be used, they can be selected from a set of pre-defined bonds at 
General and/or Output.  
To edit / create pre-defined bonds the Configuration Editor has to be used. 

 

33.7 Measurement 
The setting of the measurement conditions is one of the first steps of the method 
development. It is necessary to decide the purpose of the method first. Which are 
the critical parameters, detection limits or measuring time?  
Is it possible to measure the samples in vacuum or is gas flushing necessary? 
Which elements are important?  

These questions have to be answered in advance to create a tailor made method 
for a specific application. 

For almost all elements a variation of different excitation conditions exists for each 
instrument. The first step is to select the best target combination for a specific 
method.  
A method is limited to 8 different targets. The number of targets used is influenced 
by the analytical needs and by the measuring time. 

Some basic rules for the development of a measurement strategy: 

 

1.   Always start the method with the Compton target if you need the information 
of the Compton Scattering (for details: see Calibration). 

2. 

  

Proceed with the target requiring the highest excitation energy. The 
information from this measurement about the concentration of the heavy 
elements can be used to improve the deconvolution of low-Z elements 
influenced by line overlaps of the L or M-Lines of the heavy elements.  
Such a combination is Molybdenum and Sulphur: The Sulphur-K-line, which 
is used for calculations, is overlapped with the Mo-L-line. 
Without any correction, Mo in the samples will influence the S-results. If the 
sub-measurement which calculates Mo-K is done before the S measurement 
the result of the latter can be corrected. 

3. 
  

To analyze traces of light elements in a high-Z matrix, use a target that can 
only excite the analyte. This is only possible if the energy of the excitation 
source is between the absorption edges of analyte and matrix. 

4. 

  

To increase the count rate, it is possible to increase the tube current. 
Increasing the tube current leads to a higher intensity of the radiation. 
Increasing the tube voltage not only changes the intensity, but also the 
spectral composition of the radiation. Thus, it is necessary to create new 
background spectra when the tube voltage is changed. 
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All measurement parameters are set in the sub-method Measurement. 

 

The General Settings of the measurement are located in the upper half of the 
screen. The number of sub-measurements can be selected here. Additionally, the 
environmental conditions (vacuum, air or He-flush) are selected here. 

The lower half of the screen contains the settings of sub-measurements for this 
method.  

Some of the values in the lower part of the window should not be changed, others 
can be varied (see below). An overview of the parameters, the possible settings 
are listed in the table below. 

Parameter Notes 

Channels 1024 and 2048 channels are recommended for 
measurements at the Energy Range 12,5 and 25 keV, 
respectively. For measurements at the the Energy Range 
of 50 keV 4096 channels should be used. - Do not 
change 

Peak Time [µs] The time for the detection electronics to shape a peak. 
This time is a characteristic value for the detection 
electronics. It is important to note that all used 
combinations of peak time and energy range must be 
calibrated with the Method called MCA. - Do not change 

Zero Peak Rate 
[cps] 

Necessary for the accurate dead time correction - Do not 
change. 
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Energy range [keV] The scaling of the x-axis of the spectra. For light elements 
we like to use 12.5 keV, for mid-range energies 25 keV 
and for heavy elements 50 keV. Each target or filter has 
its own recommended Energy range. - Do not change 

Target Selects the target for this sub-measurement.- Do not 
change 

Voltage The excitation depends on the voltage which ist used. A 
voltage depending on the selected target/filter is 
recommended. Changes in the voltage will influence the 
background spectra which have to be modified after 
changing the voltage. - Do not change 

Current The optimum dead time is 25%. If Current Regulation in 
enabled (see next item), the current stored here is only 
the default start value. This will be regulated depending 
on the intensity which is influenced by the sample type. 

Current Regulation When this option is activated, the settings for tube current 
will be used as a starting current only. The software will 
measure the sample with the given settings and then 
optimize the tube current. The resulting intensity should 
not exceed 100,000 cps. 

Measurement Time 
Limit 

Default: This option is selected as standard stop criteria. 

Measurement Time This is the clock time for the measurement. It is not 
possible to select a live time. 
Live time = clock time * (1 - rel. dead time). 

Measurement Pulse 
Limit 

An alternative option to end a sub-measurement. If the 
number of counted impulses is bigger than the given 
value in No. of Impulses the measurement will stop. If 
both options (Measurement Time Limit and Measurement 
Pulse Limit) are selected, the criteria first met will stop the 
sub-measurement. 

No. of Impulses For the Measurement Pulse Limit option the criteria for 
stopping the sub-measurement can be set here. 

First Channel For the above listed option No. of Impulses the region of 
interest (ROI) must be defined. This is done with the two 
parameters First Channel and Last Channel. This is only 
necessary, if the option Measurement Pulse is used. 

Last Channel See above. 
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33.8 Spectra Viewer 

 

If elements should be identified using only the Spectra Viewer, please take care of 
the ARTEFACTS ! 

  

The Spectra Viewer can be used for method development, because the question, 
which elements could be in routine samples, can be answered a little bit easier 
using this tool. 

This information is necessary to define the deconvolution together with the 
measurement conditions. 

The following figure shows with which target one can calculate which element (for 
XEPOS and the standard TurboQuant applications). 
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Enhanced TurboQuant conditions using additional secondary targets:  

 

 

33.9 Deconvolution 
The deconvolution is necessary to determine the net counts for the individual 
elements of the method. This includes the subtraction of a background spectrum 
and a selection which lines should be used for the deconvolution. As a method is 
constructed of several sub-measurements, the parameters have to be defined for 
each of the sub-measurements. It is possible to deconvolute elements in several 
sub-measurements to correct for line overlaps, but it is only possible to calculate 
the concentration from a single sub-measurement. 
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The sub-method Deconvolution is divided into two kinds of tabs:  
The tab General is a summary of the deconvolution to get an overview. 

 
  
 

The number of background spectra and the corresponding switching limits can be 
selected here. The switchover values are the Compton to Rayleigh scattering 
ratios. Therefore, it is only possible to use several background spectra, if a 
Compton target is used in the method. With several background spectra available 
for each target it is possible to calibrate different matrices with a different scattered 
background (like organic and silicate samples)  in one method. 

The list shows which elements have to be deconvoluted during evaluation in 
general. These elements can be selected at the tab Elements.  
All elements which are present in a specific sample, should be selected. Even if 
the calculation of the concentration is not planned, it may be necessary to 
deconvolute the lines because of possible interferences and line overlaps. 
Using the tabs Measurement x, all details of the deconvolution can be modified: 
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The main part of the screen is a list of elements, which shows all selected 
elements, using the button Elements at the right side. The elements, which can be 
chosen at this place are pre-defined on the Elements tab. Only elements chosen 
on the tab are selectable here. 

If an element appears in the list, the last three columns can be modified / defined: 

The columns Line and Deconvolution describe the kind of calculation, which 
should be applied. For example, Sodium will be calculated from the K-Alpha line 
using Serial Fit as strategy. Possible strategies are: 
- Summation,  
- Series Fit ,  
- Line Fit and  
- Line Fit with Standardization 

The check boxes in the column Conc are necessary to decide, whether an 
intensity is used for the calculation of the concentration or just as intensity e.g. for 
overlapping corrections. When a number is shown (like for Chromium) that means 
that the concentration for this element must be calculated using the intensity from 
a different sub measurement (Cr = 1). 

On the right hand side there are 4 buttons to edit additional parameters. 

 
 

Elements 
If this button is selected a window with a periodic table of the elements will appear 
on the screen: 
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In this periodic table all elements that were selected in the tab Elements are 
marked in yellow and can be selected. All elements which can be excited in this 
sub-measurement should be selected. To select an element, click the element 
symbol and the colour changes to red. 

All selected elements will be deconvoluted. It is not necessary to calibrate all of 
them or use them as concentration elements. For the Compton target it is 
essential to deconvolute the elements even if no concentration is calculated from 
the Compton target (like in most geological calibrations).  
In this way the overlaps with the scattering lines can be corrected. 

Only the elements selected in this PTE can be ticked as "concentration elements" 
in column Conc. 

Deconvolution Region: 
Most of predefined SPECTRO methods do not require any changes in the 
deconvolution settings. If this is required for a specific application, the Optimization 
must be disabled 

With the above defined settings all lines to be deconvoluted are selected, but it is 
not defined where the lines are and in which way they should be grouped in 
deconvolution areas. These deconvolution areas are selected with the button 
Deconvolution Region. These ROIs should be created in such a way that all 
elements are in ROIs but not too many lines in the same ROI. 
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To create a ROI, the cursor is moved to the left edge of the planned ROI and then 

w 
, 

 spectrum. The 
ere's 

ied together with the rest of the parameters, 

 can be fitted to the measured spectrum after some of the 

 

the right mouse button is pressed. When the mouse is moved to the right hand 
side – with still pressed mouse button – a region will be marked as ROI in a 
different hatching. To simplify the creation of the ROIs, it is quite useful to sho
the lines of the elements for this sub-measurement. This makes it easier to check
if all elements are in selected regions and if all lines of the elements with Series Fit 
are in the same deconvolution area. 

To create the background regions, it is necessary to display a
sample shown in the window can be selected at the bottom of this window. Th
a list with all measured standards.  

The deconvolution areas will be cop
when a method is copied. So, it is not necessary to edit all the regions. 

Background Region: 
A background spectrum
detector artefacts (as an example: pile-up, escape, shelf) have been corrected. To 
do this, fitting regions have to be defined, according to the way described under 
Deconvolution region: 
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The fitting of the background spectra allows to use longer measuring times for the 
background spectra to reduce statistical effects. The fitting regions should never 
be in regions where elemental lines might influence the height of the fitted 
background. 

Normalization Region: 
The normalization regions are defined exactly the same way as deconvolution and 
background regions.  
The normalization regions are parts of the spectra that can be used to normalize 
the net count rates of an element. These normalization regions are necessary for 
Compton targets because the entire principle of the Extended Compton model 
(see Evaluation) and of the matrix correction based on the Compton intensity (or 
the Compton/Rayleigh ratio) is based on this normalization: 
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These normalization regions can be used as an internal standard even for other 
sub-measurements. Two normalization regions are allowed per sub-measurement. 

Iron-Cobalt-Correction: 
With the button Iron Cobalt Corr. a special correction for Cobalt can be activated. 
This correction improves the determination of Cobalt traces in the presence of a 
large amount of iron. The correction factor should not be changed. This special 
correction is only possible if the Co Kα and the Fe Kβ- Lines are in separate ROIs. 

Use Optimization: 
By ticking the Use Optimization check box the parameters from the three buttons 
Deconvolution Region, Background RegionNormalization Region are calculated 
automatically.  

  
The deconvolution of a sub measurement follows the rules: 

 The deconvolution areas (ROI, region of interest) are unfolded with increasing 
energy. 

 In each ROI, the elements with Line Fit or Line Fit with Standard will be 
processed with increasing energy. The K�-line (or the L�-line) will be 
deconvoluted and founded on the net count rate.  

 The additional lines of the same shell will be subtracted from the 
spectrum. For the L-series all lines of the three different sub-shells LI, LII 
and LIII will be considered. The coupling factors for the sub-shells can be 
edited in the Evaluation sub-method. 

 Then all elements with a Series Fit are deconvoluted with increasing 
energy. 
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The deconvolution parameters are absolutely essential for the proper evaluation of 
a sub-measurement. Wrong or missing deconvolution parameters might result in 
severe problems of the software. 

A series fit is only allowed, if all lines for one specific element are in the same 
deconvolution area (see Deconvolution Region) and if the background under the 
lines is not too different.  
If the background is too different, the line ratio might be influenced and this will 
harm the accuracy of the series fit. 

While copying a method all of the elements, lines and even deconvolution 
strategies will be pre-set, reducing the necessary effort to a minimum. 

  

 

33.10 Deconvolution Strategies 
The deconvolution is necessary to determine the net counts for the individual 
elements of the method.  
This can be done, using different mathematical procedures: 

- Summation,  
- Series Fit,  
- Line Fit and  
- Line Fit with Standardization 

The first one is used only for special applications (e.g. during a mapping using a 
MIDEX M instrument). 
To explain the differences between Line Fit and Series Fit, let's have a look, what 
happens with a new unknown sample during its evaluation: 

The energy-range of a sub-method is devided in different Regions of Interest 
(ROIs). 
These ROIs and their contents will be calculated from low-energy ROIs to high-
energy ROIs. 

Starting with the first ROI, the first step will be the Line-Fit for all Line-Fit-
Elements: 
It will start with the elements with the smallest Atomic-Number. In common cases 
the Alpha-line like K-Alpha is chosen. In this case, the K-Alpha-line of this element 
will be fitted. Based on this result, the corresponding  
Beta-line is calculated using a theoretical alpha-beta-ratio. After removing these 
lines (alpha and beta) from the spectra, the deconvolution will continue with the 
next element. 
Doing this step-by-step (or element-by-element) all elements Line-Fit was chosen 
for, will be removed from the spectra. 

The residual spectra will be taken into a next deconvolution step: 
In this last step, all elements with Series Fit (in one ROI) are deconvoluted in one 
step in a big equation-system. 

Line-Fit with Standardization means that, if a minimum intensity is reached, the 
peak is used to recalibrate the energy-channel-calbration for this sample. 
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33.11 Artefacts: 

The following figure shows a spectrum of the sample V2O5. 
Without the artefacts the spectrum should contain the background information 
from the instrument and the V-lines. 

But in reality the spectrum looks a little bit different than expected: In addition to 
the V-lines, it shows the 4 artefacts: 
- Shelf 
- Tail 
- Escape 
- PileUp 

 

As the figure shows, SHELF and TAIL are both creating additional background at 
the low-energy side of a peak. Both decrease the S/N ratio with the result of 
increased detection limits. 

If elements shall be identified manually, the artefacts described in the following are 
more difficult to handle, because they are creating "peaks": 

The artefact Escape has an energy which is reduced by around 1,75 keV 
compared to the "original"-peak. That's the energy of Silicon, which is used as 
detector chip material. 

The PileUp occures, when 2 photons, reaching the detector at the same time are 
identified as 1 photon with doubled energy. If the "original" peak is a single peak 
(because peaks cannot be separated) like Si-K-series, we will find 1 PileUp peak. 
The figure above shows what happens with 2 lines like alpha- and beta-line: These 
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two lines will generate 3 PileUp lines, because 2 alpha-photons or two beta-
photons or an alpha- with a beta-photon can combine. 

 

33.12 Background Spectra 

One part of the evaluation of a mesurement is the subtraction of the Background 
Spectra. 

For each sub-measurement up to 6 Background Spectra can be stored 
(Deconvolution).  

 

That's an option, if a Compton-target like Molybdenum secondary target is used in 
the method.  
With several background spectra available for each target it is possible to calibrate 
different matrices with a different scattered background (like organic and silicate 
samples)  in one method. 
Which background spectra should be used depends on the Compton/Rayleigh 
ratio.The background spectra are stored as standards and at the Standards they 
are visible as they are marked with B. Each of the shown background spectra 
belongs to one matrix and for each sub-meaurement a "sub-spectra" is stored: 
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It can be necessary to modifiy these background spectra depending on the 
application. 

 
 
 

33.13  Background and Contaminations 
In addition to the elements in the sample, which will have to be to measured, there 
are some "contaminations" in the spectra, making the job a little bit more difficult. 

"Contaminations" of Spectra: 

The Target:  
- The Target Material: Mo, Zr, Pd, Zn, CsI, Co  
- The Compton-Peak: Mo-, Pd- and Zr-Target 
- HOPG-Target: The tube material (anode): Pd + 
   Reflections 
- Filters: Mo, Zr, Ta, Pd, Cu, Fe  

The Measuring Chamber: 
- Iron 

The Detector: 
- Ta, Zr or Pd and a little bit of Sn (detector    
   cooling) 

 

All these "contaminations" 
together are visible in the 
Background spectra.  

  

 

Sample Cups / Protection Film: 
- Prolen: without contaminations 
- Mylar: P and Ca  
- Carbonat: Si 

The Dilution Material: 
- Oil: Sulfur 
- Charcoal: a variety of elements 

Artefacts 

Contaminations in the instruments, e.g. after a foil crack, or caused by sample 
preparation 
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Background Spectra: 

Background Spectra for XEPOS: 

 

  

HOPG-
Target 
 
(Low-
Energy 
range) 

 

  

Mo-
Target 
 
(Mid-
Energy 
range) 
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Al2O3-
Target 
 
(High-
Energy 
range) 

 

  

Pd-
Target 
 
(Mid-
Energy 
range) 
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Target 
 
(Low-
Energy 
range) 
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Target 
 
(High-
Energy 
range) 
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(Low-
Energy 
range) 
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Target 
 
(Mid-
Energy 
range) 
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33.14 Calibration of the Mass Attenuation Coefficient 

The calibration of the Mass Attenuation Coefficient is a possibility to get an 
impression about the size of the "non-visible" part of the sample and it is used 
as part of the SPECTRO procedure. To do this the Compton peak is used.  

 

In the frame of the calibration 9 parameters are calculated. Look at the tab 
Parameters (see figure below).  
The green highlighted limits are the switch-limits for the three regions. 
If these parameters shall be controlled, the yellow highlighted parameters should 
be positive. 
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The following figure shows the correlation between Compton intensity and "mac". 
a1, a2 and a3 are the three parameters for each region (1 to 3) shown in the figure 
above, "I" means the intensity of the Compton peak and µ is the "mac". 

 

For a better visualization a double logarithmic scale is used to form a diagram in 
the tab Mass Attenuation Coeff. The expected result is a line. 
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33.15 Library of Standards 
The Library of Standards is available in the menu Tools.  

 

It is a database which contains the given concentrations of a lot of Certified 
Reference Materials (CRM). These data should be used during the creation of new 
samples used as standard: 
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It is much faster done, if the given concentration were copied/imported from this database 
instead of entering each element concentration. 

 

33.16 Regions in Lucas-Tooth/Price 
The Lucas-Tooth/Price calibration is the only one, which supports more then one 
calibration region.  

This feature can be used, if the concentration range is too big to get good results. 

An example is Sulfur in Diesel. There are two possible regions: 
- Around 400 ppm of S as common region and 
- smaller then 10 ppm of S for Low-S-applications. 

This example is used to show the region-feature.  
First of all, the number of regions has to be increased. Doing this, the parameter 
"Limit 1 - 2:" is used to define the switching-limit. That's the concentration, where 
the next region (in this example region 2) starts. In the figure below, the limit is 10 
ppm, that means, that for concentrations smaller then 10 ppm region number 1 is 
used and for higher concentrations region 2: 

 

Pressing "Calculate" will calibrate only region 1! 
The "Selected Cal.-Region:" shows, that the list at the left side is presenting the 
samples and results for region 1. 
If the second region (> 10 ppm) should be calibrated, change the "Selected Cal.-
Region" into "2": 

SPECTRO Analytical Instruments GmbH 
Software Help X-LabPro 5    
Revision 1.0; 14/12/2010 Page 389 of 391 
 
 



                     
 

X-LabPro  5  
 

 

After this change, pressing "Calculate" will calibrate the second region. 

 

 

33.17 Error Messages during Calibration 

After pressing 

 
some error messages can appear, if 
something unusual was calculated. 
 

 
Following a summary of these messages: 

SPECTRO Analytical Instruments GmbH 

Message   Reason  Solution/next step 
Negative Offset   A negative Offset was 

calculated 
 Remove the Offset option 

Offset seems to 
be too big  

 

  Offset is unexpected big  If the reason can be found and 
explained, the message can be 
ignored (1) 

Incorrect 
correction 

  The calculated correction 
cannot be explained  
by Physical laws 

 Remove the mentioned 
element 

Negative   The calculated correction  Remove the mentioned 
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correction cannot be explained  
by Physical laws 

element 

Unexpected 
correction  

 

  The parameter for the 
correction is unexpected 
big. 

 If the reason can be found and 
explained, the message can be 
ignored (2) 

No. of 
Standards too 
low  

 

  Too many corrections 
No samples selected 

 More samples or less 
corrections (including Offset) 
"Enable" samples 

Negative Slope   The slope of the calibration 
line is negative 

 Many times, there is an error in 
the given concentration like a 
wrong unit during definition. 
Has to be removed 

 Known examples for error messages which can be explained / ignored: 
(1)     "Offset seems to be too big"    If the detector has a Zirconium collimator, the 
offset for Zr will generate this message - that's ok. 
(2)     "Unexpected correction"         Some K- and L-series line-overlappings like 
Ba-L and Ti-K are creating these messages, if they are corrected. 

 
 

34 Important Information  
Data Backup 

Regular data backups are important for the operation safety and availability for 
your analytical system. Utilities that enable regular backups of the program 
directory that are appropriate for the installed operating system should be used. In 
this way, it is possible to restore the most current data possible to a new computer 
or newly installed software if the PC or your specific data is lost or destroyed. The 
medium on which the backup is stored should be stored in a location that is 
spatially separated from the PC. 

Copyright and Guarantee 

© 1992-2010 SPECTRO Analytical Instruments GmbH, D-47533 Kleve, Boschstr. 
10, All rights reserved 

The X-LABPro software is copyrighted and is protected by international copyright 
laws. This software must be treated as a book. You have the right, however, to 
transfer the software to computers for internal use within the company or to make 
storage copies of this software. Additional copies, especially for transmission to 
third parties are prohibited. This is in violation of SPECTRO A. I.'s copyright. 

SPECTRO A. I. cannot guarantee that the software and documentation are free of 
errors. Nor can SPECTRO A. I. assure that the delivered software can fulfull all of 
your requirements. Especially for the error-free communication with products from 
third parties (e.g., printers and their drivers) or networks can no responsibility be 
accepted.  
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